# Table of Contents

**Introduction to Impact/SQL Escrow** ........................................................................................................... 12  
**General Information and Helpful Hints** ...................................................................................................... 13  
  Recent File List ........................................................................................................................................... 13  
  Impact Payee Shortcuts – Residential Files ................................................................................................. 13  
  File Search .................................................................................................................................................. 14  
  Name and Address File (NAF) .................................................................................................................... 16  
  Helpful Hints for Entering Information ........................................................................................................ 17  
    Dates ......................................................................................................................................................... 17  
    Dollars .................................................................................................................................................... 17  
    TAB ......................................................................................................................................................... 17  
    Execute .................................................................................................................................................... 18  
    F4 ............................................................................................................................................................ 18  
    Quick Keys ............................................................................................................................................... 18  
    Info Icons ............................................................................................................................................... 18  
    Closing Impact/SQL Escrow .................................................................................................................... 18  
**Logon** ......................................................................................................................................................... 19  
**The Impact/SQL Escrow Desktop** ........................................................................................................... 21  
  Impact Escrow Desktop............................................................................................................................... 21  
  Escrow Tool Bar ......................................................................................................................................... 22  
  Exit .............................................................................................................................................................. 23  
  Impact Widget Dashboard ............................................................................................................................ 24  
  Report Scheduling ..................................................................................................................................... 25  
**File Menu** .................................................................................................................................................. 27  
  New File ..................................................................................................................................................... 27  
    File Type ................................................................................................................................................ 28  
    File Number Options ............................................................................................................................ 30  
    File Copy Options .................................................................................................................................. 31  
  Select File ................................................................................................................................................ 32  
  Copy File ................................................................................................................................................... 33  
  Modify File Status .................................................................................................................................... 34
File Status ........................................................................................................................................ 35
Tracking ......................................................................................................................................... 37
Conversation Log .......................................................................................................................... 38
Create & Print Invoices (optional) .................................................................................................. 39
Impact Online Documents (Impact Online sites only) .................................................................... 41
Impact Express (optional) ............................................................................................................... 42
View Escrow History (optional) ...................................................................................................... 44
Publish File (optional) .................................................................................................................... 45
Save File .......................................................................................................................................... 45
Outside Services (optional) ............................................................................................................. 45
Exit .................................................................................................................................................. 45

Edit Menu ...................................................................................................................................... 46

Initial Questions - Residential .......................................................................................................... 47

  Functional and Navigational Icons on the Initial Questions Screens ........................................... 47
  Dates/Transaction Information Screen (Residential) ................................................................... 48
  Property Information Screen (Residential) ................................................................................... 52
    Property Tab .............................................................................................................................. 52
    Mobile Homes tab .................................................................................................................... 53
  Parties (Residential) ...................................................................................................................... 54
  Buyers and Sellers ......................................................................................................................... 55
    Information Tab ......................................................................................................................... 55
    Vesting Tab ............................................................................................................................... 56
    Signature Tab ............................................................................................................................ 56
    Contacts Tab ............................................................................................................................. 57
    Notes Tab .................................................................................................................................. 57
  Notary Block Icon – Buyers and Sellers Only ................................................................................ 58
  Copy Party Icon – Any Party ......................................................................................................... 58
  Reposition Party .......................................................................................................................... 58
  Lenders – (Residential) ................................................................................................................. 59
    Information Tab - Lender ........................................................................................................... 59
    Loan Terms ............................................................................................................................... 62
    Tolerance Adjustments ............................................................................................................. 64
800 Items Payable in Connection With Loan ................................................................. 93
Line 801 – Loan Origination Fee ................................................................................. 94
Line 802 – Loan Discount ......................................................................................... 94
Lines 803 Through Line 807 – Appraisal And Other Lender Fees ......................... 94
Line 808 – 811 – Other Fees .................................................................................... 94
Line 812 – Items Payable in Connection With Loan – Page (2)................................. 95
Lines 801-828 for Lenders #1-#3 ............................................................................. 95
900 Items Required by Lender to be Paid in Advance ................................................ 95
Line 901 - Interest .................................................................................................... 96
Line 902 - MIP ......................................................................................................... 96
Line 903 – Hazard Insurance Premium ..................................................................... 97
Line 904 – Other Fees ............................................................................................ 97
Lines 905-912 – Other Fees .................................................................................... 97
Lines 901-912 for Lenders #1-#3 .......................................................................... 97
1000 Reserves Deposited With Lender ..................................................................... 97
1100 Title Charges.................................................................................................. 98
1200 Government Recording and Transfer Charges .................................................. 100
1300 Additional Settlement Charges ......................................................................... 101
HUD Summary ........................................................................................................ 102
Lender Summary ...................................................................................................... 103
Residential – Non-GFE Worksheet Data Entry ......................................................... 103
Commissions .......................................................................................................... 104
Additional Buyer/Borrower Deposits ....................................................................... 104
Prorations, Debits and Credits ................................................................................. 105
Rent Schedule ......................................................................................................... 106
Borrower’s Payoffs .................................................................................................. 106
Seller’s Payoffs ......................................................................................................... 106
New Loan Fees ........................................................................................................ 106
New Loan Fees Paid in Advance ............................................................................. 106
Reserves Deposited with Lender ............................................................................. 107
Title / Escrow Fees ................................................................................................. 107
Government Recording and Transfer Charges ....................................................... 107
Large Dollar Amounts ............................................................................................................. 129
Settlement Items...................................................................................................................... 129
Settlement Summary .............................................................................................................. 131
Prorations ................................................................................................................................. 131
Additional Deposits ................................................................................................................ 134
Rent Schedule ......................................................................................................................... 135
Payoffs ...................................................................................................................................... 136
Agent Commissions ................................................................................................................ 137
Miscellaneous Commissions ................................................................................................. 139
Lender Items by Lender / Lender Items by Category .............................................................. 140
   Loan Charges ....................................................................................................................... 141
   Loan Paid in Advance ......................................................................................................... 142
   Reserves ............................................................................................................................. 145
Escrow Charges ....................................................................................................................... 146
Title Charges ........................................................................................................................... 147
Recording Fees ....................................................................................................................... 148
Additional Charges ................................................................................................................ 149
Settlement Statements .......................................................................................................... 150

Ticklers Menu .......................................................................................................................... 152
   Select and Edit .................................................................................................................... 153
   Print ..................................................................................................................................... 155
   Reminders ........................................................................................................................... 155
   Group Maintenance ........................................................................................................... 156

Disburse Menu ........................................................................................................................ 157
   Create & Print Checks ........................................................................................................ 158
      Pending Items Tab ......................................................................................................... 159
         Check ........................................................................................................................... 160
         Hold .............................................................................................................................. 161
         Transfer ....................................................................................................................... 161
         Wire-Out ...................................................................................................................... 162
            Option 1: Centralized Wire Desk Processing and ABA validation ......................... 162
            Option 2: Standard Wire Processing ..................................................................... 164
Skip .............................................................................................................................. 164
Modify, Delete and Split .......................................................................................... 165
Fee Check/ Fee Transfer Slip .................................................................................. 166
Receipts Tab ............................................................................................................. 167
Checks Tab ............................................................................................................... 167
Wire Outs Tab .......................................................................................................... 168
Receipts Tab ............................................................................................................. 168
Print ............................................................................................................................ 169
Preliminary Report ................................................................................................. 169
Print Checks ............................................................................................................ 169
Disbursement File Overdraft .................................................................................. 170
Print Final Report ................................................................................................... 170
Dual Authorization of Disbursements (optional) .................................................... 171
Create & Print Individual Checks ......................................................................... 172
Print Final Disbursement Report .......................................................................... 172
Fee Check Invoice ................................................................................................... 172
1099-S ...................................................................................................................... 173
Close File ............................................................................................................... 175
Balance Statement ................................................................................................ 175
Update Reason Funds Held .................................................................................... 175
Disbursements Pending Approval (optional) .......................................................... 176
Wires Menu (optional) ............................................................................................ 177
View Incoming Wires ............................................................................................. 177
New Incoming Wire ................................................................................................ 178
View Outgoing Wires .............................................................................................. 179
Approval .................................................................................................................. 180
Wire Out Audit Report ............................................................................................ 181
Receipts Menu ......................................................................................................... 182
View Receipts .......................................................................................................... 182
Receipts – Some Common Situations .................................................................... 185
Receipt Correction ................................................................................................... 187
Transfer Funds ........................................................................................................ 188
Format Phone ............................................................ 207
Toggle Headers and Footers ........................................ 207
Tools ............................................................................ 208
Print ............................................................................ 211
Email Document .......................................................... 211
Information .................................................................. 211
Save Document ............................................................ 212
Save and Return to Impact/SQL ...................................... 212
Title Instructions .......................................................... 212
Prelim/Commitment ..................................................... 213
HUD ............................................................................ 214
HUD-1A ...................................................................... 216
Settlement Statement ................................................... 217
Legal Description .......................................................... 219
Document Maintenance .............................................. 219
Projects Menu ............................................................. 220
New Project .................................................................. 220
Project Actions ............................................................. 222
Modify ........................................................................ 222
Delete ......................................................................... 222
Reports ....................................................................... 222
Close Project ............................................................... 223
Transfer Funds ............................................................. 224
Reports Menu ............................................................... 225
Assigned Escrows Report ............................................ 226
Log Book ..................................................................... 227
Closings Report .......................................................................................................................... 228
Income Analysis (optional)........................................................................................................ 229
Deposit Slips (optional) ............................................................................................................ 230
  Manual Deposit (optional) .................................................................................................... 231
View Deposit Slips & Voiding of Deposit Slips (optional) ........................................................ 232
Daily Receipts Journal ............................................................................................................. 233
Daily Disbursements Journal ................................................................................................... 233
Trial Balance Report (optional) .............................................................................................. 234
Wire Out Journal (optional) ..................................................................................................... 235
Custom Reports (optional) ...................................................................................................... 236
Custom Reports Maintenance (if Custom Reports avail) .......................................................... 236
Misc. Menu .................................................................................................................................. 237
  Amortization .......................................................................................................................... 237
  Rate Calculator ...................................................................................................................... 239
  Search ..................................................................................................................................... 239
  View Ledger ........................................................................................................................... 239
  Savings Ledger – from View Ledger ....................................................................................... 242
  Savings Accounts (optional) ................................................................................................. 243
    Add/Modify ......................................................................................................................... 243
    Print ..................................................................................................................................... 244
View Check Status .................................................................................................................... 245
Void Check (optional) ............................................................................................................... 246
Void Wire Out (optional) .......................................................................................................... 247
Printer Setup ............................................................................................................................. 248
Change Password (conditional) ............................................................................................... 248
Manual Check Entry (optional) ............................................................................................... 249
Accounting Lock/Unlock File ................................................................................................... 250
Naf Menu .................................................................................................................................... 251
  Add and Modify ..................................................................................................................... 251
  Modify .................................................................................................................................... 253
  Delete .................................................................................................................................... 253
  Print ....................................................................................................................................... 253
Options Menu.......................................................................................................................... 254
  Show Toolbar .......................................................................................................................... 254
  Show Recent File List ............................................................................................................. 254
Tools Menu.................................................................................................................................. 254
  Event Log.................................................................................................................................. 254
About Menu.............................................................................................................................. 255
Appendix A - Washington State –Taxes..................................................................................... 256
  Sales Taxes on Escrow and Title Charges.................................................................................. 256
  Excise Taxes............................................................................................................................ 257
Appendix B – Sub Escrow Functionality.................................................................................... 258
Appendix C - Troubleshooting .................................................................................................... 258
Introduction to Impact/SQL Escrow

This manual explains the functionality contained within the Impact Escrow module (Escrow), and discusses how each tool might be used. As each company functions in its own unique way, there are some functions that may not be utilized, but users are encouraged to examine and consider all of them, to ensure they are getting the most out of Impact.

The Escrow module is used to perform all of the traditional functions of Escrow Officers and their team members. These include the collection and organization of all of the data relating to escrow transactions; the ordering of work from the Title Department; the generation of documents involved in each transaction; the logging of the receipt of funds and the generation of disbursements; and the generation of reports about the work completed through the system.

This manual progresses through the functions in Escrow in the order that they appear on the menus within the module. This will not be how users will work with the product, as that will depend on their responsibilities and the structure of each individual business, as well as the configuration of Impact at each business.

There are a number of configuration options that can affect the functionality of the system. These variations are discussed in this manual, to the extent that the discussion does not detract from the explanation of the functions of the complete package.

Note: several functions discussed herein require the Impact Windows Service, introduced with version 8.0 and documented separately, to be installed and running.
General Information and Helpful Hints

This manual progresses through the functions in Impact Escrow in the order that they appear on the menus within the module. This is not how users will work with the product, as that will depend on their responsibilities and the structure of each individual business, as well as the configuration of Impact at each business. Before discussing the system functionality in detail, there are some general features that you should be aware of. These are discussed below.

Some formatting conventions used in this manual are:

When you need to press the Enter key, you will see ENTER in this manual.

When you see text displayed on a menu or window such as the words “Edit” or “Cancel”, you will see Edit or Cancel in this manual.

File > Select File means that you select File from the main menu and then select Select File from the sub menu.

Recent File List

There is a user option, set via Options > Show Recent File List, that will provide a listing of the last ten (10) files accessed, at the bottom of the File menu. This is the Recent File List. You can simply click on a file number, on the list, to open it up. To access the list you can use ALT+F to display the File menu.

Impact Payee Shortcuts – Residential Files

The following payee shortcuts can be used to ease data entry and ensure data commonality.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:L1</td>
<td>Lender 1</td>
</tr>
<tr>
<td>:L2</td>
<td>Lender 2</td>
</tr>
<tr>
<td>:L3</td>
<td>Lender 3 or Mortgage Broker</td>
</tr>
<tr>
<td>:L# John Doe</td>
<td>John Doe on HUD as payee</td>
</tr>
<tr>
<td>:L# John Doe</td>
<td>Allows the fee to be WTH (withheld) on non-GFE files</td>
</tr>
<tr>
<td>:T</td>
<td>Your Company Name</td>
</tr>
<tr>
<td>:T Maricopa County</td>
<td>Your Company Name with amount applied to income, but a different payee on Settlement Statement</td>
</tr>
<tr>
<td>:TC</td>
<td>Title company shown in Initial Questions (for outside title)</td>
</tr>
<tr>
<td>:E</td>
<td>Your Company Name (If option to use :E is enabled)</td>
</tr>
<tr>
<td>:SA</td>
<td>All Seller names (used in Create &amp; Print Checks only)</td>
</tr>
<tr>
<td>:S1 – 8</td>
<td>Selected Seller name (used in Create &amp; Print Checks only)</td>
</tr>
<tr>
<td>:BA</td>
<td>All Buyer names (used in Create &amp; Print Checks only)</td>
</tr>
<tr>
<td>:B1 – 8</td>
<td>Selected Buyer name (used in Create &amp; Print Checks only)</td>
</tr>
</tbody>
</table>
File Search

The File Search function, seen in many places in Impact, when a file number is being requested, permits you to search the entire database, for files that meet search criteria, with differing filters to limit the search. When first opened, the screen presented is set with broad filter of “All but file numbers” against which the Search For: field content will be applied, as shown below.

The File Search screen gives you the ability to search the database broadly or in a more targeted manner. By entering the beginning of a last name in the Search For: field, for example, and then clicking on the Search button without changing the search default of All but file numbers, you will get a listing returned of all files that have names of either the Buyer or the Seller which begin as you requested. The more sure you are of the item being requested, enter a more complete description. However, if at first you do not find what you believe you should have, limit the information you enter in the Search For: field. You may also use the percent sign (%) as a wildcard in your searches. It can be placed at the beginning, middle or end of your entry to tell the system to find anything that ends with what you entered, contains anything between your entry items, or begins with what you entered, respectively. The more targeted search options are listed below and can be selected from the Filter: dropdown. The default is All but file numbers.

- Sellers and Buyers
- Buyers
- Sellers
- Property Address
- Tax Parcel Number
- Subdivision (Name)
- Reference Number
- Base File Number
- Loan Number (Lender’s)
- File Number
- Title File Number

Once you click on the Search button, a listing of candidate items will present. The records will indicate which search criteria they matched up on. Up to the first 1,000 records that meet the criteria will be presented – you will be prompted to narrow your search if over 1,000 hits are made.
The quickest path to the Search functionality is via the Search icon on the Impact toolbar.

The user should proceed as far as they can before invoking a search, to minimize the effort. For example, if the plan is to open a file from the search results, use the Open Existing File toolbar icon and then click on the Search icon and conduct the search. Double-clicking on a search result, will then open that file.

In the sample below, “smith” was the search criteria, with the “All but file numbers” filter. The Found By column indicates how the search criterion relates to the search result. The File Number column contains that information. The Initials column presents the Escrow Officer's initials, and the Branch of the file is presented; along with the Title File Number. There is a View File Status icon next to each record returned; click on the icon to get more information on the file that the record relates to.

The Show Detail checkbox, in the top right of the screen, will open a section at the bottom of the screen presenting some additional information on the highlighted file. This helps the user determine if the selection is the file they are really looking for.

The search results can be re-ordered by clicking on a column header.

The user can re-size the screen by clicking and dragging on the lower right corner of the screen.

If the File Search screen was called up from a screen requesting a file number, double-clicking on a record in the results screen will select that file number for use.
Name and Address File (NAF)

The Name and Address File (NAF) or customer list is a very important tool in Impact. It is used to aid in consistently filling name and address information into the appropriate fields in Impact. Consistency in data entry helps ensure that documents properly present information. Management reporting is also aided by consistent data entry. The Name and Address File (NAF) is displayed in a tiered manner: Company – Branch – Individual (Top – Middle – Bottom). This provides a good way to show the relationship between an individual and where he/she works, within the larger organization. The NAF can be centralized or branch-specific, depending on system configuration. The NAF menu entry, on the main Escrow desktop, is discussed more fully later in this manual, but the following comments relate to its routine use.

The NAF is called up, from any Name field that can be filled from the NAF, by clicking on the NAF icon.

Near the top, on the left of the screen, is a box of Search Options. The nine options presented are the eight categories which can be used to categorize entries by type of firm, as they are entered/edited, and the All option is used to assist in searching the entire database, regardless of categorization of the entries.

Below the Search Options box is a box containing four fields that are used to direct the system to Search By either Name, County, ID or State. When more than one character is entered into any of these fields, the system automatically begins searching, after a brief delay to see if more characters are being entered, for records that match the criteria entered. You may use the percent sign (%) as a wildcard character. Those records that have a specific match, and their related records, are displayed in the tree on the lower left of the screen. In the search results display, the company entries are bolded, branch entries are not bolded and individuals’ entries are italicized for enhanced readability.

Double-click on an entry to Use it, if you are in a field where a NAF entry could be used, when the NAF was invoked. Alternatively, highlight the entry and then click on the Use icon at the top of the screen, or right-click on an entry and pick Use from the menu presented.
Helpful Hints for Entering Information

Dates
For current year, enter dates as two-digit month, two-digit day, for example, “0115” for January 15, 2013 (assuming 2013 is the current year). Do not enter hyphens or slashes when entering dates into Impact. If not within the current year but the current century enter the date as two-digit month, two-digit day and two digit year, for example: “062511” for June 25, 2011. If entering a different century other than the current century, you must enter a four-digit year.

You can also click the Calendar icon, just to the right of the date entry area, or press the CTRL+D Quick Key to display the Calendar tool. Select the desired date from the calendar presented by clicking on the date.

[Image: Change Date on Unposted Batch]

Dollars
Do not put commas or dollar signs in the dollar amounts. Decimals before pennies are required.

TAB
Use TAB to move forward from one entry field to the next entry field.
Use SHIFT+TAB to move backward from one entry field to the previous entry field.
**Execute**

When you see a button that has a dark border it has the “focus” and you can press ENTER to execute that command, rather than clicking on it with the mouse. Press TAB to move the focus to the other button(s).

![Press ENTER to execute “OK”](image)

**F4**

You may use the function key F4 to access a drop down list box, or you may click with the mouse on the down arrow.

**Quick Keys**

Quick Keys can quickly accomplish tasks by using keyboard entries instead of using the mouse to click on selections. Quick Keys are one or more keys you press on the keyboard to complete a task. Most menu items contain an **underlined letter** that represents the Quick Key for that menu item.

For example, press and hold the Alt key and also the F key. This ALT+F key combination opens the **File** menu, just as clicking on the **File** menu at the top left of the Impact Escrow screen opens the **File** menu.

Anytime you see a menu selection item on the screen that has a letter in the word underlined, you can use the Quick Keys alternative to using the mouse, for example, use the **ALT+D** Quick Keys to drop down the **Disburse** menu because the “D” in **Disburse** is underlined.

![ALT+D opens the Disburse menu](image)

**Info Icons**

The ![Info icons](image) are found in various screens throughout the Escrow module. When you click an ![Info icon](image) next to a field, a non-editable pop-up box is displayed, providing additional information about the field.

**Closing Impact/SQL Escrow**

As with most Windows applications, you can close Impact/SQL modules by clicking ![Close](image) in the upper-right hand corner of the Escrow desktop. Alternatively, **File > Exit** can be used.
Logon

Access to the Impact Escrow module (as to all Impact modules), is controlled by a user-rights table, administered by a limited set of user ID’s that have sufficient authority granted to them. This is a very important control, and should be carefully managed. Depending on the nature of the rights assigned to a user, they will have access to various pieces of the overall Impact suite, but generally not complete access. This functionality helps reinforce audit controls, and needs to be considered in conjunction with the network security plan.

The system can be configured to require a logon routine, each time the user opens an Impact module, or it can be configured to provide for an automatic logon utilizing the NT user name. By providing for an automatic logon utilizing the NT user name, control over the access to the application is very flexible: both the system administrator and the rights table within Impact can control access. The system administrator can control access by disabling the user’s NT user name, a likely event in the case of an employee’s departure. In addition, the user name can be disabled within Impact Utilities – which will only affect the user’s ability to access Impact modules. This would be done if the user is still using the rest of the network, but should no longer be accessing Impact.

There is not an automatic expiration of passwords setting within Impact, so to ensure strong controls the administrator would have to routinely change all users’ Impact passwords, and inform the users of them, if the automatic logon based on NT user names is disabled. For this reason, the use of an automatic logon based on NT user names can be a more effective control – assuming automatic expiration of passwords is implemented through the NT operating system. This matter is more fully explained in the Impact Utilities manual.

If the system is configured for NT Authentication, and more than one database is available, a screen like that shown below will be presented, after the user double-clicks on the Impact Escrow icon on their desktop. The appropriate database should be selected and OK clicked on. If only one database is available, the user, if they have permission, will be taken directly into the module.
When configured to require a logon step, the user will be identified within the Impact system by their initials (3 maximum), and will be given a password. A login screen will be presented asking for the user’s initials and password.

Enter the user initials in the first field, and then TAB to the Password field. Enter the password and, if the correct database is identified in the Log on to: field, click **OK**. If the database is not correct, then TAB to the **Log on to:** field and select the correct database by clicking on the drop down list arrow and highlighting a database name; then click **OK**. Most users will only have one database available.

Alternatively, if the user does not want to use the mouse to click **OK**, they can hit the TAB key until **OK** is highlighted, and hit ENTER.

**NOTE:** When they enter their password, it will not display on the screen, but will be represented by a series of asterisks “****”.

If the user does not want to continue, they should click on **Cancel** instead. This will cause the Logon dialogue box to close and the Impact Escrow module will not be opened.

**KEEP PASSWORDS PRIVATE.** Users should not share their passwords or log on to the system and then let someone else operate under their session. The initials of the user logged on to the system will attach to transactions entered, and users will only want to be responsible for their own activity.

If users forget their password, the administrator of the Impact application must assign a new one.
The Impact/SQL Escrow Desktop

Impact Escrow Desktop

Impact will display a desktop as shown below when the user signs into the Escrow module.

The screen, as it initially opens, presents the user with a menu of options across the top of the screen. Each option has a dropdown menu below it, which will be displayed when the user clicks on the option name. Once the user has clicked on one option name, and the menu list below it is presented, they can slide their cursor down the list, with the mouse, to get to the function they wish to use. If they are not sure under which option heading the desired function is housed, they can click on any option heading and, once the menu list is presented, slide their mouse to the left or right, to other option headings, and the menu lists will present without the user having to click again, and they can then browse all of the menu choices available to them.

The current date should be displayed in the lower right corner of the Impact desktop. If the current date is not displayed, or is incorrect, the user should notify the system administrator and NOT continue to enter activity to the system – having the correct dates on activity is very important. The current date is used for the print date on documents, the receipt date, check date, and voiding of check date, for example.

The file number and seller and buyer names will appear when a file is opened by the user. When shown, the file is “locked” by that user and can only be opened in “read only” mode by others, until closed by the user.
### Escrow Tool Bar

If the user has set the option to present the tool bar (Options > Show Toolbar), which displays under the menu at the top of the Escrow desktop, they will see a row of icons that can be used to initiate actions without using the menus. Holding the cursor over the icons will present tooltips identifying each icon’s purpose.

The table below details the tools and their Quick Key alternatives, if the user does not want to use the mouse.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool Name</th>
<th>Quick Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>New File</td>
<td>ALT+F then N</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Save File</td>
<td>ALT+F then A</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Open Existing File</td>
<td>ALT+F then S</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>File Status</td>
<td>ALT+F then F</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Copy File</td>
<td>ALT+F then C</td>
</tr>
<tr>
<td><img src="image6.png" alt="Button" /></td>
<td>Search For File</td>
<td>ALT+F then F then S</td>
</tr>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Name and address file (NAF)</td>
<td>ALT+A then A</td>
</tr>
<tr>
<td><img src="image8.png" alt="Button" /></td>
<td>Conversation Log</td>
<td>ALT+F then L</td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>View Escrow History</td>
<td>ALT+F then V</td>
</tr>
<tr>
<td><img src="image10.png" alt="Button" /></td>
<td>Select &amp; Edit Documents</td>
<td>ALT+O then D</td>
</tr>
<tr>
<td><img src="image11.png" alt="Button" /></td>
<td>Amortization Schedule</td>
<td>ALT+M then Z</td>
</tr>
<tr>
<td><img src="image12.png" alt="Button" /></td>
<td>Rate Calculator</td>
<td>ALT+M then R</td>
</tr>
<tr>
<td><img src="image13.png" alt="Button" /></td>
<td>Ticklers</td>
<td>ALT+I then S</td>
</tr>
<tr>
<td><img src="image14.png" alt="Button" /></td>
<td>Tracking</td>
<td>ALT+F then T</td>
</tr>
<tr>
<td><img src="image15.png" alt="Button" /></td>
<td>Deposit Slips</td>
<td>ALT+T then S</td>
</tr>
</tbody>
</table>
Exit

Users should exit out of Impact when they leave their desks for an extended period, or are going home for the day. They should use the boxed X, in the upper right corner of the Impact desktop window, to exit. Users should always exit out of Impact at the end of each day, before logging off of their computers. If users leave their Impact Escrow session logged on, others will have access to their “rights”, and this could raise security concerns. Remember that work done under a user’s initials will bear that user’s name. The menu path to exiting is File > Exit in the Escrow module.
Impact Widget Dashboard

Impact Widgets are introduced in Impact/SQL version 8.0. They are comprised of, in this version of the Escrow module, up to four (4) “floating windows”, each presenting different functional areas, which can be opened (or not) and positioned as the user wishes on his/her desktop. The functions addressed by each will be discussed elsewhere in this manual, but the widgets are: Held Items Queue, Open Orders (for escrow officers), Report Schedules and Ticklers Reminders.

At the bottom of the Impact Escrow desktop window there is a dark band, labeled as the Impact Widget Dashboard. At the right side are two icons:

- ![Order Widgets](image)
  This icon is used to order the widget windows which are on the desktop by name, in alpha ascending or descending order, and will tile the windows from the upper left corner of the Impact desktop. Widgets can be sized and positioned by the user, in typical Windows fashion.

- ![Widget Selection](image)
  This icon is used to open the widget selection window, as shown above. Highlighting a widget name and clicking on it will either open or close the widget, depending on its current status.

The three icons at the top right of each widget window are used to:

- ![Refresh](image) Refresh the window content,
- ![Collapse](image) Collapse or ![Expand](image) Expand the window and ![Close](image) Close the window.
Report Scheduling

The ability to schedule reports is introduced with Impact/SQL version 8.0. Scheduled reports will print in the background, freeing up the user to go on and perform other Impact functions. Reports can be scheduled on a one-time basis or to print on a recurring basis. The Impact Windows Service must be installed and functioning for report scheduling to function. Scheduled reports can be tracked on the Report Schedules Widget (discussed above). If a report can be scheduled, the user will see a Schedule button on the report’s option selection screen, like that shown here.

If the Schedule button is present and the user wishes to schedule a report to run in the background, either once or on a recurring basis, the user should first set the report options (unique by report type and discussed elsewhere in this manual) and then click on the Schedule button. A screen like the ones shown here will be presented, on which the user will manage scheduling options. Two versions are shown below, one indicating the report is to run one time, and the other is preparing to schedule the report to run on a recurring basis.

NOTE: only printers available to the Impact Windows Service will be available for scheduled reports.

This Impact Report Scheduler screen reflects a One Time Schedule Type.

This Impact Report Scheduler screen reflects a Recurring Schedule Type.

The system name of the report is reflected at the top of the screen (*.rpt), next to the Report File label. The name for the report, to appear on the Report Schedules Widget screen, is in the Schedule Name field, and the default value can be edited. A Brief Description field is also available for an additional user comment.
The **Schedule Type** field is next, and can be set to **One Time** or **Recurring**.

If **Recurring** is selected, the **Interval Type** can be set to **Daily**, **Weekly** or **Monthly**.

If **Daily** is selected, the **Days of Week** entries, in the **Timer Information** section, are all checked and cannot be changed…the report will run seven days a week, at the time the user sets in the **Timer Time** field.

Alternatively, select **Weekly** and check those days the report should run (one or more) each week, and set the time. Check all weekdays for Monday–Friday, for example.

If the user checks **Monthly**, the **Days of Week** section of the screen will be replaced with one like that shown to the right that only asks what time of the day to run the report. The **Report Date Range** section, below, is used to detail the data range to present.

The **Report Date Range** section of the screen is used to select the date range of data to be included on the report, whether it is being run once or on a scheduled basis. The options available are shown in this screen shot. Most are self-explanatory; the **Custom Range** option allows for running the report forward or back "x" number of days from the current date. So, if the user wanted the report to present the last 7 days of activity, each time it is run, he/she could do that, as shown below (right).

Once a report is scheduled, it will appear on the **Report Schedules** widget screen. The Report Schedules widget screen shown to the left reflects a Log Book report having been scheduled. The report’s schedule can be modified, or deleted from this screen.
File Menu

The File Menu’s content can vary depending on system configuration. The full listing of possible entries is presented below, and all will be explained in this section of the Escrow manual. The order of the menu entries is not indicative of workflow. These items will be explained in menu order.

- New File
- Select File
- Copy File
- Modify File Status
- File Status
- Tracking (optional)
- Conversation Log
- Create & Print Invoices (optional)
- Impact Online Documents (optional)
- Impact Express (optional)
- View Escrow History (optional)
- Publish File (optional)
- Save File
- Outside Services (optional)
- Exit

The Recent File List, if turned on to be presented (Options > Show Recent File List), will display below the File Menu. The last 10 opened files will be listed and the user can open a file from that list by clicking on it.

New File

The New File menu entry, or the New File icon, will trigger the opening of the New Escrow File screen shown here. On this screen, the user will identify several key elements relating to the creation of a new file and may also trigger some file copying options.

At the top of the screen, the Escrow Branch for the new file is identified. Depending on the user’s Access Level, there may only be one branch available (it will be shown but grayed out and cannot be changed) or all branches will be available, and the user will select the correct branch for the new file via the dropdown arrow to the right of the Escrow Branch field.
The next section of the screen, File Type, is used to determine if the file is to be a “Residential” or “Commercial” file. This is a critical determination, as the type cannot be changed after the file is opened.

**File Type**

Prior to version 7.6 of Impact/SQL, all files were of one type, now called “Residential”. With version 7.6 of Impact, a new file type was introduced, called “Commercial”. The “Commercial” file type is distinguished by the removal of many of the limits that had been placed on the traditional Impact files, which are now called “Residential” files. Conceptually, the “Commercial” file type provides for unlimited parties to the file, including lenders, an unlimited number of loans and an unlimited number of properties.

Listed below are the changes made, from the traditional (pre version 7.6) Impact file structure, to accommodate commercial transactions. The following outline details file type characteristics; and, as they differ between Residential and Commercial files, they will be noted.

- Unlimited parties (buyers, sellers, lenders, attorneys, accommodators, real estate brokers and other parties) [Residential files are limited to 3 Lenders and 3 real estate brokers]
- Unlimited number of contacts may be entered for each party
- Expanded lengths (from pre-v7.6 limits)
  - Buyer and Seller names expanded to 8,000 characters
  - All other party names expanded to 250
  - Buyer and Seller Vesting expanded to 8,000 characters
  - Buyer and Seller custom signatures expanded to 8,000 characters
- Ability to copy any party
- Buyer and Seller Notary block information
- Buyer and Seller current address information may be linked to the property or another party of the same type
- Buyer and Seller current address information forwarding address may be linked to current address, property or another party of the same type
- Prelim distribution may now be entered at the same time as the party information
- The ability to designate the Source of Business and/or Bill to Customer when entering a party
- Phone numbers expanded for all parties to include home, work & ext, cell and fax
- Loans can be designated for the benefit of the buyer or seller – Commercial files only.
- Ability to enter an alternate loan description which will override Impact’s default loan description – Commercial files only.
- Notes are available on all parties and contacts
- Support for Foreign addresses on all parties
- Unlimited properties [Residential files can have only one (1) property]
- Sales price may be entered for each property or in aggregate – Commercial files only.
• Notes are available for properties
• New settlement item entry that supports the following for **Commercial** files only:
  
  o Unlimited prorations
  o Unlimited Loan charges for each lender
  o Unlimited Loan Paid in Advance for each lender
  o Unlimited Reserves for each lender
  o Unlimited Escrow Charges
  o Unlimited Title Charges
  o Unlimited Recording Fees
  o Unlimited Additional Charges
  o Unlimited number of sub agents per agent
  o Unlimited Additional Deposits for the Buyer or Seller
  o Unlimited Rent Schedule
  o Notes are available for each settlement item; notes will be printed on the settlement statements.
  o Ability to enter Buyer Debit, Buyer Credit, Seller Debit and Seller Credit for each settlement item.
  o Fractional settlement statements (based on percentage of the transaction)
  o Printing a Payoff Schedule

The differences in data entry screens, between **Residential** and **Commercial** files, will be discussed later in this manual.

Critical points to consider, when making the File Type selection, are

• the type **cannot** be changed after selection and file opening; and,
• a HUD-1 **cannot** be created from a **Commercial** file – only Settlement Statements can be generated.

For these reasons, the user must be absolutely sure that they want to select the **Commercial** file type at file creation.
File Number Options

The File Number Options section, on the New Escrow File screen, is used to determine how the file number will be assigned to the new file. The options include taking an Automatic number, entering a Manual number, or taking a series of numbers with the Tract option. Depending on your company's configuration, Automatic or Manual numbers may be deactivated (dimmed out).

Automatic numbers are numbers assigned by a predetermined setup with numbering by branch or by database. Automatic numbers may be numeric or a combination of alphabetic and numeric of up to eight (8) characters. When using Automatic numbers, Impact will assign the current date as the open date.

Manual numbers can be all numeric, all alphabetic, or a combination of alphabetic and numeric of up to eight (8) characters. Manual numbers will require the user to supply an Original Setup Date for the file. Enter the 2 digit month, 2 digit day, and 2 digit year, for example, "013113" for January 31, 2013. The year's digits need not be entered if the current year is desired. The user can also click on the Calendar tool just to the right of the date entry area to select the date, or use the CTRL+D Quick Keys, to pull up the calendar tool.

Note: Do not enter hyphens or slashes when entering dates into Impact.

The Tract numbering option will allow the user to take multiple automatic numbers at one time. After selecting Tract, the Number to Pull entry field will activate. Enter the number of new files to be created (NOT the first file number) in this entry field. For example, if the user enters the number 3 in the Number to Pull field, then the next three (3) available automatic escrow numbers will be assigned to the files that are created. As shown to the right, the file numbers for the first and last file in the Tract range are "links"...click on the appropriate file to load either the first or the last in the range, or click on the Close icon to leave the New File screen without loading either. The files will have been created, either way.

Impact will not inflate the daily order count by the number of files created via Tract. When the escrow file whose number was issued via Tract numbering is opened, and Initial Questions started, then the order will be counted as a new file as of the current date. Users should check with their company on the policy for Tract file number usage.
**File Copy Options**

The **File Copy Options**, on the **New Escrow File** screen, are used if the user wants to copy information from an existing file, into the new file being created. For example, the ability to copy some or all of another file is of use with subdivision sales. The source files are often called "Master" files. Master files can be set up with much routine data already entered, and then are copied at each file opening that will utilize that common data.

The file number from which data will be copied should be entered in the **Master File Number** field. The options available for copying are enabled once a file number is entered. The options available are:

- HUD Data
- Payoffs
- Additional Deposits
- Rent Schedules
- Property Information
- Buyer Names
- Seller Names
- Reverse Names
- Copy Legal Description
- Copy Documents

Detailed descriptions of the options are provided in the **Copy File** section of this manual.

By default, Impact will have **HUD Data**, **Buyer Names**, **Seller Names**, and **Property Information** pre-checked. If the user does not want any or all of these fields copied they should place their mouse pointer in the box beside the description and click to add or remove a check mark.

In addition, there are options to **Copy Documents** and/or **Copy Legal Description** assigned to the **Master File Number**. Checking the option to **Copy Documents** will copy the existing documents from the **Master File Number** to the new file. Then, when the user goes into **Documents > Select and Edit Documents > File Document List**, they will see the documents pre-selected. The documents will still need to be opened for the DDE fields to be refreshed with the new file’s information.

Once all of the options desired are selected on the **New Escrow File** screen, the user should click on **OK** to continue and have the file created or **Cancel** to exit without having a new file created.
Select File

The Select File option, on the File menu, will present a screen for the user to enter an existing file number into, in order to open the file for data entry work. The Open Existing File icon, on the toolbar, can be used to get to the same screen, as can the ALT-F then S Quick Key shortcut.

![Select File Screen]

The New File icon, at the top of the screen, will take the user to the New Escrow File screen discussed earlier in this manual.

The Search icon, at the top of the screen, will take the user to the File Search screen discussed earlier in this manual.

Entering the file number in the field provided and clicking on OK will open the file for data entry. If another user has the file open (and thus has a “lock” on the file) a message will be presented explaining that and ask if the file should be opened in “read-only” mode. In “read-only” mode, the user will be able to look at the data in the file but not change any of it. A sample of that message is shown here.

![Record Locked]

USA Digital Solutions, Inc.  Escrow v8.0.0 Manual
10/30/2013  Page 32 of 258
Copy File

The **Copy File** option, on the **File** menu, is used to copy data between two existing files of the same type. This would be done if the user did **not** copy information from a master file at initial setup, but determined later that they wanted to do this. **Copying information from one file to another will wipe out the information previously entered in the file, so this should only be done with newly opened files, before any data entry has been done.** The **Copy File** icon, on the toolbar, can be used to open the **Copy Escrow** screen, as can the **ALT-F then C** Quick key shortcut.

The top of the screen is used to enter the numbers for the **Copy From Escrow** (source file) and the **Copy To Escrow** (target file).

The **Copy Options** presented are the same as on the **New Escrow File** screen.

**HUD Data** - This option copies the entire source file to the target file, except for accounting (ledger) data and payoffs, plus **Additional Deposits** and **Rent Schedules** entered from the Worksheet style of entry. **HUD Data** is checked by default. If you do not want the **HUD Data** fields to be copied uncheck the box beside the description by clicking in the box. This option is useful for projects, condos, exchanges, or when a substantial amount of information was entered into the wrong escrow, and you want to copy it to the correct escrow file, before deleting it from the erroneous file.

**Payoffs** – if payoffs entered in the original file should be copied, check this box.

**Additional Deposits** – if available, the option will be enabled, and should be checked if that data should be copied from the source file.

**Rent Schedules** - if available, the option will be enabled, and should be checked if that data should be copied from the source file.

**Property Information** - This option copies all fields entered in the **Property Information** screen from the source escrow number to the target escrow number.

**Buyer Names** - This option copies the **Buyer Names** from the source escrow number to the target escrow number. **Buyer Names** is checked by default. If the user does not want the **Buyer Names** to be copied uncheck the box beside the description by clicking in the box.

**Seller Names** - This option copies the **Seller Names** from the source escrow number to the target escrow number. **Seller Names** is checked by default. If the user does not want the **Seller Names** to be copied uncheck the box beside the description by clicking in the box.

**Reverse Names** - This option is useful for 1031 exchanges or when a customer is selling and then buying. When **Buyer Names, Sellers Names** or both are selected to be copied along with **Reverse Names**, the designations are reversed. The **Buyers** are moved to **Sellers**, **Sellers** are moved to **Buyers** or both, respectively.

**Copy Legal Description** - This option is useful when there are long legal descriptions that are common to several files, with parcel numbers being unique to each specific escrow.

**Copy Documents** - This option is useful for escrows with the same lenders and multiple loan documents. Impact will copy all the existing documents from the **Copy From Escrow** to the **Copy To Escrow**. Then, when the user goes into **Documents > Select and Edit Documents > File Document List**, they will see the documents pre-selected. The documents will still need to be opened for the DDE fields to be refreshed with the new file’s information.
Modify File Status

The Modify File Status option, on the File menu, opens the Escrow Number Entry dialogue box. If there is already a file open on the desktop the Enter The Escrow Number entry field is pre-filled with the current open escrow number. The Search icon can be used to search for a file number.

The Modify Escrow File Status screen has four (4) choices in the Status area, Active (Open), Cancel, Set For Deletion, and Hold. None of the options will prohibit the user from modifying the escrow, receipting in funds, disbursing funds, or creating escrow documents. The options are status flags only. Any status flag may be reversed. The escrow status can be utilized in reporting.

The Active (Open) status reflects an escrow that has not been flagged Cancel, Set For Deletion, or Hold. Closed files will reflect Open on the Current Status area of the screen, plus the screen will reflect when the file was closed with a message: “Closed on mm/dd/yyyy”.

The Cancel status is used on an escrow that was cancelled per the parties involved or a file was opened in error. The number of cancelled escrows will appear on management reports. After Cancel is selected the Reason field will be enabled to allow for the entry of a reason for the file’s cancellation. An automatic Title Order Sheet with “Cancelled” imprinted on it will be sent to the Title Department, when a file is cancelled.

If one or more 1099-S forms have been issued for the file being cancelled, the user will be presented with a pop-up message warning that the existing 1099-S’s will be deleted, and the user must confirm the intent to cancel the file.

The Set For Deletion status is used if the transaction is an “escrow only” transaction. Impact will automatically flag escrows that include title work for deletion after the policy is issued. If the user has an “escrow only” transaction and therefore no title work, then they must set the escrow for deletion, or it will remain on the system forever. The Deletion status is reserved for future use with archiving, but currently there is not an archiving function in Impact/SQL.

The Hold status is used to identify files that should not be archived (for example, master condos or projects). An escrow flagged as on Hold will not be archived, when that functionality is added to Impact/SQL. Again, there is no archiving function at this time.

The Hold status, when turned on will exclude that file’s documents from being deleted by the Batch Processor/Impact Windows service document deletion routine.

Click on OK to accept the choice, or on Cancel to quit without saving. If the status was changed, when the OK button is clicked, the Escrow Status Information screen will be presented.
File Status

The **File Status** menu option, on the **File** menu, opens the **Escrow Number Entry** dialogue box. If there is already a file open on the desktop the **Enter The Escrow Number** entry field is pre-filled with the current open escrow number. The **Search** icon can be used to search for a file number. Once a file number is provided, and the **OK** button is clicked, the system will present the **Escrow Status Information** screen, on which information on the full life cycle of the file will be presented, as shown below.

![Escrow Status Information Screen]

At the top of the screen are two icons. The **Change File** icon is used to select another file for viewing. The **Print** icon is used to generate a printed report of the file information.

General information about the file is presented at the top of the screen, under the aforementioned icons.

There are four (4) tabs of information below the general file information: **Info**, **Tracking**, **Policies** and **External Systems**. If there is content on those tabs, there will be a red diamond in front of the tab name. Some general comments on some of the data presented follows.

The **Branch Number** and **Manual Date** are determined when a new escrow file is established.

The **Escrow Officer**, **Project Name**, **Date Opened**, **Opened By**, **Est. Close Date**, **Funding Date** and **Date Entered** are pulled from **Initial Questions > Dates/Transaction Info**.

If the database is configured to automatically close the file when the revenue check is cut, then the **Date Closed** and **Date Recorded** will be the date the revenue check was cut. Otherwise, depending on the database configuration, Escrow may enter the **Date Closed** and **Date Recorded** from the **Disburse > Close File** menu path.

The **Last Changed** date and time is updated when a user signs into the escrow file. If the database configuration is set to **Enable File History Log**, the user will be able to produce a listing of who accessed the file and when from **File > View Escrow History**.

The **Date Ordered** and **Ordered By** is updated when the current user signed into the file sends the file to Title via **Edit > Order Title Search** or **Edit > Initial Questions > Title Search**.
If the database configuration is to **Auto Print Title Instructions** in the Title Department, then the **Date Accepted** is updated when the title instructions print. If the Title Department is manually printing the title instructions one by one the **Date Accepted** will be blank.

The **Search Date, Search Inits, Exam Inits, Exam Date, and Into Typing** are updated when Title inputs the information within the Title module under **Edit > Update Search & Exam Info**.

The **Typist Inits, Type Date, Amend No., Amend Date, and Released Date** are automatically updated when the **Prelim/Commitment** is created.

As an additional aid in the communication flow between Title and Escrow, when an amended **Prelim/Commitment** is generated, the escrow officer will automatically be notified via e-mail.

The **Policy Date** is automatically updated when the Title Department creates the policies. The **Policy Date** reflects the date the policy(ies) was created, not the “as of” date of the policy. Information on the policy(ies) is displayed on the **Policies** tab.

The **IRS Reporting** field is updated with “Completed", if a physical 1099-S was created under **Disburse > 1099S**, otherwise the field will be blank.

The **Buyer #1, Seller #1, Realtor (who is the Listing/Seller Broker), Property Address, Type of Transaction, Lender #1 Name, Sales Price, Loan Amount, Marketing Rep, Escrow Co/Other, Title Officer** (the name from **Initial Questions > Title Information > Title Officer**), **Parcel Number**, and **Processor** are updated when the Escrow user updates the escrow file in **Edit > Initial Questions**.

The **Title Department** is updated when Escrow sends a file to Title via **Edit > Order Title Search** or **Edit > Initial Questions > Title Search**.

Information on the **Tracking** tab is explained in the **Tracking** section of this manual (next).
Tracking

The Tracking function, under the File menu, is a customized tool to track items that are not specifically detailed on Initial Questions or on HUD lines. Tracking may be used to keep track of some items required by the escrow instructions, for example. Default Tracking templates can be set up for each transaction type, or for all files, by the System Administrator, through the Utilities module. The Tracking screen allows an unlimited number of separate items to be maintained. Fields within Initial Questions or HUD/Settlement Statement entry screens will not update Tracking, nor will Tracking update the HUD/Settlement Statement. Tracking is a useful tool to inform others in the office of the status of items ordered and completed.

After selecting Tracking from the File menu, if the user has an escrow open on the desktop the Escrow Number Entry screen will open, pre-filled with the file number. If no file is open on the desktop, the Escrow Number Entry screen will open and the user should enter the file number. Click on OK to continue or click on Cancel to exit.

If there are not yet Tracking items set up for the file, a Tracking Template dialogue box will pop up with a prompt asking if the user would like to use the default tracking template? Click on Yes to bring in the default set of Tracking entries, or click on No if only manual entries are desired.

The Tracking Entry screen presents the Description of the items to be tracked, the Date Ordered, Date Received, and a column for Comments.

To Add a new entry, click here

Type in comments here

Date last changed

For the Calendar tool, click on field, then click again or hit ENTER

USA Digital Solutions, Inc.
10/30/2013

Escrow v8.0.0 Manual
Page 37 of 258
To use the Calendar tool in any of the Date fields, click on the field to highlight it, then click again or hit the ENTER key to enable editing of the date fields.

Click on the last column and enter text to include Comments.

To the right of each entry, the **Delete** icon can be used to remove the entry.

There are icons at the top of the screen to **Change File**, add a **New Entry** and to **Print** the listing of events for the file.

**Tracking** may be customized per escrow. Depending on system configuration, the Title Department may have the ability to add or modify the tracking data. Each entry field has 50 character positions available for comments. You can add items to be tracked, if the default set does not include a needed item. Adding a new tracking item will add it to the bottom of the list.

The **Cancel** button will close the window and abandon any changes, without a warning.

The **OK** button save changes and close the Tracking Entry window.

## Conversation Log

The **Conversation Log** is a utility through which notes of conversations partaken in during an escrow's life can be stored. The **Conversation Log** is used to keep a chronological order of conversations entered by date, time and user. It can also be used when someone other than the escrow officer takes a call concerning the escrow.

Entries to the **Conversation Log** cannot be modified after entry and can therefore be used as evidence in a dispute. The Log does not spell check typing.

There are three icons at the top of the screen that are used to **Change File**, add a **New Entry** and to **Print** the Conversation Log entries.

There is an **Info** icon to the right of each entry that will open up a window showing the full text of the entry. Again, entries cannot be edited nor deleted.

The entries are sorted, by default, in descending time order, with the most current on the top of the list. Clicking on any column header will alter the sort to be by the column clicked. Re-clicking on the column header will invert the sort (ascending vs. descending). A custom sort can be done with the **Sort** icon in the upper right corner of the screen.
Create & Print Invoices (optional)

There are two types of items that can be worked via the Invoicing function in Impact: Pre-Bills and Invoices. The document generated by each type will differ in that pre-bills will indicate they are not a true invoice. These documents are customized by database. Pre-bill and invoice numbering is automatic and the numbering schemes are database wide. The default Bill To customer on new items is pulled from the party in the file designated as the Bill To Customer, but can be changed on each item created. Depending on system configuration, Escrow may have the ability to generate pre-bills &/or invoices, and may be able to switch a pre-bill to an invoice. Also, depending on system configuration, Escrow may not be able to delete an invoice once it has been entered into Impact. The sample screen below reflects all of these settings as being enabled.

NOTE: There is not an Accounts Receivable function, within Impact, for tracking invoices, and invoices can be edited at any time after creation – they cannot be locked.

Selecting Create & Print Invoices from the File menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter the Escrow Number entry field is pre-filled with the current open escrow number. If no file is open the entry field is blank and the user should type in a pre-existing escrow number or click on the Search icon to aid in locating the file number to work with. Click on OK to proceed with the file number entered.

The Create & Print Invoices screen is then presented, listing any existing pre-bills or invoices, as shown below. Note that the one pre-bill on the listing shows a “P” after the number of the item in the Invoice # column.

Across the top of the screen are the icons Change File, Print Selected, Email Selected, Publish Selected and New Invoice. If an item is checked (checkbox to the left of each record) the printing, emailing and publishing (if so configured) icons will be activated and will affect those actions. If the user realizes that the wrong file was selected, or is entering a number of invoices one file to the next, the Change File icon is a handy way to get to another file, without leaving the invoicing screen.

On the right side of the screen, next to each invoice, are a Modify icon and a Delete icon (if configured to allow deletions). The invoice number cannot be modified on an existing invoice.
The New Invoice icon will take the user to the Invoice Entry screen shown below, from which either a pre-bill or invoice can be created (if so configured). The date will default to the current date. No invoice number will be assigned until the invoice is completed. If a party to the file has been assigned as the Bill To Customer, their information will complete the name and address fields. The NAF icon, in the upper right corner, will activate when the Bill To field has the focus so a customer can be selected from the NAF.

![Invoice Entry Screen](image)

The Type of Invoice box, in the upper right of the screen, is where the user will indicate if the item being prepared is a Regular Invoice or a Pre-Bill. This is also the control used to switch a pre-bill to a regular invoice.

Detail lines of the invoice are entered in the lower half of the screen. There is a limit of 30 entries per invoice. The Product Code column presents the items loaded in the Invoice Description lookup table (maintained by the System Admin via the Utilities module). The item selected from the dropdown will default a Description, possibly a Liability Amount (also controlled by the Invoice Description table) and possibly an Amount (if one is defaulted for the code selected). The Clear icon, to the right of each entry will initiate the removal of the item, and the user will be prompted to confirm they intend to delete the entry.

The Import Title Charges button, in the lower left of the screen, will present if the enhanced Sub Escrow functionality is enabled, under which Title and Sub-Escrow users can enter title charges. This button will pull charges entered under that function into the invoice, eliminating the need to re-type them.

When the invoice detail entry is complete, click on the OK button to save and return to the Create & Print Invoices screen. To exit without saving, click on the Cancel button.
Impact Online Documents (Impact Online sites only)

The Impact Online Documents option, on the File menu, will only appear on sites utilizing Impact Online. Impact Online is used to allow customers to open files via the Internet, and to let customers view documents published from Impact to Impact Online.

The option, in Escrow, is used to do two specific functions: Delete documents that have been published to a file in Impact Online and to alter viewing permissions to parties to the file on published documents.

The screen above will present after the user identifies the file for which Impact Online-published documents should be managed.

The Change File icon, at the top of the screen, is used to switch to a different file’s published document list.

The Delete Selected icon, at the top of the screen, will be enabled once one or more documents have been selected by entering a checkbox in front of the document Description. This action will delete the document(s) selected from Impact Online, not from the Document List for the file, in Escrow.

The checkboxes under the party type headings (Buyer, Seller, Lender, Listing, Selling and Other) indicate whether those party types have permission to view the specific published documents. These are set when a document is published, but can be altered from this screen.

Click on OK to save changes and return to the Escrow desktop.
**Impact Express (optional)**

The **Impact Express** function provides for the quick entry of a number of new escrow files, over a range of available consecutive numbers, with a minimal amount of information being requested initially. All files created through this method are considered “Open” as of the date they were created (unlike the Tract approach, which tags files as new once limited data is entered via Initial Questions.) As an escrow number cannot be returned to “unused” status, once selected for use, the company may have this function turned off if it is not expected to be used, to prevent the erroneous use of a large number of file numbers by accident.

**NOTE:** **Impact Express** must be enabled by the system administrator.

Clicking on the Impact Express menu entry, on the File menu, will trigger the presentation of the **Impact Express Order Entry** screen, shown to the right.

Depending on the user’s access level, the **Branch** field may already be defaulted and may be unchangeable. If it is not filled in, the user should select the branch the files are to be established in, using the dropdown branch list.

The user must type the first number for the series of escrows to be opened into the **Starting Escrow #** field. Automatic numbering does not apply to this screen. The number entered must have at least four digits next to each other, and cannot be an existing number.

The user must type the number of escrows that should be opened into the **Number of Escrows** field.

The **File Type** selection is used to designate whether the new files are to be **Residential** or **Commercial** in type.

Once all of the fields are completed, click on **OK** to proceed, or **Cancel** to exit without creating the files.

Should the **Starting Escrow #** that was entered be a pre-existing number &/or not have four digits next to each other, then a message stating that problem will present. Click **OK**, to clear the message, and then enter a **Starting Escrow #** that is not a pre-existing number and which has four digits next to each other.

The system will present a screen asking the user to confirm that they wish to create whatever number of files they have requested, like that shown here. The user should carefully check the count requested and then click on **Yes** to continue, or **No** to stop and correct the count.
The system will present a modified initial data entry screen, as shown below, that reflects the number of files that have been requested in the header. The first file number requested will present just below the icons at the top of the screen.

NOTE: If the user does not proceed through the data entry screen for each file, but clicks on the Save & Exit icon at any point before the last file requested has been presented, the balance of the files requested will not have been created.

The user should proceed to enter data in the data entry fields for the first file. The only required field on the Impact Express data entry screen is Escrow Officer, regardless of the system’s mandatory fields settings.

The NAF icon can be used to furnish information for the following fields:

- Title Company (outside Title Co)
- Source of Business
- Bill To Customer
- Seller #1
- Buyer #1
- Lender #1
- Attorney #1, #2
- Other Party

Across the top of the screen are seven icons (other than the NAF icon discussed above), which are explained below.

The Save & Exit icon will save the current file and exit the Impact Express routine. If the user had not proceeded through all of the files requested, they will not all have been created...just those worked up.

The Print icon has a single option under it – Title Instructions. The user can print the Title Instructions for the file on the screen with this option.

The Previous icon will be grayed out if the user is on the first file requested. If not on the first file, the icon can be used to move back through the files being worked up, saving changes on the current file.
When the dropdown arrow to the right of the Jump icon is clicked on, a listing of all of the files that have been worked up at all (by going to them in order with the Next icon, so that they have been created) so the user can “jump” to a file out of order. Again, the dropdown will initially only present the first file requested, if the user has not moved through each file requested, thereby creating them.

The Next icon will save data on the current file and take the user to the next sequentially numbered file in the set requested. The Next icon will be grayed out when the user reaches the last file requested. At this point, once the data entry is completed for the last file, and the file has been submitted to Title, if so desired, the Save & Exit icon would be used to get out of the Impact Express data entry screen.

Clicking on the Clear icon, at the top of the screen, will result in a prompt asking if the entire screen should be cleared for the current file. If the user replies in the affirmative, all data entered, including the Order Type and Escrow Officer will be removed from the screen. The Clear icons in the body of the screen, by the Source of Business and Bill To Customer fields, will only clear those respective entries.

The Send to Title icon is used to submit the file presently on the screen to the Title Department. The user will be presented with a confirmation prompt and with a prompt asking if the Title Instructions should be printed for the file.

After the files are opened through Impact Express the user may work the files more completely through the routine Initial Questions, and other data entry, screens.

**View Escrow History (optional)**

There are events that occur within Impact/SQL that are tracked and written to a history log file. If the option is turned on, in Utilities, to allow users to view the history data, users will see the View Escrow History option on the File menu.

The listing of events that are tracked include:

- File Initial Opening
- Change of File Status
- Title Instructions Printed
- HUD or HUD1A Printed
- User Opening of the File (on desktop)
- Commitment/Prelim Typed
- Commitment/Prelim Released
- Policy Typed
- Change of Branch of File
- Change of Data Entry Type
- File Copy
- Vesting Data Imported
- Commitment/Prelim Deleted
- Sale Price Changed
- Messaging Item
- Loan Amount Changed
- Buyer Name Changed
- Seller Name Changed
- Marketing Rep Changed
- Marketing Rep Percentage Changed
- Title Charges Status Changed
- Ordering of Title Search

Some of the items tracked will reflect the Previous Value and New Value on the View File History screen.

The Change File icon, at the top of the screen can be used to pull up the history for another file.

The Print icon can be used to generate a printed report of the file’s history.
**Publish File (optional)**

Should the environment be configured with one or more integrations that can accept file data, the Publish File menu option will appear on the File menu. Clicking on the item will trigger the DSI Messaging component installed to attempt to publish the file data.

If the publish event is successful, the user will receive a prompt to that affect, with the corresponding system’s number assigned to the file. If the publish event is unsuccessful, the user will receive a message explaining why the event was unsuccessful. If, for example, the problem is missing data, the user would correct the situation and re-publish.

**Save File**

When a file is opened on the user’s desktop (indicated by the file number being presented in the lower left corner of the desktop screen), the Save File option will be enabled on the File menu. This option is used to save any data changes not already saved and will unlock the file and remove it from the desktop – freeing it up for others to work with. It is highly recommended that any file be saved out of as soon as it is not being worked on, to make it available for other users who may need to access it.

The Save File icon, on the tool bar, performs the same function.

Choosing the Select File or New File options will automatically execute the Save File function if there is a file already open on the desktop.

**Outside Services (optional)**

Should the environment be configured with one or more integrations with outside services, such as with RealEC, the Outside Services menu option will appear on the File menu. This option is used to gain access to the interfaces of those service providers. Separate documentation on those integrations should be consulted for further information on functionality.

**Exit**

The last entry on the File menu is Exit. This function is the same as clicking on the Close icon in the upper right corner of the Impact/SQL Escrow desktop. This will shut down the Escrow module. Should there be a file open on the desktop, it will be saved before the module is closed. It is highly recommended that the user exit the application when they leave their desk or go home for the day so that they do not leave the system accessible under their login – giving others the opportunity to work in the system as though they were the user.
**Edit Menu**

The *Edit* menu is where the data entry screens are located for Escrow files. Order and settlement information is entered on these screens. The *Edit* menu is only activated when there is a file open on the user’s desktop. This means the file is locked to other users, so that there is not a conflict over data being entered and saved on the file.

There are four entries found on the *Edit* menu; three are always the same and the last depends on the type of file selected (Residential or Commercial) and the data entry form selected (if Residential). The menu will reflect the following items, each of which will be described in the following pages:

- **Initial Questions**
- **Legal Description**
- **Order Title Search**
- **HUD Style Entry** or **Worksheet Style Entry** or **Settlement Entry**

As indicated earlier in this documentation, when a file is opened initially, the determination is made at that time whether it is to be a “Residential” file or a “Commercial” file. This distinction is NOT to be considered the designation of a transaction type or property type, but, rather, is driven by the nature of the underlying real estate transaction. The reader is referred to the earlier section of this documentation on **New File** setup for the explanation of the two types. If “Commercial” was the file type selected at opening, the fourth *Edit* menu entry will be “Settlement Entry”. If “Residential” was the file type selected at opening, the fourth *Edit* menu entry can be either HUD Style Entry or Worksheet Style Entry – dependent on system settings and the user’s choice of entry style, made on the first screen of Initial Questions – to be explained further below. And, within the Residential file type, there is a further distinction for the type of data entry, driven by whether the transaction is governed by the RESPA 2010 regulations or not.

The following discussion of the *Edit* menu’s many facets will discuss all of the aforementioned data entry types. The differences are most pronounced in the **HUD, Worksheet** or **Settlement Entry** area, but there are some differences during the **Initial Questions** data entry phase as well. A user is well advised to review and consider all options before opening a file and making the determination as to which path they will be following. In an effort to avoid confusion between types, the following discussion will be broken down by type (*Residential vs. Commercial*) where relevant.
Initial Questions - Residential

The Initial Questions entry screen listing, under the Edit menu, will present, for Residential files, between six and eight (6 & 8) items, depending on system configuration (listed below). These screens are used to enter the data required before submitting an order to Title. Since not all fields pertain to every escrow, the user must determine which data to enter. Some fields in Initial Questions can be set to require an entry – they can be made mandatory. Mandatory fields will have a green background on the data entry screens.

- Dates/Transaction Info
- Property Information
- Parties
- Commissions (optional)
- Source of Business/Bill To
- Title Information
- Prelim Distribution List
- Misc Data Entry (optional)

Functional and Navigational Icons on the Initial Questions Screens

At the top of the Initial Questions screens, there are a set of icons used to perform functional and navigational tasks.

The Save & Exit icon is used to get out of the Initial Questions screens. Any data changes that have been made are saved to the database through use of this icon. There is not a way to exit without saving changes that have been made to the screens.

The Print icon has three options under it: HUD, Settlement Statement & Title Instructions. The user can print any of the three documents, for the file on the screen, with this option by clicking on the dropdown arrow and selecting the document to print.

The Title Search icon is used to submit the order to Title. While the user will be prompted as to whether they wish to submit to Title upon exiting, they can initiate that function with this icon.

The Previous icon will be grayed out if the user is on the first screen of Initial Questions. If not on the first screen, the icon can be used to move back through screens as they are being worked up.

When the Jump icon is clicked on, a listing of all of the Initial Questions screens is presented so the user can "jump" to a screen out of order. In addition, there is an entry on the screen listing to jump to the HUD entry screens directly, without having to save and exit.

The Next icon will take the user to the next screen of Initial Questions, unless the user is on the last screen, and then the icon will be grayed out.

The Calendar tool presents next to date fields and can be used to select a date. Alternatively, the user can simply type in the date in MMDD form (if current year) or MMDDYY if not the current year.

The F4 function key can be used to open dropdown menus for the fields with them.

The TAB key can be used to move from field to field.
Dates/Transaction Information Screen (Residential)

The first screen of Initial Questions is the Dates/Transaction Information screen, shown below.

Order Type is the first field at the top of the screen, if the system is configured to present it. A default can also be set for the database. The options are Escrow & Title, Title Only and Escrow Only. The dropdown list is presented by clicking on the arrow to the right of the field, or clicking on the F4 function key. The user can also hit the “E” or “T” keys to move through the options (“E” for the two entries starting with “E”, “T” for Title Only). The primary use of this field is for categorization of transactions for management reporting. However, the Escrow Only selection will eliminate the prompts about submitting the order to Title; the user can still submit manually – but should not need to.

Type of Closing is the next field and it is important to understand the options available.

- **HUD** – used for files that are not confirmed to need to consider the 2010 RESPA requirements and with which the user wishes to use data entry forms that resemble the HUD sections, with HUD numbering. A file with this selection can be switched to a “with GFE” selection.

- **Worksheet** – used for files that are not confirmed to need to consider the 2010 RESPA requirements, and with which the user wishes to use data entry forms that do not have HUD numbering and which include extra proration and rent schedule fields. A file with this selection can be switched to a “with GFE” selection.

- **HUD with GFE** – used for files that must comply with the 2010 RESPA regulations that require a GFE Comparison and Loan Terms schedule, among other things, and with which the user wishes to use data entry forms that resemble the HUD sections, with HUD numbering and GFE data entry fields. A file with this selection cannot be switched to a “non-GFE” selection. A HUD-1A cannot be generated with a file of this selection.

- **Worksheet with GFE** – used for files that must comply with the 2010 RESPA regulations and with which the user wishes to use data entry forms that do not include HUD line numbering. This selection is very infrequently used, as the RESPA regulations direct items to specific line numbers and not having them available for reference makes data entry difficult. A file with this selection cannot be switched to a “non-GFE” selection. A HUD-1A cannot be generated with a file of this selection.
The default **Type of Closing** can be set for the database, but the user can always select the other options (unless the database is set to allow Worksheet styles only – which is very rare due to the 2010 RESPA requirements). The user will be prompted to confirm the change upon tabbing out of the field or clicking on **Save & Exit**. Should the file have additional deposits, the user will receive a warning that deposit entries will be deleted when the change is made.

As indicated previously, if a “non-GFE” **Type of Closing** has been selected, it can be changed at a later time to a “with GFE” type. The user will be prompted, when the user tabs out of the field, or clicks on **Save & Exit** to end data entry, to confirm the switch is desired.  **As it is not possible to switch back from a “with GFE” type to a “non-GFE” type, the user must be very sure the switch is intended.**

**Escrow Officer** – all files must have an escrow officer assigned to them, even Title Only files. The user should select an escrow officer from the dropdown list. Only EO’s assigned to the branch of the file will be presented. The flagging of a user as an Escrow Officer is done through the **Users** function, in the **Utilities** module, by a System Admin.  A **Secondary Escrow Officer** field may present if the option to add a second is enabled.

**Title Officer** – the dropdown list presented is of internal title officers assigned to title plants available to the branch of the file. If a TO is selected, the title branch of the TO will be the title branch the file is submitted to, when submitted to Title. If no TO is selected, and the branch of the file has multiple title branches available to it, when the user submits the file to Title, they will be prompted to select a title branch for the submission. The flagging of a user as a Title Officer is done through the **Users** function, in the **Utilities** module, by a System Admin.

**Processor** – this field is used to identify an escrow secretary or escrow assistant that will be the primary support person for the file. All users assigned the Processor flag will appear in the dropdown. The email notification on the release of the prelim/commitment, if so configured, will go to both the Processor and the Escrow Officer assigned to the file. The flagging of a user as a Processor is done through the **Users** function, in the **Utilities** module, by a System Admin.

**Marketing Rep (1-2, or 1-4)** – depending on system configuration, two or four marketing rep fields will be presented to the user. The appropriate rep(s) should be selected by the user, and if more than one rep is selected, each (other than the first) should be assigned their “ownership interest” percentage. The undefined balance will be considered the first rep’s interest. The percentages can be used in management reporting. The dropdown list of marketing reps is maintained in the **Utilities** module, by a System Admin, in the **Marketing Reps User Table**.

**Date Opened** – this field is pre-filled with the date the file was created but can be changed by the user manually or with the Calendar tool. There is another system-managed date field, that the user cannot change, that maintains the actual date the file was created – which tends to be the field used in management reporting.

**Contract Date** – this field is used to enter the date of the purchase contract, if there is one. This field is available to be pulled into escrow documents.

**Close of Escrow Date** – this field is used for the anticipated closing date. It prints as the Settlement Date on the HUD and Settlement Statement. If this date field is changed, after being initially set, a pop-up window will remind the user to check on the Proration Date.

This date is also used as the basis for closing projects. A separate **Close Date** field is maintained by the system, normally the date that the Fee Check/Fee Slip was generated, which is most often used for management reporting.

**Contract Number** – this field is used in conjunction with the Contract Date, as needed.
**Proration Date** – this field is used to set the beginning or ending date on certain prorations. If the proration date field is changed, the user will receive a prompt asking which prorations should be altered by the system – giving the user control over whether existing calculations should be changed. If some data has not been entered, not all of the prompt's options will be enabled. The user may check any and all enabled options – with the Taxes, Assessments and Miscellaneous prorations option being pre-checked. If that option is not desired, the user must uncheck it.

**Project Name** – this field is used to link escrow files to a project or condo master file. The field is used to group files with a project for reporting purposes, enabling reporting on an entire project for a developer. The project name can be up to six (6) characters. When the project name is entered, the system will check to see if there has been a project identified by that name previously established in the database. If not, a screen will be presented, like that shown here, on which the user should identify the full **Project Title**, the number of the **Master Escrow** (must be a pre-existing file, in the user’s branch; can be the active file) and the **Bank** involved (will default to the bank of the Master Escrow).

**Funding Date** – this field is used to identify the funding date and will appear on the HUD.

**Disburse Date** – this field is used to identify the disbursement date of the file and will appear on the HUD.

**Type of Transaction** – the transaction type is selected from the dropdown list. This field is used to categorize files for management reporting. This field is often mandatory. The transaction type lookup table is maintained, through the Utilities module, by a System Admin. Transaction types can be flagged to enable 1099-S reportability or to prevent it.

**IRS Reportable** – this checkbox is used to indicate whether the specific file will have 1099-S reporting done out of it. If the transaction type previously selected is flagged to indicate files of that type are not subject to 1099-S reporting, this option will be grayed out.

**Exchange** – this checkbox is used to indicate the transaction is involved in a 1031 Exchange – so that the corresponding checkbox on any 1099-S produced will be checked. If the transaction type previously selected is flagged to indicate files of that type are not subject to 1099-S reporting, this option will be grayed out.

**Underwriter** – this field is filled via the dropdown listing of available underwriters. If only one is available, it will default. Once the file has been submitted to Title, the underwriter selection cannot be changed through the Escrow module – only through Title.

**Premium Rate** – the dropdown for this field presents the product sets that have been defined by the business as those available to their customers. The listing will present the various combinations of owner’s and lender’s policies and the user should select the description that best fits the transaction. The listings may differ by underwriter. Should additional information need to be provided to Title, it can be added in the **Comments** field on the **Title Information** screen.

**Sales Price** – the purchase price of the property is entered in this field, if a purchase transaction. The field can be left blank if a refinance transaction. The loan amount, on a refinance transaction, is not entered here, but on the **Lender** screen.
**Initial Deposit** – this field is used to record the earnest money on a purchase transaction. The first time an amount is entered in this field, an Initial Deposit (receipt entry) screen will present, letting the user create the earnest money receipt at that time. The Earnest Money receipt type will default. The user should enter the **Payor Name** and confirm the other information on the screen is correct. If the user is in fact not in receipt of the funds, and does not wish for a receipt to be created, then the **Cancel** button should be clicked. The user should only click **OK**, and continue with the receipt creation, if the funds are in hand.

In the HUD style of data entry, the Initial Deposit is the only deposit that adds the deposit to the HUD and provides for the creation of the receipt. Recording of all other deposits of additional funds from the buyer involve two steps – creating a receipt and entering a line item on the HUD.

In the Worksheet style of data entry, additional deposits will prompt the user to create receipts, if the system is so configured.

**Funds Held by Broker** – this field is used to identify the amount, if any, of Buyer funds being held by one of the agents (Listing, Selling or Other), that will not be placed into escrow and will be deducted from their earned commission.

**Funds Held By** – the dropdown list will let the user select which agent (Listing, Selling or Other) is holding the funds identified in the field above. The system will utilize this information to manage the funds being disbursed to the appropriate party.

**Estimated Fee Information – Title and Escrow** – these fields are purely informational and are used to record anticipated fees on the transaction. Managerial reports can present this information. These fields are not used on the HUD or Settlement Statement.

That completes the description of the **Dates/Transaction Information** screen of **Initial Questions**.
Property Information Screen (Residential)

The **Property Information** screen is used to enter information on the property involved with the transaction. Most of the fields on this screen are available for use in escrow documents and in reports.

There are three tabs on the **Property Information** screen: **Property**, **Mobile Homes** and **Notes**. Should there be data on the respective tabs, there will be a red diamond icon next to the tab name. The **Notes** tab presents a memo field into which comments may be entered by the user for future reference.

**Property Tab**

The **Property** tab is used to detail all the pertinent information about the property, starting with the address information. There are two lines for the street or box address information (**Address #1** & **Address #2**) and then **City**, **State** and **Zip Code** fields. The **City** field has a dropdown list that can be populated by the business with those cities that they routinely do business with; selections from that list may populate the **County** and **State** fields at the same time. The user may also enter the city manually. The **State** field dropdown has all of the states abbreviations listed.

If the **Foreign Address** check box is checked, the City, State and Zip Code fields are replaced with a single **Location** field that can be used to identify the city, country and postal code (if any) for the foreign address. This routine is recommended for military addresses as well.

There will be a **Search** button to the right of the Address #1 line if the system is configured for an integration with an external property search function, such as that from CoreLogic. This type of search function is used to qualify the address information and let the user select search results to populate much of the property information screens. This is not the same as the search function utilized within Impact to locate files.

The **County** field can be populated manually or via the business-maintained dropdown listing of counties.

The **Property Type** field is populated via the business-maintained dropdown listing of property types (ie. 1-4 Family Residence). The property types are used to categorize the transactions for management reporting, but have no other functionality in the system.

The **Municipality Type** and **Municipality Name** fields are provided, but are not used in most states.
The **Subdivision Name** field can be filled from stored subdivision information via the use of the button with the ellipse (...) on it, next to the field. The stored subdivision information can fill the **Tract**, **Book** and **Page** fields as well. If the user does not find the subdivision name they need in the listing available, they can enter the name manually. The stored subdivision listing is maintained by the business via the **Utilities** module.

The **T/S Weeks** field is used to store the number of weeks of a timeshare unit, should the transaction involve a timeshare transfer.

The **Unit**, **Low Lot**, **High Lot**, **Block** and **Q1Q2Q3Q4** sections of the screen are used to detail information related to the plat map of the property. The user would only use the **Unit** or the **Q1Q2Q3Q4** sections, not both, depending on how the property is described in the land records.

The **Brief Legal** field will auto-populate from data entered in the **Subdivision Name**, **Tract**, **Map Book** and **Map Page** or **Section**, **Township** and **Range** fields (whichever set are used), the first time the brief legal field is tabbed or clicked into. The user can modify the brief legal that is presented. The brief legal field is limited to 250 characters. Note: if changes are made to the individual component fields, the brief legal will not be automatically reconstituted unless it is deleted and the field is tabbed into again when empty.

Clicking on the **Full Legal** icon will launch MS Word® and let the user enter the full legal description. The full legal is stored as an MS Word® document by Impact/SQL and, as such, it can be incorporated into other documents prepared within Impact/SQL. Often, Escrow does not enter the full legal, but leaves that task to Title. Once an order has been submitted to Title, the full legal cannot be edited by Escrow unless an override setup option is enabled.

The **Tax Parcel ID Numbers / Tax Map Key** fields (four) are available for that data and are available to the **Search** function in Impact. Hyphens must be included when entering the tax parcel numbers, as there is not a standard convention.

The **HPR Numbers** (horizontal property regime) fields are used with property descriptions of timeshare or condominium units. If needed, these fields could also be used for additional tax parcel ID numbers or tax map keys. Depending on the system configuration, these fields may be labeled **Property Levy Codes**.

**Mobile Homes tab**

The Mobile Homes tab, on the Properties screen, is used to detail any number of mobile homes that may be involved with the transaction. The data entered on this tab is available for use in escrow documents. When first presented, the screen looks like the sample below.

Clicking on the **New Mobile Home** icon will create an entry, in the column on the left side, of “Mobile Home 1” and will open up the data fields for entry of information. The NAF will be enabled for the **HCD Address** information.

Once one or more mobile homes’ information has been entered, if the user determines one should be deleted, it should be highlighted in the column on the left and the **Delete Selected** icon should be clicked on. The user will be prompted to confirm the intent to delete the item selected.
Parties (Residential)

Residential files can have an unlimited number of Buyers, Sellers, Attorneys, Accommodators and Other Parties. They can have three (3) Lenders and three (3) Real Estate Agents (Listing, Selling and Other – one each). Entry and editing of parties is done via the Parties menu item on the Initial Questions sub-menu. If the user is on the Property Information screen, clicking on the → Next icon, at the top of the screen, will take the user to the Parties screen. When first opened, prior to any parties being entered, the screen is as shown here.

The **Buyer** tree-view is opened, and the Buyer category header is highlighted in the lower left corner. The category headers have counts after each to indicate the number of parties of each type that are already in the file. Clicking on the category you wish to add a party to will bring that category’s tree-view up on the top left of the window.

The **Entity Type** field has the focus when the screen is first loaded. However, if the user sees that the wrong **Party Type** has been selected for the new entry, it can be changed at the top of the screen. Once a party has been created, its party type cannot be changed. However, a party entered with the wrong type can be copied to a new party, with the correct type, with the **Copy From** function (at the bottom of the screen). Then, the original, erroneous, entry can be deleted.

The **Cancel** and **OK** buttons apply to all of the tabs of data together, not just the tab being viewed.

Information on the various parties’ screens follows.
**Buyers and Sellers**

The Buyer and Seller party types have identical screens. The other party types have unique screens, as will be detailed later in this document.

NOTE: Buyer and Seller names can be 8,000 characters long, while other parties can have names of up to 250 characters.

The New Buyer screen, shown on the previous page, is quite full. There are five tabs across the top (Information, Vesting, Signature, Contacts and Notes) and three tabs across the middle of the Information tab (Current Information, Forwarding Information and Distribution).

The fields on each screen are generally self-explanatory, but some warrant special mention.

**Information Tab**

The Entity Type field, at the top of the Information tab, has two selections: Individual and Company.

If Individual is selected, the Prefix, and First, Middle and Last Name and Suffix fields are presented. The name will be properly managed for presentation on documents and on the 1099's.

If Company is selected as the Entity Type, the Prefix, and First, Middle and Last Name and Suffix fields are replaced with a Full Name field. In addition, an Attention To field will be added so the primary contact at the company can be identified.

The Tax ID Type field has three options: TIN, EIN and SSN. Select the appropriate type and enter the 9 digit value in the Tax ID field – without hyphens – and the value will be presented with the appropriate hyphenation.

The Reference Number field can be used to enter any party-provided value.

The user should check the Source of Business and/or the Bill To Customer check boxes if the party is either of those. Only one party can be the Source of Business and only one can be the Bill To Customer. If the user tries to assign each of those roles to more than one party, they will be warned about that fact.

The Ownership Percent field, seen on Commercial Buyers and Sellers is not seen on Residential files.

**Current Information and Forwarding Information Tabs**

The Current Information and Forwarding Information tabs, at the bottom half of the Information tab, are for addresses and contact numbers. The Link To field, on the Current Information tab, has a dropdown selection of either None (the user will enter the address) or one of the properties that has been entered can be selected to be used as the current address. Addresses of the other buyers (if entering a buyer) or sellers (if entering a seller) can be linked to as well. The same field, on the Forwarding Information tab, will offer the same choices and the address entered on the Current Info tab.

The Primary Notification dropdown choices are: Work Number, Home Number, Cell Number, Email, Fax Number, Mail or None.

**Distribution Tab**

The Distribution tab is used to identify the number of copies of the Prelim, CC&R’s and Document Sets should be provided to this party, and the method of delivery. Depending on system settings, there can be references to the Legal, Vesting and Plotted Easements as well.
**Vesting Tab**

The **Vesting** tab is used to detail how this party will hold title, and will only appear for **Party Types** of **Buyer** and **Seller**.

![Vesting Tab Image]

The **Hold Title Code** dropdown list, at the top of the Vesting screen, presents the database defaults for vesting. One of those can be selected as the entry, and when that is done, it will appear in the body of the screen. If the user wishes to simply type in the vesting information, in the body of the screen, they may do so if no selection is made in the Hold Title Code field. If a Hold Title Code entry is desired as the starting point for a manually edited entry, select the appropriate code, by clicking on it, then reselect the blank entry at the top of the list...this will result in the initially selected entry being put in the body, but then let it be edited. This field can contain 8,000 characters.

**Signature Tab**

The **Signature** tab is used to create “custom signatures”. Custom signatures allow the user the flexibility to handle information above and below the signature line in documents. This signature function is useful when dealing with corporations, attorneys and trusts, which might require an explanation of the status of the signer. The text boxes can contain 8,000 characters.

![Signature Tab Image]
**Contacts Tab**

The **Contacts** tab is used to enter name and contact information for people that are contacts for the party being edited. For example, a buyer may want his/her secretary to be their primary contact on matters relating to the transaction. This screen is used to load one or more contacts for the party being entered. When first presented for a party with no contacts loaded, the screen will reflect “No records found.” in the body of the screen. If contacts have been entered, they will be listed on the screen.

There will be **Modify** and **Delete** icons next to each record.

The **New Contact** icon, in the upper left corner of the first screen presented will bring up the screen below.

The **Roles** available for assignment to **Contacts** are **Assistant, Loan Officer, Loan Processor** and **Secretary**. This list can be expanded, from the back end only currently, by DSI personnel.

The **NAF** is available when the cursor is in the **Name** field.

![New Contact Screen](image)

The **Add Another** button, at the bottom of the screen, is used to do just that: add another contact.

The **Cancel** button is used to exit the **New Contact** screen without saving changes.

The **OK** button is used to save data that has been entered and to then exit the **New Contact** screen, returning the user to the listing of contacts screen.

**Notes Tab**

The **Notes** tab, on the **New/Edit Party** screen is available to add any comments on the party that the user wishes.
**Notary Block Icon – Buyers and Sellers Only**

At the top of the Parties screen, when either the Buyer or Seller category is selected (by clicking on it), there is a Notary Block icon that will present that is used to edit the Notary Block for either Buyers or Sellers (one is permitted for each category, not for each party in the category).

When the Notary Block icon is clicked on, a blank screen will be presented, like that shown below. The user may enter whatever text they wish to appear in the buyer or seller signature area detailing the notary verbiage.

![Notary Block Icon](image)

**Copy Party Icon – Any Party**

Next to the Notary Block icon, and active whenever a specific party is highlighted, is the Copy Party icon. Clicking on the icon will open a new party screen, filled with the highlighted party’s information, with the Party Type field available for edit at the top of the New Party screen. So, for example, a Buyer can be selected and be copied using the Copy Party icon and the copied party could then be made a Seller party, by changing the Party Type field to Seller.

An alternative approach is to right-click on a party and select Copy from the menu presented.

**Reposition Party**

The Reposition Party icon, above the tree-view when there is more than one party entered in the category, will present a window in which the user can reorder the parties – this will impact the number of the party, which can impact documents that have already been prepared based on the previous ordering. The Move Up and Move Down icons are used to push the selected party in the desired direction.
Lenders – (Residential)

The Lender party type has a different set of data entry/edit screens. The content of the Information tab is different from that of the Buyer & Seller party type screens, and will be explained below. Two of the other top-of-the-screen tabs – Contacts and Notes – as well as the Distribution sub-tab on the Information screen - are common in layout and content as those on the Buyer & Seller screens, so will not be discussed again here. There are Loan Terms and Tolerance Adjustment tabs, which do not exist on the Commercial files’ Lenders screens. Note: the Loan Terms and Tolerance Adjustment tabs will only appear on “with GFE” files.

There are placeholders for each of the three (3) permitted lenders in Residential files already established on the Parties screen. Traditionally, Lender #3 is used for the Mortgage Broker. After highlighting the Lenders category, the user should use the Modify icon, on the right side of the lender placeholder they wish to add data to, to bring up the Edit Lender screen below.

Information Tab - Lender

The Information tab, on the New/Edit Lender screen, is presented here (the “with GFE” version).
The **Full Name** field can contain 250 characters, and the **NAF** can be used to load that data, along with the related **Contact Information** fields on the **Contact** sub-tab.

The name of the primary lender contact is entered in the **Attention To** field.

The Lender’s **Reference Number** field is the third field on the screen. There is a **Loan Number** field below, so this field would likely be used for some other lender-provided value.

If the Lender entry is the **Source of Business**, that box should be checked.

If the Lender entry is the **Bill To Customer**, that box should be checked.

On the Lender #3 screen ONLY, there is a **Mortgage Broker** checkbox. If the party being entered on the Lender #3 screens is representing a lender but not making a loan, then the **Mortgage Broker** box should be checked and no loan information would be entered. If this box is checked, the **Loan Amount** and **Type of Financing** fields will be disabled.

The **Loan Number** and **Loan Amount** fields are next, followed by a field for the **Mortgage Insurance Number**.

Once the file has been worked up, depending on the charges that have been entered, and if they are set to have been calculated by the system based off of the **Loan Amount**, if the **Loan Amount** is changed, a screen like the one shown here will pop up, after the Lender screen is asked to be saved and closed, that will identify areas that would be affected by the change made and ask if the user wishes to have the figures recalculated. The items that might appear are **Loan Origination Fee**, **Loan Discount Fee**, **City/County & State Tax Stamps**, **City/County & State Transfer Tax** and **Escrow/Title Fees**.

The **Type of Financing** field has ten (10) options available on its dropdown list, and these dictate the loan type text on the settlement statement, and manage whether interest prorations can be detailed from this screen.

**New Loan** – used for most transactions; no interest proration from this screen. The loan will be applied to the buyer/borrower with prepaid interest calculated in the new loan section.

**Assumption** – if a loan is being assumed, interest proration can be done here; will offset the buyer and seller with interest prorations.

**Note & DT** – interest proration can be done here; will offset the buyer and seller with interest prorations.

**Seller Carryback** – Lender Full Name field will populate with “:S1” payee shortcut (Seller One); interest proration can be done here; will offset the buyer and seller with interest prorations.

**Realty Mortgage** – interest proration can be done here; will offset the buyer and seller with interest prorations.

**Purchase Money** – interest proration can be done here; will offset the buyer and seller with interest prorations.

**Refinance** – no interest proration from this screen.

**Second Mortgage** – interest proration can be done here; will offset the buyer and seller with interest prorations.

**Agreement for Sale** – interest proration can be done here; will offset the buyer and seller with interest prorations.

**Reverse Mortgage** – treatment of the loan follows specific RESPA rules ("with GFE" only)
The **Type of Loan** field has five (5) options, which mark the appropriate HUD box for loan type: FHA, RHS, Conv. Unins., VA and Conv. Ins.

**Lender Interest Proration**

The **Interest Prorate** function will be enabled if available for the **Type of Financing** selected. The user should click on the checkbox in front of the **Prorate** label, in the **Interest** box on the right side of the **Edit Lender** screen, to open the **Lender Proration** screen, shown here.

The Proration Types available are **Interest** and **Per Diem**.

The user should select the appropriate base for the proration (360 or 365 days), if the default is incorrect.

The **Interest Rate** should be entered, along with the **Starting Date** and **Ending Date** (this is a “to” date, not a “through” date).

The appropriate **Give Credit** to party should be selected.

The **Calculate** button can then be clicked on to compute the **Prorated Amount**.

Should there be an existing proration that should be removed, the user should click on the **Remove** button.

**Yield Spread Premium (non-GFE)**

The **Yield Spread Premium** check box will be enabled on non-GFE files. The Yield Spread Premium (YSP) is reflected as a notation under the loan section of the HUD or Settlement Statement, again, on non-GFE files. When the checkbox in front of the **Yes** label is checked, in the **Yield Spread Premium** box, on the **Edit Lender** screen, the **Yield Spread Premium Broker Information** screen shown here is presented to the user.

The Lender Payee shortcut (:L3) can be used for the **Broker Name**, if the broker information has been entered for Lender #3.

The **Description** can be selected from the drop down list, or the user can type in their own description. **Yield Spread Premium** and **Broker Compensation** are the available choices in the dropdown listing.

There are three options for the **Code** field:

- The **WTH** option will subtract the **Amount** entered from the **Due From Lender** funding amount that appears on the **Lender Summary** screen.

- **Over Funded (Issue Check)** - If the lender funds the YSP then a check will be issued payable to the **Broker Name**, and will appear as a negative amount on the **Lender Summary** screen.

- **Not Over Funded** - this option should be selected if the lender does not include the YSP in the funding check, and the amount will not appear on the **Lender Summary** screen.
Contact Information Sub Tab - Lender

The Contact Information sub tab, at the bottom of the Information tab on the Lender party screen, is used to store information on the primary contact at the lender.

The Primary Notification field dropdown lets the user identify how the contact prefers to be communicated with. Options are: Work Number, Home Number, Cell Number, Email, Fax Number, Mail and None.

Loan Terms

The Loan Terms screen, on “with GFE” files, is presented here. The information for this screen should come from a combination of the lender’s GFE and Lender’s Instructions to Escrow. The screen starts out looking like the sample to the right, with many items “grayed out”. If the response(s) to the questions, on the left side of the screen, are “Yes”, the Yes box is to be checked and the grayed out fields will open up, indicating data can be entered. In the sample below, all of the responses are Yes, and you can read the screen’s field names more easily. The user should not check the Yes box unless the category is applicable.
Reverse Mortgage

Special functionality has been added to Impact/SQL for Reverse Mortgages to accommodate HUD and Loan Terms reporting requirements for “with GFE” files. To trigger the functionality, the Type of Financing selected, via the dropdown box, must be Reverse Mortgage.

With Reverse Mortgage selected as the Type of Financing, on the Loan Terms tab and the entry of any Initial Draw, in the 200 section of the HUD, the appropriate presentation of the loan amount, in the description area of line 202 (rather than in the column), is made, along with the proper presentation of Loan Terms on that page.

The Loan Terms tab, in a reverse mortgage situation, needs specific treatment, on specific lines, as indicated below, in addition to the entry of the initial draw amount, if any, on the 200 section.

Loan Term: check the Text box, and enter lender-provided text (ex: N/A” or “Unknown” or “Not Applicable”) in the field labeled Years.

Monthly amount owed…: check the Text box, and enter lender-provided text, as above.

Can loan balance rise?: check the Yes box, and check the Text box, and enter lender-provided text.

Total monthly amount…: check the Includes escrow payment of box, and check the Paid by or through draws from Principal limit box.

Enter the description “Initial Draw” and the amount on line 204 or 205 of the HUD, if there is one.
**Tolerance Adjustments**

The categorization of charges is very important in the 2010 RESPA process. Certain charges technically should not deviate from the GFE figures (Category 1), others can deviate by no more than 10% (Category 2) and others can deviate (Category 3). The third tab on the Lender/Loan Information screen is **Tolerance Adjustments**. On this tab (displayed below) the user would enter values, authorized by the lender, that acknowledge that there were deviations from the tolerance limits for Category 1 (zero tolerance) and Category 2 (10% tolerance limit) charges.

Quoting from the Federal Register’s Instructions on page 2 of the Good Faith Estimate (HUD-GFE), the charge categories are (Categories 1, 2 & 3, from left to right):

<table>
<thead>
<tr>
<th>These charges cannot increase at settlement:</th>
<th>The total of these charges can increase by up to 10% at settlement:</th>
<th>These charges can change at settlement:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Our origination charge</td>
<td>Required services that we select</td>
<td>Required services that you can shop for (if you do not use companies we identify)</td>
</tr>
<tr>
<td>Your credit or charge (points) for the specific interest rate chosen (after you lock in your interest rate)</td>
<td>Title services and lender’s title insurance (if we select them or you use companies we identify)</td>
<td>Title services and lender’s title insurance (if you do not use companies we identify)</td>
</tr>
<tr>
<td>Your adjusted origination charges (after you lock in your interest rate)</td>
<td>Owner’s title insurance (if you use companies we identify)</td>
<td>Owner’s title insurance (if you do not use companies we identify)</td>
</tr>
<tr>
<td>Transfer taxes</td>
<td>Required services that you can shop for (if you use companies we identify)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Government recording charges</td>
<td>Initial deposit for your escrow account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Daily interest charges</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Homeowner’s insurance</td>
</tr>
</tbody>
</table>

So, should there be charges that violate the tolerance limits, the lender and escrow officer must work together to have those charges authorized, and the net overage would be detailed on this tab, as a **negative number**. In the sample shown below, there was an overage of $100 in Category 1 charges and an overage of $200 in category 2 charges. These adjustments will display in the Comparison of Good Faith Estimate (GFEC) and HUD-1 Charges section of the HUD (top of page 3).

In addition, there is a **Show Credit(s) to Buyer on HUD in Section 200** checkbox, and two **Description** and **Amount** fields (which are enabled if the checkbox is checked), that can be used to detail lender credits on the first page of the HUD.
Accommodators

The Accommodator party type’s data screens are similar in some respects to the Buyer/Seller screens – in that there are Information, Signature, Contacts and Notes tabs – yet the bottom of the Information screen is patterned after the Lender party type screen, with the Contact Information and Distribution tabs.

Only the top half of the Information tab is truly different from either the Buyer/Seller or the Lender Information screens.

There is still a Reference Number, which can be used to store whatever the party provides as their “id” for the transaction.

There is a Full Name field, likely to be used for a company name. The NAF will be activated if the cursor is in the Full Name field.

The Attention To field would be used to identify the primary contact’s name at the company.

The Representing field will present, in the dropdown, all existing Buyers and Sellers (only), and the user should pick the party that the Accommodator being entered represents.

If the Accommodator being entered is the Source of Business or a Bill To Customer, the respective check boxes should be checked.

The balance of the Accommodator party screens are common to those discussed previously.
**Attorneys**

The **Attorney** party screens are identical to the Accommodator screens except there is not a Signature tab for an attorney entry.

**Agents - Residential**

The **Agent** party type screen is really made up of three sub-party types: **Listing (Sellers) Agents**, **Selling (Buyers) Agents** and **Other Agents**. Residential files are limited to one agent of each type, and there are placeholders for each created when the file is established.

The **Agents** party screens are identical to the Attorneys screens except there is not a **Representing** field for the agents.

**Other Parties**

The **Other** party type screens are identical to the Attorney screens.

**Commissions (Residential)**

The **Commissions** screen may be available on the **Initial Questions** menu, if the system is configured for it to appear there. The Commissions screen is the **HUD 700 Total Real Estate Broker Fees** screen.

![Image of HUD 700 Total Real Estate Broker Fees screen]

The **Price $** field should be pre-filled with the number from the **Sales Price** field on the **Dates/Transaction Information** screen. NOTE: If the **Price $** value is changed on this screen, the **Sales Price** on the **Dates/Transaction Information** screen will **not** be changed. Changing the **Sales Price**, on the **Dates/Transaction Information** screen, after this screen has been worked up, will result in a prompt asking the user if the **Price $** value should be changed – it will not automatically do so.

The **Total Commission $** field can be filled in two ways:

- If the commission is based on a percentage of the selling price, press TAB to proceed to the % field and enter a number in the commission percent field (usually between 3% and 8%). Then click on the TAB key to have Impact calculate the number for the **Total Commission $**; or,

- Alternatively, if the commission is a set dollar amount, just enter a number in the **Total Commission $** field, and TAB out of the field (bringing the focus to the **701. Detailed** label).
Prior to the Division of Commission detail being entered, a warning message will appear below the lines 701 & 702, stating that “The total of the agent commissions is $xxx.xx less than the total commission amount.” Below the Total Commission line, at the top of the screen, is a heading of Division of Commission (Line 700) as follows: and lines 701 & 702 are presented to detail the agent commissions. The “to” (payee) fields on each line will be pre-filled with the name(s) of the Listing Broker and Selling Broker if they have been entered. They should be entered as Parties prior to getting to this screen. Entering them here will not populate the parties screen with them.

If the “Detailed” label has the focus (is surrounded by dots) the user can hit the SPACE BAR and open the Broker Information screen (for either line 701 or 702, depending on which label has the focus). If not, the user can open the Broker Information screens by clicking in the checkbox next to the line number (if unchecked – meaning no details have been entered) or by clicking on the Modify icon if enabled (indicating that details have already been entered). The HUD 701 – Listing Broker Information screen is presented below (the HUD 702 – Selling Broker Information screen is identical).

There are two possible system configurations for entering Agent % values – the first field on the Broker Information screens:

- as a Percentage of the Total Commission – if this is the system setting, the user would enter a split percentage (such as 50%) in each broker's calculations; or,
- as a Percentage of the Sales Price – if this is the system setting, the user would enter the percentage applicable to each agent. For example, if the total commission is 6% of the sales price and each agent is to receive half of the total, the percentage entered for each agent would be 3%.

Generally, once an amount has been entered into the Agent % field, and the user TAB’s out of the field, the Agent Amount will be computed. However, if the Total Commission, on the prior screen, was not calculated, but simply entered manually into the Total Commission field, the Agent Amount should be manually entered on this screen – the calculation will not be automatic.
If a New Mexico transaction, the user should enter a number in the **Sales Tax %** field to have Impact calculate the sales tax on the broker’s commission and populate the **Sales Tax Amount** field, or just enter a number in the **Sales Tax Amount** field.

The **Agent Information** area will populate with the broker’s information.

The bottom of the **Broker Information** screen has tabs for up to five (5) **Sub Agents’** information – to be used to distribute some, or all, of the primary agent’s commission total. Impact can show the **Sub Agent** information on the stub of the broker’s check (a system configuration setting). Any amounts paid to a Sub Agent will be deducted from the broker’s check. Sub Agent information will not be disclosed on the HUD Settlement Statement. Sub Agent information can be used to create separate checks for the agent and the brokerage firm.

To add or modify any of the five (5) Sub Agents’ information, the user will click on the appropriate tab. A **Percent** (of the Agent Amount), if the Agent Amount has been calculated, or a set **Amount** should be entered into the appropriate field to specify the sub-agent’s split of the agent’s commission. The rest of the Sub Agent identification and address fields may be filled out manually but a better choice is to use the **NAF**.

Back on the **HUD Form 700** screen, the user should check the line **703 Commissions paid at Settlement POC** check box to have the commission reported as Paid Outside Closing (POC). When first checked the **POC** screen will present through which the **Paid By** party can be identified, and an **Alternate Description** can be entered by the user if desired.

The **Remove** button should be used to clear the POC flag.

By default, Impact will have the commission **Paid From Sellers Funds at Settlement**, rather than **Paid From Borrowers Funds at Settlement**. To modify the default, place the cursor in these amount fields and make the necessary changes. The total of the Borrower and Seller columns must match the **Total Commission**, as is the case with the aggregate agent divisions.
Source of Business/Bill To

The Source of Business/Bill To screen, for both Residential and Commercial files, is a combined screen (shown below), assuming the Bill To Customer functionality is configured for in the database, that reflects the parties assigned to those roles. Typically, the assignment of the roles is done as the parties are entered via the New/Edit Party screen. NOTE: if either of the types is set to be mandatory, the user will not be able to leave this screen until there is a party assigned.

Only one party can be the Source of Business and only one can be the Bill To Customer – but they need not be the same for both. If the user tries to assign either of the roles to more than one party, they will be warned about that fact, with a message like that shown below.

If the user gets the warning that another party already has the role being requested (by checking the Source of Business or Bill To Customer checkboxes on the New/Edit Party screen for a particular party) and they indicate “Yes” to continue, the current party will be given the role and the previously flagged party will have that flag removed from their record.

The Source of Business/Bill To screen presents the parties selected for the roles, if any, as shown here.

The user can use the icons, at the right of each heading, to create a New Party (and give that new party the role desired), to Modify the party selected (from a list of existing Parties) or Remove the designation from the Party (does not remove the Party).

If the Modify icon is clicked, the Party Selection screen shown here is presented. The Filter field, at the top of the screen, can be used to search for parties by entering a part of their name or a party type – should the party listing be very long and not all are visible at one time.
**Title Information**

The **Title Information** screen is used for entering any and all additional information that may be needed to facilitate the title search. It is also used to identify an Outside Title Company for Escrow Only orders.

The top portion of the screen is used to provide information to the Title Department. This information will be presented on the **Title Instructions** (Title Order) form.

The **Status** field is used to indicate the status of the structure, or if one exists, on the property. The choices are: **Exists**, **Proposed** (vacant land), or **Under Construction**. If **Proposed** is selected, this should alert the Title Department that an ALTA inspection is needed.

The **Base Order No** field is used to identify if there is a starter file that should be used on the transaction. The number of the starter file should be entered in this field. The **Base Order No** field is available to be used in the **Search** function.

The **Subject To** field is used to enter “Schedule B” items, if Escrow knows of some that should be noted. If the file is for an “escrow only” transaction, the **Reference Numbers 1 & 2** fields can be used for the outside title company’s title file number and any other numbering that needs to be referenced. If the transaction is being worked by the internal Title Department these fields can be used for other reference numbers, such as a builder or developer number. The **Reference Number 1** and **Reference Number 2** fields are also used in the **Search** function.

The **Need By Date** field should be used to enter the date that the Prelim/Commitment is needed. Click on the **Calendar** tool icon, just to the right of the date entry area, or use the **CTRL+D** Quick Keys to pull up the **Calendar** tool, or enter the date manually in **mmdyy** form (no slashes).

The **Requirements** fields are used to note any requirements that are needed, such as Releases, or Deeds of Trust.

The **Comments to Title** field is used to add anything that was unclear in any of the previous fields or screens. If the user is sending an amended title order, enter “Amended” and notes about what was added, deleted, or changed. When a second title order is sent to the Title Department, it will print “Amended” across the top of the form.

The bottom portion of the screen, labeled **Title Company Information**, is used to detail information on the **Outside Title Company** if the file is an **Escrow Only** transaction. The user should enter the
information for the outside title company that is doing the title search. The **Title Company Information** may be filled out manually, or if the outside title company is in the **NAF** then use the **NAF** icon, in the upper left corner of the screen, to speed-fill this information. The data that is entered into the **Title Company Information** fields can be made available in other areas within Impact. For example, the information that is entered here is utilized every time that the **:TC Payee Shortcut** is used. See the Impact Payee Shortcuts section for more details about this and other shortcuts.

The **Title Officer** field’s dropdown list presents External Title Officer names that have been entered in the **Utilities module>User Tables>External Title Officers**. The user may select a name from the dropdown list or may enter a name manually.

### Prelim Distribution List

The **Prelim Distribution List** is used to manage the delivery methodology, for **Prelims**, **CC&R’s** and other **Docs**, to the various parties to the transaction. A system setting will add columns for the **Legal**, **Vesting** and **Plotted Easements** as well. While the data on distribution method and counts for the noted documents types can be entered on each party's data entry screen, the data for all parties can be viewed, and edited, on this screen. There is also an additional record for the **Escrow Branch**.

![Prelim Distribution List](image)

The distribution method (**Via** column) and counts for each doc type can be edited on this screen, so the user does not need to go into each party to change this information. Changes made on this screen are immediately reflected on the party.

The **New Party** icon, at the top right of the screen, can be used to add another party to the file.

The **Information** icon, on each party’s record, will present a brief set of information on the party, to refresh the user’s memory if needed.

The **Clear** icon, on each party’s record, will erase the distribution method and counts for that entry.
**Miscellaneous Data Entry**

A system configuration option exists that provides for the ability to add data fields for information that the Company wishes to track that is not provided for elsewhere. A screen will be presented of whatever fields the Company has established. The setup of the fields for this screen is done in the Utilities module, by a System Administrator via **Utilities > User Tables > Dynamic Data Fields**. This data can be reported on, but cannot be used in documents.

A sample of a Miscellaneous Data Entry screen is shown here.

![Miscellaneous Data Entry Screen](image)

This is the end of the **Initial Questions** menu section description, for **Residential** files.

Items that are unique, in **Initial Questions**, for **Commercial** files, will be discussed in the following pages.
Initial Questions - Commercial

The Initial Questions menu, on Commercial files, is identical to that on Residential files with the exception of the Commissions menu option – the Commissions screen is not applicable to Commercial files.

As was discussed earlier in this documentation, in the New File section, once the choice of a Commercial file is made, it cannot be altered. That section of the manual should be referred to for general information on Commercial files.

Dates/Transaction Information (Commercial)

The Dates/Transaction Information screen, on a Commercial file, is very similar to that of a Residential file, but has the following differences:

- Type of Closing is Commercial and cannot be changed

- The Sales Price field will reflect the aggregate of prices entered on each property and will be grayed out. If prices are not entered on each property, the Sales Price field on the Dates/Transaction Information screen will be editable…until such time as prices are entered on New/Edit Property screens.

- The Initial Deposit field is not presented.

- The Funds Held by Broker fields are not presented, as they are not applicable to non-RESPA files.
Properties (Commercial)

Commercial files are distinguished by the ability to have an unlimited number of properties added to them. The Property Information menu entry, under the Initial Questions sub-menu, will initially open with a largely blank window. The Add Property icon, at the top near-middle of the window, is used to initiate the entry of information on each property to be added to the file. When the Add Property icon is clicked a screen will be presented like the one shown below. The same three tabs are presented as on the Residential property screen: Property, Mobile Homes and Notes.

The Commercial New/Edit Property screen is very similar to that in Residential files, with the following differences:

- There is a Sales Price field for each property. Prices entered in this field (on each property) will aggregate to the Sales Price field on the Dates/Transaction Information screen.
- There is an Add Another button at the bottom of the screen that, when clicked, will present another property entry screen for the next property to be defined.
- There is a Copy From button at the bottom of the screen that, when clicked, will present a listing of the previously entered properties on the file and the user may identify which property to copy to use as a starting point when entering another new property. Alternatively, when a property is highlighted, in the Property tree-view (discussed later), the Copy Property icon, at the top right of the Property tree-view (left side of screen), will copy the highlighted property to a new property record, where the copy can be edited.

The reader is referred back to the Property Information Screen (Residential) section of this manual for explanation of the common fields on this screen. The Mobile Homes and Notes tabs are identical to those on the Residential Property screen.

The Cancel button applies to all changes made to the active property screens, not just a particular screen. Hitting Cancel will eliminate all changes made to all screens (Property, Mobile Homes & Notes).

Once the OK button is used to save changes made to a property entry, the property will be listed in a tree-view on the left side of the screen – as shown on the next page.
The **Properties** screen (shown below), when first presented, will not have any property highlighted, in the tree-view on the left side of the screen, and will have limited data about all entered properties on the right side of the screen.

To edit an existing entry in the tree-view, the user can either highlight it, in the tree-view, and click on the ![Edit](image) icon in the upper right corner of the window, or right-click on the property and select **Edit** from the options presented (![Edit](image) or ![Delete](image)).

![Properties screen](image)

The ![Reposition Property](image) icon, above the tree-view, will present a window in which the user can reorder the properties – this will impact the number of the property, which can impact documents that have already been prepared based on the previous ordering.

The ![Copy Property](image) icon, above the tree-view, will copy the highlighted property's information to a new property, where the differences can be edited.

As shown above, a view-only screen of each property's information is shown when the property is highlighted in the tree-view. The **Notes** on any property can be read (but not edited) by clicking on the ![Notes](image) icon in the upper right corner.

The ![View Detail](image) and ![View Summary](image) icons, also in the right corner, will flip from a summary listing of all properties to a detailed preview screen for one property or back, depending on the icon and view that is open. The screen to the right reflects the **View Summary** presentation.

The ![Delete](image) icon (in the icon tray on the right of each property summary section) can be used to completely remove a property from the file.
Parties (Commercial)

Commercial files can have unlimited numbers of all Party types, including Lenders and Agents (which are restricted in number in Residential files). Entry of Party information on Commercial files is fundamentally the same as it is on Residential files, and the user is referred to the Parties explanation earlier in this manual for a full discussion of the subject. The following comments will be limited to differences in Buyers, Sellers and Lender party data entry that are specific with Commercial files.

Buyers & Sellers (Commercial)

The Buyer and Seller party entry screens, on Commercial files, are identical to those in Residential files with one addition: Ownership Percentage. The Ownership Percentage entered on each Buyer and Seller party entry reflects that party's ownership interest in the entire transaction. Up to four decimal places may be entered. As an example of an entry, 10 1/8th percent would be entered as 10.125. The system keeps track of the aggregate percentages entered and will detail the remaining percentage, if any, to be assigned to the parties that have been entered on the file, as shown in the screen shot below. If any percentage is entered on any party, 100% must be assigned, across all parties, before the user can leave the Parties screens.

![Screen Shot](image)

The Ownership Percentage is used to enable the generation of “fractional” settlement statements, by Party, that split up the transaction’s figures by the percentages entered.
**Lenders (Commercial)**

The **Lender** party entry screen, on **Commercial** files, is very similar to those in **Residential** files with four changes: The GFE-related **Loan Terms & Tolerance Adjustments** tabs do not exist, **Interest Prorations** cannot be administered from the **Lender** screen, the **Type of Loan** field does not exist and an **Alternate Loan Description** field has been added to the screen.

![Alternate Loan Description](image)

The **Alternate Loan Description** field will present as the description of the loan on the **Settlement Statement**.

**Lenders** can be **Repositioned**, on the main **Parties** screen, on **Commercial** files.

Again, all other **Party** entry is identical to that described earlier in this manual.

**Balance of Initial Questions Menu (Commercial)**

The balance of the **Initial Questions** menu entries on **Commercial** files (Source of Business/Bill To, Title Information, Prelim Distribution and Misc Data Entry) are identical to those in **Residential** files and so will not be discussed here. The reader is referred back to the discussion of those screens earlier in this manual.
Legal Description

The second entry on the Edit menu is Legal Description. This function is used, by Escrow, to edit the Full Legal, if so desired, before the file is submitted to Title. Should the file a user is working on be an escrow-only file (with title not being worked up in the Impact/SQL system locally) the user would need to enter the Full Legal in order for it to be available for use in documents. Once a file is submitted to Title, Escrow users cannot edit the Full Legal (unless a system override setting is enabled). The Full Legal can still be used in escrow documents after it is locked. The Legal Description is entered, and stored, as a MS Word® document in Impact.

The selection of the Legal Description entry, on the Edit menu, will result in the presentation of the Legal Description screen as shown below. If the file involved is a Residential file, there will only be one property listed. If the file involved is a Commercial file, all of the entered properties will be listed. Samples of each are presented here (Residential on the left, Commercial on the right).

When first opened, no property will be selected (checkbox in front of the Property Address), but to utilize the function icons across the top of the screen, the appropriate property(ies) should be checked. At that point, the Legal Description for the selected property(ies) can be Printed, Emailed or Published (if so configured). If there is a Date/Time entry in the Last Updated column, a Full Legal exists for the property. If that column is blank, no Full Legal has been started for the property.

To enter a new legal description, or edit an existing one, the user should double-click on the appropriate property on the list or click on the Edit icon to the right of the property to be worked.

The default Full Legal master document is very often completely blank. However, it can be customized if there is default verbiage, or data from the file, that the Company wishes to have always presented at initial creation, in a standardized format. When a Full Legal is first opened for a property, the system will copy the default master document and save it tied to the file and property, and present it to the user inside MS Word®, ready for editing by the user.

Impact adds a customized tool bar/ribbon to the MS Word® tool bar/ribbon set that provides for various custom functions that aid in the entry of the legal description. The Impact/SQL Legal Tool Bar/Ribbon, from Office 2010, is presented below. There are different Impact/SQL Tool Bar/Ribbons in the different document types in Impact (Escrow, Title, Prelim & Policy), customized for the document type.
There are shortcut Quick Keys for many of the **Legal** tool bar icons, as detailed here.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool Name</th>
<th>Quick Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Next Fill-in" /></td>
<td>Next Fill-in</td>
<td><strong>CTRL+1</strong> or <strong>F11</strong> takes user to the next fill-in field in the document, if there are any.</td>
</tr>
<tr>
<td><img src="image" alt="DDE" /></td>
<td>Insert Field</td>
<td><strong>CTRL+2</strong></td>
</tr>
<tr>
<td><img src="image" alt="Clause browser" /></td>
<td>Insert Legal Clause</td>
<td><strong>CTRL+3</strong> to bring up the floating insert legal clause window</td>
</tr>
<tr>
<td><img src="image" alt="Degree" /></td>
<td>Insert Degree</td>
<td>The apostrophe key under the tilde ~</td>
</tr>
<tr>
<td><img src="image" alt="Change case" /></td>
<td>Change Case</td>
<td><strong>SHIFT+F3</strong> at end of text string will cycle through three options: ALL CAPS, all lower case, Upper first letter only.</td>
</tr>
<tr>
<td><img src="image" alt="Date to text" /></td>
<td>Date to Text</td>
<td><strong>CTRL+0</strong> will mimic icon. <strong>CTRL+9</strong> will generate an alternative text version (Month ##, ####) vs. icon’s (## the day of Month, ####)</td>
</tr>
<tr>
<td><img src="image" alt="Format phone" /></td>
<td>Format Phone Number</td>
<td>Enter 7 or 10 digits then hit icon or <strong>ALT+2</strong> to add parentheses and hyphen to format number.</td>
</tr>
<tr>
<td><img src="image" alt="Open Tools Menu" /></td>
<td>Open Tools Menu</td>
<td>No Quick Key shortcut. Content of menu varies by Access Level.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print Document</td>
<td><strong>CTRL+P</strong> to print the document</td>
</tr>
<tr>
<td><img src="image" alt="Email document" /></td>
<td>Email Document</td>
<td><strong>CTRL-SHIFT+M</strong> to email the document</td>
</tr>
<tr>
<td><img src="image" alt="Info" /></td>
<td>Info</td>
<td><strong>CTRL-SHIFT+A</strong> for info on Impact and the document</td>
</tr>
<tr>
<td><img src="image" alt="Save document" /></td>
<td>Save Document</td>
<td><strong>CTRL+S</strong> to save the document changes</td>
</tr>
<tr>
<td><img src="image" alt="Save and return to ImpactSQL" /></td>
<td>Save and Return to Impact</td>
<td>No Quick Key shortcut. Saves the document changes and closes the doc.</td>
</tr>
</tbody>
</table>
Order Title Search

Typically, the title search is ordered after the user finishes with the last screen of **Initial Questions**, and the system will prompt the user after they press **Save & Exit** from those screen, if they did not use the **Title Search** icon within **Initial Questions**, to order the search, as to whether the search should be ordered (except for **Escrow Only** files). The prompt is shown to the right. If the user wishes to submit the file to Title, they should click on the **Yes** button; click on **No**, if not to be submitted at this time.

Whether submitted or not, there will be an additional prompt asking the user if they wish to print the Title Instructions. Again, **Yes** or **No** are the options. If Yes is clicked upon, the user will be presented with the printer control panel where they can **Print**, **Preview**, **Email** or **Publish** (if so configured) the Title Instructions.

Once Escrow has submitted the order to Title, the **Date Ordered** and **Ordered By** fields, on the **Escrow Status Information** screen, will reflect the date submitted and by whom.

When the **Title Instructions** have been printed in, or emailed to, Title, by the automated routine for doing so, the **Date Accepted**, on the **Escrow Status Information** screen, will reflect the date printed or transmitted.

If an amended order is submitted to Title, the **Amend Date** and **Amend No** fields will update on the **Escrow Status Information** screen.

**Title Instructions** are customizable by site and the order sheets can be customized differently for when they are printed out by Escrow and when they are printed by Title (manually or via the automated routine).
HUD, Worksheet and Settlement Data Entry

Due to the 2010 RESPA changes, and the introduction of Commercial files into Impact/SQL, there are now five (5) distinct data entry paths for settlement data; they are:

- **HUD – Residential** file without 2010 RESPA features on HUD entry screens. Non-GFE HUD and Settlement Statements can be produced.

- **Worksheet – Residential** file without 2010 RESPA features on worksheet entry screens. Non-GFE HUD and Settlement Statements can be produced.

- **HUD with GFE – Residential** file, with 2010 RESPA features included on HUD entry screens. HUD and Settlement Statements can be produced; combined or separate by loan.

- **Worksheet with GFE – Residential** file, with 2010 RESPA features included on worksheet entry screens. HUD and Settlement Statements can be produced; combined or separate by loan. Note: the 207/208 & 507/508 lines cannot be accessed via this entry path.

- **Settlement Entry – Commercial** file. Settlement charge entry screens. Multiple properties and unlimited parties. Combined and proportional Settlement Statements can be produced. No HUD production.

The non-GFE versions of Residential file data entry will be presented first. The with GFE versions of Residential data entry will then be explained, followed, lastly, by information on the Commercial file Settlement Entry process.

As has been explained earlier in this manual, the choice between Residential and Commercial is made at the time of file opening, on the New File screen, and is irreversible. The Commercial selection will force the Settlement Entry data entry process – there are no alternatives for Commercial files. The Residential selection will allow the user, on the Dates/Transaction Information screen of Initial Questions, to make the determination of the style of data entry HUD or Worksheet, “with” or “without GFE”. NOTE: once a “with GFE” form is selected, it cannot be reverted back to a “non-GFE” form.

Switching a Residential file from a HUD to a Worksheet style of entry (or vice versa) can be done, but there is a potential for data loss, depending on data that has already been entered to the file. The user will receive a prompt if that is going to happen, and can make the determination whether to proceed.
Common Tools on HUD and Worksheet Entry Screens, incl. Payoffs

There are some common tools used across the HUD and Worksheet styles of entry screens. These will be described before going into the specific entry styles.

The Calendar tool is present on all date fields. Click on it to open a calendar display from which the desired date can be selected.

The Edit icon is presented on line items that have sub-screens associated with them which have already been used to prepare data for the HUD/Worksheet line – such as Payoffs, Commissions, POC’s or Title Services charge summaries. These will be explained in detail in the discussion of each section.

On many of the entry screens, there is a checkbox in front of the text “Check”. This is used to indicate that a check is to be cut for the charge.

The Payee Name and Address icon is used to detail the payee’s information (for use on checks) while data is being entered through the HUD/Worksheet screens. It will bring up the Payee Name and Address screen through which that information can be entered for a particular entry. The NAF can be called on from that screen.

The Proration/Calculate icon is used to bring up sub-screens on which prorations or charges are calculated. A sample Proration screen is shown here. The user should enter a Description of the item being prorated, and the Total to Prorate. The Starting and Ending Dates should be entered (the Ending Date is a “to” date, not a “through” date). The user should select the appropriate Total to Prorate Based On option (Annual, Semi-Annual, Quarterly, Monthly or Daily). The user should select the appropriate Proration Based On option (360 Days, 365 Days or Days in Period). Once the data is entered and options selected, clicking on the Calculate button will compute the Prorated Amount as will clicking on OK to return to the screen being worked up. In most situations, the Remove button will break the link to the calculator and leave the values on the main entry screen in editable form.
The “Credit/Debit” and “Debit/Credit” checkboxes, on the HUD 100, 200, 400 and 500 screens, provide for single entry points for offsetting buyer & seller items. The checkbox on HUD line 201 is only used if the buyer gives the seller the earnest money directly. In the sample to the right, the entry on line 206, with the Credit/Debit box checked, will reflect a debit on the seller’s side of the HUD (line 506). Without the check, only a credit on the buyer’s side would be presented. These items will have corresponding entries on the HUD 500 section. Entries on the 100 section will have offsets on the 400 section.

The entry of the primary and other payoffs is common in form in the HUD and Worksheet entry screens. From the **HUD Form 100** and **HUD Form 500** screens you can add an unlimited number of Borrower or Seller payoffs with unlimited itemized charges.

To add details for the first payoff, click on the **Payoff #1** check box, or press the **SPACEBAR**, if the Payoff #1 label has the focus, to place a checkmark in the box and open the **Payoff Details** screen.

To add additional payoffs, click on the **Other Payoffs** check box, or press the **SPACEBAR**, if the Other Payoffs label has the focus. If you are at the **HUD Form 100** screen, then the **HUD Form 105. Borrower’s Payoff** screen will open. Alternatively, if you are at the **HUD Form 500** screen, then the **HUD Form 505. Seller’s Payoff** screen will open. From either screen, click on the **New Payoff** icon, and then the **Payoff Details** screen will open.
Should the Modify icon, next to the Payoff labels, be enabled (not grayed out), that is an indication there is existing payoff information already entered. Clicking on the icon will take the user to the existing item(s) so they can be edited.

On the Payoff Details screen make one selection from the three choices, at the top of the screen, as to how the payoff funds are to be handled: Issue Check for Payoff, Issue Wire for Payoff, or Net Funding.

If the payoff is made payable to one of the lender payee shortcuts (:L1, :L2, or :L3), and Issue Check for Payoff is selected, and multiple payoffs are to the same lender, the lender will get a separate check for each payoff.

If the payoff is made payable to one of the lender payee shortcuts (:L1, :L2, or :L3), and Net Funding is selected, the payoff will be deducted from the lender's proceeds. The details will be shown on the Lender Summary screen.

If Issue Wire for Payoff is selected the Wire Information area of the screen will be activated (not dimmed out) and is used to detail a wire. NOTE: when entered, this data will trigger an immediate wire. The Bank ABA entry will be validated against a table of ABA numbers and an alert will inform the user if the entry is invalid. Using the NAF to populate this section is advisable, as the ABA and Account Number can be stored there.

The Payoff To fields may be filled out manually but a better choice is to use the Name and Address File (NAF). See the NAF menu section for more details on using the NAF.

The Principal Balance is entered in the field of that name.

In the Interest Days/Year area of the screen, choose either 360 Days (30 day months) or 365 Days.

The Interest Start Date and Interest End Date should be entered if the Total Interest is to be calculated, not entered manually. They are optional on manual entry, but will print in payoff detail if provided.

NOTE: Once a payoff wire out has been generated, the system will not recreate the payoff disbursement item, if the disbursement file is recreated. For example, if the user generated a wire out for a payoff, and put the item on hold and later decides the item should be deleted and recreated, it will not be recreated if the disbursement file is recreated. The user will need to manually create the disbursement.
There are three options for interest proration and the user’s choice is selected in the Prorate By field. The options are Interest, Per Diem and Manual.

Selecting the Prorate By Interest option will cause the system to present an Interest Rate % field that should be filled with the appropriate rate. Then the Calculate button, at the bottom of the screen should be clicked to calculate the interest. Clicking on OK to close the screen will also result in the Total Interest field being calculated.

Selecting the Prorate by Per Diem option will cause the system to present a Per Diem field that should be filled with the appropriate daily amount. Then the Calculate button, at the bottom of the screen, should be clicked to calculate the interest. Clicking on OK to close the screen will also result in the Total Interest field being calculated.

Selecting the Prorate By Manual option will remove the Interest Rate % or Per Diem fields and the user would enter the Total Interest directly in the field of that name.

The Additional Charges area of the screen is used to add additional items included in the payoff. Click on the New Additional Charge icon to add an entry. The down arrow on the Description field will present pre-established items, to save typing, or the charge can be typed in manually. The business can maintain the list of pre-defined charges. The Amount field should be filled with the charge. Repeat the process to add all required charges. To remove any item click on the Delete icon to the right of the item.

To view the calculation immediately on the Payoff Details screen, click on the Calculate button at the bottom of the screen. Clicking on OK will also have the system do the calculation, and return to the original screen where the Payoff check box was selected. If later, you need to view or make changes to the fields in the Payoff Details screen, select the Modify icon to the right of the Payoff check box.

Press the Cancel button to trigger a return to the main screen without saving the data. A prompt will ask the user to confirm that changes should or should not be saved.

All information entered on the Payoff Details screen will appear on the stub of the payoff check and as a separate page of the HUD Settlement Statement. When a name is used in the Payoff Details screen, and then the identical name (or Payee Shortcut) is used in a payee field on any other screen, this will produce two (2) separate payoff checks.
Residential – Non-GFE HUD Data Entry

Earlier in this documentation, it was explained that the file type, Residential vs Commercial, is established at the time a file is opened and the Type of Closing setting (data entry style) is established at the top of the first screen of Initial Questions (Dates/Transaction Information). The following discussion will detail the data entry process for Residential files with the HUD (non-GFE) Type of Closing (data entry style) setting.

There are two paths to get to the HUD entry screens. From the Edit menu, select the HUD Style Entry option and drive to the particular screen desired, or start on the 100 screen and move through them in sequence. The other alternative, if in the Initial Questions screens, is to use the Jump icon to present the listing of data entry options and select HUD and then the screen desired.

The following pages will explain these screens in detail.

At the top of each of the screens are a Save & Exit icon, for returning to the main screen; a Print icon, enabling generation of a HUD, Settlement Statement or Title Instructions; and Previous, Jump and Next icons for moving between the screens. The user can jump back to Initial Questions as well.

At a minimum, each line has a description and an amount field. Some have default descriptions, others allow for the user to enter a description of their choice. Some amounts are pulled from other screens or are supported by calculation screens – and these appear grayed-out, indicating the user cannot edit them in column.

The tools discussed earlier in this documentation are found throughout these data entry screens. These include the Proration tool, the Calendar tool and the Modify screen icon. The Check checkbox and Debit/Credit (Credit/Debit) checkboxes are also present when relevant. The NAF icon will be enabled when the user is in a field that can accept data from the Name and Address File.
100 Gross Amount Due from Borrower

This screen includes fields that populate lines 101 through 120 on the HUD form.

Note the Proration icons on the far right that can be used to enter prorated charge data. Once used to complete the description and amount entry, if re-accessed via the icon, and the Remove button is clicked in the proration screen, the description and amount will NOT be taken off the screen, but left in an editable condition.

200 Amounts Paid by or in Behalf of Borrower

This screen includes fields that populate lines 201 through 209 on the HUD form, Amounts Paid By or in Behalf of Borrower.

The earnest money entry from the first screen of Initial Questions will fill the line 201 amount field, by default. Note: if funds were provided directly to the seller from the earnest money, then it would be appropriate to check the Credit/Debit box on line 201, as shown above. Typically, this is not the case.

When the borrower brings in funds in addition to the amount in the Deposit or Earnest Money field, first type into the line 206 (or 209) description field “Additional closing funds” and enter the amount of the funds into the field to the right, and then create a receipt by selecting Receipts > View Receipts > New
Receipt from the Escrow desktop. Lines 204 & 205 are reserved for lender credits; and lines 207 & 208 are used by the system on GFE files, so if there is a conversion possibility they should be reserved.

In the top right of the 200 screen, there is a Modify Lenders icon. Clicking on it will bring up a listing of Lenders 1-3. The user can select the lender to edit and the lender screen will be pulled up for editing. This is helpful to confirm the distribution of the dollar amounts aggregated on lines 202 & 203.

The grayed out Funds Held by Broker entry is populated from the first screen of Initial Questions and data corrections should be made there.

### 210 Adjustments for Items Unpaid by Seller

This screen includes fields that populate lines 210 through 220 on the HUD form, Adjustments For Items Unpaid By Seller.

![210 Adjustments for Items Unpaid by Seller](image)

### 400 Gross Amount Due To Seller

This screen includes fields that populate lines 401 through 420 on the HUD form, Gross Amount Due to Seller.

![400 Gross Amount Due To Seller](image)

If Proration and/or Debit/Credit information is on the 100 Gross Amount Due From Borrower, 200 Amounts Paid By or in Behalf of Borrower, or 210 Adjustments for Items Unpaid by Seller screens, the corresponding information will appear pre-filled on the 400 & 500 screens. If information was not entered on those screens, it can be entered here with the same tools and the data will populate the appropriate screens with the corresponding data.
500 Reductions In Amount Due To Seller

This screen includes fields that populate lines 501 through 509 on the HUD form, Reductions in Amount Due to Seller.

As noted in the 200 section, if funds were provided directly to the seller from the earnest money, then the Debit/Credit box on line 501 would be checked, as shown below.

In the top right of the 500 screen, there is a Modify Lenders icon. Clicking it will bring up a listing of Lenders 1-3. The user can select the lender to edit and the lender screen will be pulled up for editing. This is helpful to confirm the distribution of the dollar amounts aggregated on line 503.

510 Adjustments for Items unpaid by Seller

This screen includes fields that populate lines 510 through 520 on the HUD form, Adjustments for Items Unpaid by Seller.

This screen presents the offsets to lines 210 through 219.
700 Commissions

This screen includes fields that populate lines 700 through 708 on the HUD form, Commissions.

On line 700, the **Price $** field should be pre-filled with the number from the **Sales Price** field on the Dates/Transaction Info screen. To enter a number in the **Total Commission $** field, there are two options:

1) If the total commission is based on a percentage of the selling price, press TAB to proceed to the @ field and enter a number in the commission percent field (usually between 3% and 8%). Press TAB to have Impact calculate the number in the **Total Commission $**, and to proceed to line 701; or,

2) Alternatively, if the commission is a set dollar amount, just enter a number in the **Total Commission $** field, and press TAB to proceed to line 701.

**NOTE:** If you change the **Price $** value, on this screen, the **Sales Price** from Initial Questions will NOT be changed. Changing the **Sales Price** from Initial Questions, after this screen has been worked, will result in a prompt asking if you want to change the **Price $** value – it is not automatically changed.

**Line 701 - 1st Commission Detail Line (Listing Agent)**

The payee on line 701, should be pre-filled with the name of the **Listing Agent** from Initial Questions – Parties. If the user modifies the name on the line 701 “to” field (the payee), the name change will be reflected on the Listing Agent party information screen – therefore care should be taken when editing that field. If only one disbursement is going to be issued per agency, the dollar amounts can be entered directly on lines 701 & 702.

When additional disbursements (i.e. to sub-agents), check the Detailed checkbox and there will be two possible system configurations for entering commission percentages:

1) as a percentage of the **Total Commission** shown on line 700;

2) or, as a percentage of the **Sales Price**.
If the system configuration is set to use a percentage of the Total Commission, the user would enter a split percentage – such as 50%, in each broker’s calculations. Click on the checkbox (if open) next to the line 701 label, or click on the Modify icon if the checkbox is already checked (indicating there is existing information on the 701 Listing Broker Information screen), to open the HUD 701 – Listing Broker Information screen. The percentage the agent is entitled to, of the total commission, would be entered in the Agent % field. For example, if the Total Commission is 6% and each agent receives half, then the percentage for each agent is 50%, therefore enter 50 in this field. Press TAB to have Impact calculate the number in the Agent Amount field. If this is a New Mexico transaction, enter a number in the Sales Tax % field to have Impact calculate the sales tax on the broker’s commission and populate the Sales Tax Amount field.

If the system configuration is set to use a percentage of the Sales Price to compute commissions, the user would enter the agent’s percentage (for example 3% if evenly splitting a 6% total commission). Click on the checkbox (if open) next to the line 701 label, or click on the Modify icon if the checkbox is already checked (indicating there is existing information on the 701 Listing Broker Information screen), to open the HUD 701 – Listing Broker Information screen. The percentage the agent is entitled to, of the sales price, would be entered in the Agent % field. For example, if the Total Commission is 6% and each agent receives half, then the percent for each agent is 3%, therefore enter 3 in this field. Press TAB to have Impact calculate the number in the Agent Amount field. If this is a New Mexico transaction, enter a number in the Sales Tax % field to have Impact calculate the sales tax on the broker’s commission and populate the Sales Tax Amount field.

Alternatively, if the commission is a set dollar amount, do not enter anything in the Agent % field and only enter a number in the Agent Amount field.

The Agent Information will be pre-filled from the Listing Agent party screen. Any modifications to the Agent Information will update the Listing Agent party screen.

The Agent Information screen has an area for up to five (5) Sub-Agents. Impact can show the Sub-Agent information on the stub of the broker’s check. Any amounts paid to a Sub-Agent will be deducted from the broker’s check. Sub-Agent information will not be disclosed on the HUD Settlement Statement. Sub-Agent information may be used to create separate checks to the agent and to the brokerage firm.

To add or modify any of the five (5) Sub-Agent information areas, type a number in the Percent or Amount field. The rest of the Sub-Agent fields may be filled out manually but a better choice is to use the NAF.

For a disbursement item to be generated from the sub-agent entries, the Company data field must be populated with the disbursement payee.
Line 702 – 2nd Commission Detail Line (Selling Agent)

Line 702 is worked up the same way as line 701, but the information is about the Selling Agent party. See the Line 701 discussion above for details.

Line 703 – Commission paid at settlement

The amount on line 703 will default from the amount on line 700. It must remain consistent with the amount on line 700 and with the sum of the breakdowns on 701 and 702. The amount on line 703 will, by default, present in the Paid From Sellers Funds at Settlement column, rather than the Paid From Borrowers Funds at Settlement column. To modify the default, place the cursor in these amount fields and make the necessary changes.

Select the POC check box to have the commission reported as Paid Outside Closing (POC).

Lines 704-708 – Adjustments To Commissions

Use lines 704-708 to detail other Commission related adjustments.

For example - to give the Borrower and/or Seller a credit from the Listing Agent or the Selling Agent. Enter the credit as a negative amount and the payee will be either the Listing Agent or the Selling Agent. The payee name must be identical to the broker’s name in order for Impact to subtract the amount from the broker’s check.

If the description on line 704 shows “Sales tax on commission”, then an amount was entered on line 701 or 702 detail screens, in the Sales Tax % and/or Sales tax Amount fields.
800 Items Payable in Connection With Loan

This screen includes fields that populate lines 801 through 828 on the HUD form, **Items Payable in Connection With Loan**. There are two Page tabs on this screen (lines 801-811 on the first, 812-828 on the second) and icons at the top of the screen to move between the three lenders’ sets of data. A red diamond, on the Page # tabs, and a red dot on the Lender icons, indicates there is data entered on that page, or for that lender.

The non-GFE HUD entry format can have some line descriptions and amounts defaulted, on the **Items Payable In Connection With Loan** screens, depending on system configuration. To modify the pre-filled data, place the cursor in these fields and make the necessary changes.

If a Buyer and/or Seller amount is shown on a line, a payee must also be entered, or a check will not be created. If a payee is shown on a line, an amount must also be entered, or the description will not print on the HUD form; "0.00" can be entered to have a description print with no dollars.

If one of the lenders is a payee, the user can use the Lender Payee Shortcuts to speed data entry; for example, use :L1 to have Lender 1 as the payee. Each lender has a Payee Shortcut. See the Impact Payee Shortcuts section for more details about these and other shortcuts.

If the Withhold from funding (WTH) check box is selected, then a check will not be created for the amount shown on the line. The payee must be :L1, :L2, or :L3 in order to select the WTH check box. These items will be shown on the Lender Summary screen.

If ":L# name", with another party’s name entered after the lender shortcut, and WTH is checked, the other party’s name will appear on the HUD, but the amount will be netted on the Lender’s Summary screen.

The Address icon should be used to open the Payee Name and Address screen to enter that information.

If the Paid Outside of Closing (POC) or Paid Outside of Closing by Lender (POCL) or Paid Outside of Closing by Broker (POCB) are selected, then a check will not be created for the amount shown on the line.
Line 801 – Loan Origination Fee

The Loan Origination Fee is automatically calculated by Impact when a number is entered into the % field on line 801. The calculation is always based on the Loan Amount entered in the Initial Questions > Parties > Lender #1(or #2 or #3) Edit Lender screen.

To have Lender #1 be the payee, type in :L1 into the to field.

To modify data in any of the fields, place the cursor in the field and make the necessary changes.

If the following boxes are checked no disbursement item is created.

- WTH – Withheld from the Lenders funding check. The payee must be :L1, :L2, or :L3.
- POC – Paid Outside of Closing by the buyer and/or seller
- POCL – Paid Outside of Closing by the lender
- POCB – Paid Outside of Closing by the mortgage broker

Line 802 – Loan Discount

The Loan Discount Fee is automatically calculated by Impact when a number is entered into the % field. The calculation is always based on the Loan Amount entered in the Initial Questions > Parties > Lender #1(or #2 or #3) Edit Lender screen.

To have Lender #1 be the payee, type in :L1 into the to field.

To modify data in any of the fields, place the cursor in the field and make the necessary changes.

Lines 803 Through Line 807 – Appraisal And Other Lender Fees

Follow these instructions for lines 803 through 807.

The first field on each line is used for the name (payee) of the service provider. The Address icon should be used to open the Payee Name and Address screen to enter that information.

Select one of the WTH, POC, POCL or POCB check boxes, if needed, then type in an amount into the Paid From Borrowers Funds at Settlement field and/or the Paid From Sellers Funds at Settlement field.

Line 808 – 811 – Other Fees

Follow these instructions for lines 808 through 811.

The first field on these lines is used for the description of the service.

The second field is used for the name (payee) of the service provider. The Address icon should be used to open the Payee Name and Address screen to enter that information.

Select one of the WTH, POC, POCL or POCB check boxes, if needed, then type in an amount into the Paid From Borrowers Funds at Settlement field and/or the Paid From Sellers Funds at Settlement field.
Line 812 – Items Payable in Connection With Loan – Page (2)

Access to additional lines for each lender is available on the Items Payable In Connection With Loan Page (2) tab at the top of the screen. These lines are identical in behavior to lines 808-811 discussed above.

Lines 801-828 for Lenders #1-#3

At the top of the Items Payable in Connection With Loan screen are three Lender icons. The icons are labeled Lender #1, Lender #2 and Lender #3. To switch from one lender’s screen set to another, click on the appropriate lender icon. If there is a red diamond in the lower left corner of the lender icon, there is data entered on that lender’s screen set.

NOTE: For any line item entered with a zero dollar amount, the description and payee info will print on the HUD and Settlement Statement.

900 Items Required by Lender to be Paid in Advance

On lines 902 through 904, on the Items Required by Lender to be Paid in Advance screen, the first three lines have defined purposes, and the balance are open for whatever entries are required. The payee (to) field can be filled manually, or with the NAF tool, which will be activated when the cursor is placed in a payee field.
**Line 901 - Interest**

For line 901 – **Prepaid Interest** - there are two approaches to entering the Interest:

1) Manually enter the information. Select either the Withhold from funding (WTH) or Paid Outside Closing (POC) check box if appropriate, then type in a number into the **Paid From Borrowers Funds at Settlement** field and/or the **Paid From Sellers Funds at Settlement** field.

2) Let the system calculate the interest. Click on the **Prorate** icon, on the far right of line 901, to open the **Interest Proration** screen shown below. The **Proration Type** field has two options, **Per Diem** and **Interest**; depending on the selection made, the field below **Proration Type** will reflect the appropriate type – either a per diem dollar amount or an interest rate. The **Starting** and **Ending Dates** should be entered, and the appropriate **Proration Based On** selection should be made. Whether credit is to be given to the Buyer or Seller should be indicated and then the **Calculate** button should be clicked to compute the **Prorated Amount** (or click on **OK** to calculate and exit).

![Image of HUD 901 Interest Proration screen]

**NOTE:** Interest prorations are from the **Starting Date** TO the **Ending Date**, NOT through the **Ending Date**.

If you want to modify any of the line 901 fields, after using the Interest Proration calculator, without Impact recalculating the numbers, open the Interest Proration screen again, and click on the **Remove** button (lower left corner). The system will remove the lock on the information on the 901 line and let it be edited.

In order to credit back interest, first open the **Interest Proration** screen, use a negative number in the **Per Diem Amount** field, type in the **Starting Date** (which in crediting back interest would be the date you are computing back to) and the **Ending Date** (which would be the date you are computing back from), then press **OK**. The **Starting Date** must be the earlier date for Impact to make a calculation. Then the user may modify the **From Date** and **To Date** by reopening the Interest Proration screen and clicking on the **Remove** button then click on **OK** to close the screen, thereby opening up the date fields to be manually edited. If the interest credit calculation is known upfront the information may be manually entered directly.

**Line 902 - MIP**

The first field is used for the number of **MONTHS** of MIP to be pre-paid. The second field is for the payee. The **Address** icon can be used to enter the name and address of the payee. The **NAF** can also be used. The amounts are entered manually.
**Line 903 – Hazard Insurance Premium**

The first field is used for the number of **YEARS** of Hazard Insurance Premium to be pre-paid. The second field is for the payee. The 📝 Address icon can be used to enter the name and address of the payee. The 📝 NAF can also be used. The amounts are entered manually.

**Line 904 – Other Fees**

The first field on this line is used for the description of the service, and the second field is used for the name (payee) of the service provider. The 📝 Address icon can be used to enter the name and address of the payee. The 📝 NAF can also be used.

Select one of the check boxes (WTH or POC) if needed, then type in an amount into the **Paid From Borrowers Funds at Settlement** field and/or the **Paid From Sellers Funds at Settlement** field.

**Lines 905-912 – Other Fees**

Lines 905-911 are provided for additional pre-paid items. Address fields are not available on these lines.

**Lines 901-912 for Lenders #1-#3**

At the top of the **Items Required by Lender to be Paid in Advance** screen are three 📝 Lender icons. The icons are labeled **Lender #1**, **Lender #2** and **Lender #3**. To switch from one lender’s screen set to another, click on the appropriate lender icon. If there is a red diamond in the lower left corner of the lender icon, there is data entered on that lender’s screen set.

**1000 Reserves Deposited With Lender**

For reserve items, enter a number in the **months** field and an amount in the **per month** field; Impact will automatically calculate the amount in the **Paid From Borrowers Funds at Settlement** field. The default is for the amounts to be placed in the Borrower’s column, but the user can move the figures, if the terms of the transaction so dictate. There are 📝 Lender icons to move to each Lender’s screen.

Select one of the check boxes (WTH or POC) if needed.

An “**Aggregate Adjustment**” description may be defaulted in one of the last two (2) lines. If a negative number is needed, enter a minus sign before or after the number. The negative number will be displayed in red.
1100 Title Charges

Please note that the Rate Calculator in Impact/SQL does not currently handle some common pricing practices and is under review for revision (as of September 2013). Therefore, a full description of the Rate Calculator will not be included in this section of the Escrow manual.

On the Title Charges screen, depending on system configuration, you will either see the Title Charges Detail check box, to the left of the Computer to Calculate Fees? option box – or you will only see the Computer to Calculate Fees? option box, at the top of the screen, under the Title Charges (1) tab heading. It is very rare that the Title Charges Detail option is turned on on a system (it was a client-specific request), so the absence of the option should be expected.

In the rare instance that the option exists, clicking on the Title Charges Detail check box will open the Title/Escrow Fee Breakdown screen shown here. Click on the Detail button, on the Title Charges screen to re-enter a previously worked up Title Charge Detail screen. As this screen is rarely presented, it will not be discussed further.

The Computer to Calculate Fees? option, on both of these screens will also not be discussed further due to the current state of the Rate Calculator in Impact (see notice at the top of this page). The Computer to Calculate Fees? option should always have “No” selected, and the user will enter charges manually. If Computer to Calculate Fees? is chosen, the fields will not accept manual entries. The radio button will need to be reset to “No” to open the fields for editing.
To make changes to the **Paid From Borrowers Funds at Settlement** field and/or the **Paid From Sellers Funds at Settlement** field, or to modify any pre-filled payee data on a line, place the cursor in the field to make the necessary changes.

In the payee field, a Payee Shortcut may be currently displayed, or can be entered, for example, use :T to have Your Company Name as the payee. :T, as payee, denotes a revenue check which may, depending on system configuration, require income codes on each detail line, which are entered on the **Disbursements** screen on non-GFE files.

Depending on your company’s system configuration, a :E may be entered as a payee with the amount being applied as revenue. The use of :E vs. :T is to distinguish between charges entered by Escrow versus Title users, in a traditional Sub-escrow environment. The :E and :T will display subtotals at the bottom of the **Title Charges** screen if enabled. Both represent fees to the Company. The newer Sub-escrow functionality, in Impact version 7.7 and later (see Appendix B), does not need such a device as Title/Sub-escrow users do not enter charges directly into the HUD if the newer functionality is enabled.

Users have the ability to use :T (space) [name]. This will permit a payee name on the HUD other than the Company name, but still be included as a revenue check item – only on non-GFE files.

A :TC may be entered as a payee. :TC is the payee shortcut for the **Outside Title Company**, on an Escrow Only file. The :TC payee shortcut will pull the name from **Initial Questions > Title Information > Title Company Information**. The :TC-coded items will not be counted as revenue to your company.

The Address icon can be used to enter the name and address of the payee, for those lines that have the icon. Alternatively, the to payee field can be filled in manually, or with the NAF tool, which will be activated when the cursor is placed in a payee field.

As needed, select one of the check boxes:

**WTH** – Withheld from the Lenders funding check. The payee must be :L1, :L2, or :L3.

- **POC** – Paid Outside of Closing by the buyer and/or seller
- **POCL** – Paid Outside of Closing by the lender
- **POCB** – Paid Outside of Closing by the mortgage broker

The **Lenders coverage** field may be pre-filled with the **Loan Amount** from data entered on the **Edit Lender** screen of **Party** entry in **Initial Questions**.

The **Owners coverage** field may be pre-filled with the **Sales Price** from data entered on the first screen of **Initial Questions**.

**NOTE:** HUD lines 1109 and 1110 will print the payee name from HUD line 1108.

Access to lines 1114 through 1130, for additional charge entry, is available on the **Title Charges (2)** tab.

For Washington state requirements see Appendix A - Washington State.
1200 Government Recording and Transfer Charges

Impact can be configured to calculate recording fees and other government charges. The System Administrator must configure the fees through the Utilities module. (In the sample below, tax stamps are reflected in Maricopa County, which is an erroneous example, but it is just a demonstration.)

![Recording Fees Screen](image)

The Calculator icon, to the right of five lines on the Government Recording and Transfer Charges screen, is used to pull up screens though which Impact will automatically calculate the charges for each line, if the system is so configured. Users can fine-tune the charges, as to who pays them, on those screens. If the calculator has already been used, the data fields will be grayed out and the user should click on the Calculator icon to reopen the calculator screen. The automatic calculation of Recording fees, State tax/stamps, City Transfer Tax, and County Transfer Tax is based on the city and county of the property.

![Recording Calculations Screen](image)

On the Recording Fees screen shown above, the user would enter the number of pages for the document types being recorded and the system will calculate the charges. The system will put the charges in the default column(s) set for the system, but the user can move the charges from Buyer to Seller or vice versa.

The Remove button can be used, after the calculator has been used, to open up the charges on the main screen for editing by the user, if need be.

The user can enter charges directly, without using the calculators, if he/she wishes. If the City &/or County involved with the transaction has not had charges pre-configured for them, then the user would have to enter charges manually.

In the payee (to) fields, Payee Shortcuts may be currently displayed, or can be entered, for example, use :T to have the Company Name as the payee. See the Impact Payee Shortcuts section for more details about these and other shortcuts.
If appropriate, select the appropriate POC check box.

- **POC** is paid outside of closing by the buyer and/or seller  
- **POCL** is paid outside of closing by the lender  
- **POCB** is paid outside of closing by the mortgage broker

Access to lines 1208 through 1217 is available on the **Recording/Transfer Charges (2)** tab. The first field on each line is used for the description of the charge, and the second field is used for the name (payee) of the service provider.

For Washington state requirements see Appendix A – Washington State.

### 1300 Additional Settlement Charges

There are five tabs of data entry available for the 1300 section, covering lines 1301 through 1335, for **Additional Settlement Charges**. Line 1400, Total Settlement Charges, appears at the bottom of each tab. Tabs with values on them, will be tagged with a red diamond in front of the tab label.

The charge description is entered in the field next to the line number, and the payee is identified in the to field. The user can fill out the payee manually, using the Payee Name and Address icon or place the cursor in the to field to enable use of the NAF.

![Image of the 1300 Additional Settlement Charges table]

If the Paid Outside of Closing (POC), Paid Outside of Closing by Lender (POCL), or Paid Outside of Closing by Broker (POCB) check box is selected, then a check will not be created for the amount shown on the line. Also if the withheld from lender’s funding check (WTH) is checked, no disbursement will be created and the payee must be :L1, :L2, or :L3.

If any information is entered into the description field with a zero amount in the borrower’s and/or seller’s columns, the description and payee fields will print on the HUD Settlement Statement.
The Add'l Charges (3) screen allows the user to prorate items. Click on the Prorate icon to create a new proration or to open up an existing proration.

Prorations will calculate either the Buyer/Borrower or Seller sides of the HUD-1 form, based on the radio button selection.

Fill in the Description entry field with the appropriate information and enter an amount in the Total to Prorate field.

Enter dates (in mmddyy format, or use the Calendar tool) for both the Starting Date and the Ending Date fields:

**NOTE:** Prorations are from the Starting Date TO the Ending Date, not through the Ending Date.

In the Total to Prorate based on area of the screen, choose if the amount entered on the Total to Prorate field is an Annual, Semi-Annual, Quarterly, Monthly, or a Daily amount.

In the Proration Based On area of the screen, choose one of the 360 Days (30 day months), 365 Days, or the Days in Period radio buttons, to determine the basis on which the proration calculation is to be made.

To view the calculation immediately on the Proration screen, click on Calculate. Clicking on OK will also do the calculation, and returns the user to the 1300, tab 3 screen. If changes need to be made to the fields in the Proration screen, once set up, click on the Prorate icon. The Remove button, on the Proration screen, will open up the results fields for manual editing.

**HUD Summary**

This is the balancing screen that summarizes the entries made on all HUD lines and shows the amounts due to/from the buyer and seller.

Any checks for amounts listed on line 303 or line 603 can be split among several payees by using the Split icon next to the disbursement item on the Disburse > Create & Print Checks screen.
**Lender Summary**

The **Lender Summary** screen presents the net funding amount of each loan and identifies withheld amounts. If a lender over-funds, then a check to the lender will be created on the Disburse > Create & Print Checks screen.

At the top of the **Lender Summary** screen are three 📦 Lender icons. To switch between lenders, click on the appropriate icon, or use the **ALT+# (1, 2 or 3)** Quick Keys.

The **Items Withheld from Loan** area, on the right of the screen, itemizes the **Withheld Amount**, listing all the items on various other screens, for the lender selected, that have the WTH checkbox selected. A scroll bar is present if there are more items than will present in the window.

![Lender Summary Screen](image)

To make adjustments to items listed in the **Items Withheld from Loan** area of the screen, go to the appropriate HUD entry screen and make corrections there.

The user can print the **Lender Summary Report** via the 📡 Print icon at the top of this screen.

**Residential – Non-GFE Worksheet Data Entry**

There are several differences between the **HUD Data Entry** and the **Worksheet Data Entry**:

The **Worksheet Data Entry** has more lines but has no line numbers.

The **Prorations, Debits and Credits #1** and **Prorations, Debits and Credits #2** tabs replace the 100 through 510 screens of the HUD Data Entry screens. The Debit or Credit can be automatically calculated by Impact as a proration or the amount can be manually entered as a Debit or Credit.

The **Worksheet Data Entry** has, on the **Prorations, Debits and Credits #x** screens, both the buyer’s debits and credits, and the seller’s debits and credits viewable on one screen.

The **Worksheet Data Entry** screens include an **Additional Buyer/Borrower Deposits** screen that can be used to generate multiple additional buyer receipts and automatically includes these entries on the Settlement Statement.

The **Worksheet Data Entry** screens include a **Rent Schedule** screen, with an unlimited number of proration style entries available. The **Rent Schedule** prints on the breakdown addendum to the HUD form, and as an attachment to the Settlement Statement.

Both the **HUD Data Entry** and the **Worksheet Data Entry** will allow either the HUD form or the Settlement Statement documents to be produced for every escrow.
Commissions

See the 700 – Commission description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

Additional Buyer/Borrower Deposits

The Additional Buyer/Borrower Deposits screen has unlimited lines available for deposits by the buyer/borrower. Each deposit is shown on the Settlement Statement and/or HUD form.

Click on the New Deposit icon, at the top of the Additional Buyer/Borrower Deposits screen, to open the New Additional Deposit window, shown to the right. Enter text in the Description field and then the amount of the deposit in the Amount field. The system can be configured to create a receipt, and therefore a ledger entry, automatically or to allow the user the option of creating a receipt. If the latter option is in place, the New Additional Deposit screen will present a checkbox labeled Enter Receipt. If the funds are to be receipted into the ledger, leave the check mark in the Enter Receipt checkbox and click on the OK button to continue, or Cancel to stop the process. If the funds should only be recorded on the Settlement Statement or HUD, but not receipted into the file, uncheck the Enter Receipt checkbox, either by clicking with the mouse, or by hitting the SPACEBAR when the Enter Receipt label has the focus (has dots around it).

Assuming the Enter Receipt checkbox was checked, the Initial Deposit receipt screen will then be presented, as shown to the left. The Bank should be confirmed, along with the Payor Name and Receipt Type. Click on OK to complete the receipt entry. If Cancel is clicked, no receipt will be created AND the additional deposit will also not be created. Only by not having the Enter Receipt checkbox checked will an additional deposit be able to be entered without a receipt being created.

The resulting entry is presented below, and reflects a confirmation that the item has a receipt, in the Has Receipt column.

Click on the Delete icon, to the right of an entry, to remove an Additional Buyer/Borrower Deposit. Removing the deposit will remove the line item from the Settlement Statement – but will not delete the receipt. The Modify icon will let the deposit item be modified – but will not modify the related receipt. If a receipt was originally created, depending on system configuration and date of the item, the user may be able to modify or delete the receipt – through the Receipts screen, or will have to contact the Accounting Department to address the matter.
Prorations, Debits and Credits

There are two screens of **Prorations, Debits and Credits**, accessed by the tabs near the top of the screen, or via the ALT+# (1 or 2) Quick Keys.

Three lines on the #1 screen have default descriptions; the others on screen #1 and all on #2 have fields for the user to enter a description into.

There are Proration icons on each line, at the far right. See the Common Tools on HUD and Worksheet Entry Screens, incl. Payoffs section (earlier in this manual) for details on using the Proration tool. Items filled via the Proration tool will be grayed out, editable only via the tool.

The Remove button, in the Proration tool, will completely remove the entries on these screens, not leave them for the user to edit.

Directly below the description area of the line is the From Date field, and to the right is the To Date field. The date fields for each line can be completed either through the Proration tool or manually. The Debit and Credit values for each line can be completed either by the Proration tool for each item, or by entering the numbers directly into the Debit and Credit fields.
Rent Schedule

The Rent Schedule screen can be used to add an unlimited number of Rent Prorations. Click on the New Rent Schedule icon, at the top of the screen to add a new Rent Proration. The Rent Proration screen works like the other proration screens discussed previously in this manual.

The Modify icon, to the right of each entry, is used to edit the rent proration.

The Delete icon, to the right of each entry, is used to remove the rent proration.

The Rent Schedule can be printed via the Print icon at the top of this screen.

Borrower’s Payoffs

The Borrower’s Payoffs screen is used to enter any payoffs to be made on behalf of the buyer/borrower. Click on the New Payoff icon to add a payoff entry.

The Modify icon, to the right of each entry, is used to edit the payoff.

The Delete icon, to the right of each entry, is used to remove the payoff.

For instructions on using the Payoff Details screen, see the Common Tools on HUD and Worksheet Entry Screens, incl. Payoffs section (earlier in this manual) for details.

Seller’s Payoffs

The Seller’s Payoffs screen is used to enter any payoffs to be made on behalf of the seller. See the Borrower’s Payoffs section just above for details.

New Loan Fees

See the 800 Items Payable in Connection With Loan description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

New Loan Fees Paid in Advance

See the 900 Items Required by Lender to be Paid in Advance description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.
Reserves Deposited with Lender

See the 1000 Reserves Deposited With Lender description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

Title / Escrow Fees

See the 1100 Title Charges description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

Government Recording and Transfer Charges

See the 1200 Government Recording and Transfer Charges description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

Additional Settlement Charges

See the 1300 Additional Settlement Charges description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.

Worksheet Summary

This is the balancing screen that summarizes the data entered on the worksheet screens and presents the funds due to/from the buyer and seller.

Lender Summary

See the Lender Summary description in the Residential - Non-GFE HUD Data Entry section (earlier in this manual) for an explanation of this screen.
Residential – HUD with GFE Data Entry

The 2010 RESPA changes resulted in a substantially different data entry process on some screens. The following discussion will detail the altered screens and functionality. The reader is referred to the Residential – Non-GFE Data Entry section (earlier in this manual) for screens not discussed in this section – as they have not been affected by the RESPA changes. The first screen that is affected is the HUD Form 800. Items Payable in Connection with Loan screen, and that is where the HUD with GFE description will begin, after some information on changes to POC items.

POC’s – Partial and Full

A requirement to accommodate partial POC’s was introduced with the “with GFE” process. These are charges that are partially paid outside of closing by the buyer/borrower, seller (in some instances), lender or mortgage broker. Changes have been made to the 800 through 1300 screens to allow for partial POC’s to be identified. The POC on the 700 screen must be a full POC, and the dollar amount is un-editable – it is system managed, net of any held funds.

The option to select the seller as the payor of a full or partial POC is limited to the 1100, 1200 and 1300 screens. The seller cannot be selected on the 800, 900 and 1000 screens.

Note: a full POC is managed through the same screen, with the difference being that no dollar amount would be entered in the buyer or seller columns – the entire POC amount is entered in the POC screen. This is a change to non-GFE data entry behavior.

One sample of the partial POC treatment will be described here.

In this sample, $45 of a $250 Credit Report charge was paid outside of closing by the borrower. The user will click on the checkbox, under the POC heading, to open the POC entry screen. The POC amount, in this instance $45, is entered in the Amount field. The party that paid the POC is identified via making a selection from the Paid by: dropdown list. As the Lender and Mortgage Broker are options in the list, the traditional POCL and POCB check boxes have been removed from the screens. The unpaid balance of the charge ($205) is entered by the user in the Paid From Borrower's Funds at Settlement column.

The Alternate Description field can be used to force a user-entered description to appear on the HUD – replacing the description that the system would be entering by default. For lines that are included in roll-ups, like 1102, if a POC is entered, and an alternate description is entered, the alternate description will not be presented on the HUD, but will appear on the Settlement Statement. The roll-up line’s description will print on the HUD.

Clicking on the modify icon, if it is not grayed out, will take you into the POC screen which already contains data. Clicking on the POC checkbox, after it is checked, will remove the POC entry – without notice. The same will occur if you click on the Remove button while in the POC screen.

On calculated lines (like 1003 Mortgage Insurance, for example), the calculated amount will be reduced by the POC amount.
HUD Form 800. Items Payable in Connection With Loan

The 800 screen was substantially altered, from the non-GFE 800 screen, to support the new RESPA requirements. A sample of a blank screen (with the cursor in a Payee field, so the NAF icon is highlighted) is shown below. Note the Lender , NAF , Address Card , and Modify icons, in addition to the three Loan Charges tabs (A, B & L) – there are a set of three Loan Charges tabs for each Lender.

The screen is, obviously, similar in concept to the non-GFE 800 screen, but has the lender’s summarized Our origination charge and Your credit or charge (points) for the specific interest rate chosen figures, on lines 801 and 802. The sum of the values entered in 801 and 802 will be presented in the Paid From Borrower’s Funds at Settlement field, with the Modify icon next to it, on line 803 (boxed in red below). A description of the use of the Modify icon, on line 803, is on the next page of this document. The GFE Amounts for lines 801 and 802 will be found on the lender’s GFE, at the top of page 2, and the sum of the values entered should match the line A (Your Adjusted Origination Charges) on that form. That value will be automatically summed from lines 801 and 802 and will be entered in the line 803 GFE Amount field. To get the lender’s name to appear on line 803 of the HUD, enter the appropriate shortcut (:L1,:L2 or :L3) in the payee box (following the description) on that line.

The GFE Amount and GFE Category fields are to be edited by the user. Data for this screen will come from the GFE and the lender’s Instructions to Escrow. The GFE Amount fields are entered as all Impact amount fields are, no commas, but with the appropriate decimal point and pennies as needed. The GFE Category field is a dropdown through which you can select Category 2 or Category 3, as appropriate. The default on this screen is Category 2, as that is likely the predominant condition for these types of charges, but Category 3 can be selected. (The Categories are defined in the Lenders – Residential – Tolerance Adjustment section presented earlier in this manual.)

Note the far right-hand column is now labeled Seller Paid (Credit to Buyer) Amount. This reflects the 2010 RESPA requirement that seller paid loan items appear as a credit on page 1 of the HUD. Because this is a credit to the buyer, the full charge should be shown in the Paid From Borrowers Funds at Settlement column and any credit from the seller should be entered into the Seller Paid (Credit to Buyer) Amount column. Seller data that is entered will not appear on page 2 of the HUD, but rather will be presented on page 1 as an aggregate, crediting the buyer and debiting the seller. The default description there will be Seller Paid Loan Charges, which can be changed by the user by editing the
description on lines 208 or 508. If lines 208 or 508 have been used for another purpose, amounts will not be able to be entered in this column and a notice to that effect will be presented. The user will need to move the 208 or 508 items to another line for the aggregate total functionality to work properly, or manually enter their own debit/credit figures.

There is a text box, to the right of the Our origination charge description on line 801, into which the user can enter text provided by the lender discussing the points (% & $) included in the origination charge. This information is required to satisfy an IRS requirement.

**Loan Origination Fee Breakdown – HUD Line 803**

Clicking on the MODIFY icon, on line 803, will take the user to a Detail screen (below, left), where the first item of an itemized listing, which must add up to the sum of lines 801 and 802 if not marked WTH, can be added. Completing this detail itemization is required if a check is to be issued to other parties from these funds (like the Yield Spread Premium discussed earlier). Once an item’s detail has been entered, and the user clicks on the OK button, the Loan Origination Fee Breakdown screen (below, right) is presented, with a NEW ITEM icon in the upper left of the screen and MODIFY and DELETE icons on each detail line. You can also add additional detail lines from the Detail screen with the ADD ANOTHER button.

Again, the sum of the items on the Loan Origination Fee Breakdown screen must sum to the Total Loan Origination Fee figure – which is the sum of lines 801 and 802, less any WTH amount, shown on the screen as Total Available. There is a Balance Left figure, upper right of the screen, which shows the amount yet to be detailed. The user will not be able to leave the screen until the full breakdown is detailed OR there are no detail records on the screen.
HUD Form 900. Items Required by Lender To Be Paid In Advance

Like the 800 screen, the 900 screen also reflects the **GFE Amount** and **GFE Category** fields, for the applicable lines. As it is most likely that items on this screen will be **Category 3** items, that is the value that defaults. **Category 2** can be selected if applicable. Again, data for these will come from the lender’s GFE and Instructions to Escrow.

Line 901 has the 📊Proration icon, at the far right, to trigger the use of the **Proration** screen to calculate prepaid interest.

The 📖Payee Name and Address icon is used to fill both the payee name and address at the same time; the 📖NAF icon is available to facilitate name and address information entry.

![HUD Form 900 screen](image)

Note the far right-hand column is now labeled **Seller Paid (Credit to Buyer) Amount**. This reflects the 2010 RESPA requirement that seller paid loan items appear as a credit on page 1 of the HUD. **Because this is a credit to the buyer, the full charge should be shown in the Paid From Borrowers Funds at Settlement column and any credit from the seller should be entered into the Seller Paid (Credit to Buyer) Amount column.** Seller data that is entered will not appear on page 2 of the HUD, but rather will be presented on page 1 as an aggregate, crediting the buyer and debiting the seller. The default description there will be **Seller Paid Loan Charges**, which can be changed by the user by editing the description on lines 208 or 508. If lines 208 or 508 have been used for another purpose, amounts will not be able to be entered in this column and a notice to that effect will be presented. The user will need to move the 208 or 508 items to another line for the aggregate total functionality to work properly, or manually enter their own debit/credit figures.
HUD Form 1000. Reserves Deposited with Lender

The 1000 screen has changed a little with the 2010 RESPA requirements. Line 1001 now reflects the GFE Amount for the Initial deposit for your escrow account, found on page 2 of the new GFE, line #9. Also shown on line 1001, inside the field under the Paid From Borrowers Funds at Settlement heading, is the net of the amounts calculated from the data entered on lines 1002 through 1009, on the left side of the screen.

Note the far right-hand column is now labeled Seller Paid (Credit to Buyer) Amount. This reflects the 2010 RESPA requirement that seller paid loan items appear as a credit on page 1 of the HUD. The full charge for reserves is summarized by the system in the Paid From Borrowers Funds at Settlement column and any credit from the seller should be entered into the Seller Paid (Credit to Buyer) Amount column. Seller data that is entered will not appear on page 2 of the HUD, but rather will be presented on page 1 as an aggregate, crediting the buyer and debiting the seller. The default description there will be Seller Paid Loan Charges, which can be changed by the user by editing the description on lines 208 or 508. If lines 208 or 508 have been used for another purpose, amounts will not be able to be entered in this column and a notice to that effect will be presented. The user will need to move the 208 or 508 items to another line for the aggregate total functionality to work properly, or manually enter their own debit/credit figures.
HUD Form 1100 Title Charges

The Title Charges form has the same three Lender icons 📃 with three tabs of Title Charges screens for each (A, B & L). The Title Charges (A) screen is shown below, and will be described here. The (B) & (L) screens are discussed following the explanation of the (A) screen.

Should there be more than one lender, care must be taken to properly record title charges on the appropriate lenders’ screens, so that the GFE Comparisons generated are accurate.

The NAF icon is highlighted when the cursor is in a payee field, as indicated by the highlighted :T on line 1102 below. The Payee Name and Address icon is also used here to facilitate entry of payee data. The Modify icon is used to open data entry/edit screens on lines 1102, 1103 and 1104 for Settlement fees and Owner’s and Lender’s title insurance – which will be described below. The payee field should reflect “:T” if the Company is collecting the fees or the appropriate vendor’s name if the fees are being paid to a third party.

The amount field on line 1101, Title Services and lender’s title insurance, under the Paid From Borrower’s Funds at Settlement heading, reflects the sum of the items detailed on lines 1102, 1104 and all of the items on the Title Charges (B) and Title Charges (L) screens that are tagged with #4 (HUD 1101) in the From GFE field (explained below). The GFE Amount field, on line 1101, is used to enter the amount from the Lender’s GFE, box #4.

The amount field on line 1102, Settlement, Escrow or Closing Fees to, under the Paid From Sellers Funds at Settlement heading, reflects the amount of non-GFE settlement charges paid by the Seller, if any, included in the 1102 breakdown screen (discussed below). It does not include settlement charges from the GFE attributable to the Buyer but paid by the Seller – those will be reflected in a Seller Credit on page 1 of the HUD. The GFE Amount field, on 1102, is only used to segregate Escrow charges if they are to be in a separate category from Title Charges and Lenders Title Insurance.

The amount field on line 1103, Owner's title insurance to, under the Paid From Borrower's Funds at Settlement heading, reflects the total Owner’s title insurance premiums and other itemized additional charges detailed in the breakdown screen (discussed below), and all of the items on the Title Charges (B) and Title Charges (L) screens that are tagged with #5 (HUD 1103) in the From GFE field (explained below). The GFE Amount field, on line 1103, is used to enter the amount from the Lender’s GFE, box #5.

The GFE Category fields should be checked to make sure the right categories are selected for each line.
The **Lender’s title policy limit $** figure, on line 1105, will reflect the loan amount entered on the **Lender’s Policy and Additional Charges** data entry/edit screen, and will be blank until that edit screen is utilized. This figure can be edited via the **Modify** icon on line 1104.

The **Owner’s title policy limit $** figure, on line 1106, will reflect the sales amount entered on the **Owner’s Policy and Additional Charges** data entry/edit screen, and will be blank until that edit screen is utilized. This figure can be edited via the **Modify** icon on line 1103.

The **Agent’s and Underwriter’s portions of the total title insurance premium**, shown on lines 1107 and 1108, are computed based on the remittance percentage entered on the underwriter menu maintenance screen (entered by System Administrators), and cannot be directly edited, if the **payee on 1103 & 1104 is “:T”**.

For outside title transactions, once the payee name is anything other than blank or :T, the Agent’s portion of the total title insurance premium and Underwriter’s portion of the total title insurance premium fields become accessible to manually enter the values into them. The outside title company must provide the values to be entered by Escrow into 1107 & 1108 in that instance.
**Line 1102 Settlement or Closing Fees**

The **Settlement or Closing Fees** data entry/edit screen, reached via the Modify icon on line 1102, is shown below.

This screen should be used to enter all ":T" (the Company's) escrow fees.

Escrow fees the Company is charging that are not included in the GFE box #4, and which are paid by the seller, are entered in this breakout screen as well, with the amount of the charge entered in the **Seller Amount** field.

Escrow fees to third parties, whether included in the GFE box #4 amount or not, should be entered on screens (B) and (L).

The top portion of the screen presents fields into which information about the basic escrow fee is entered. A description of the fee is entered in the **Escrow Fee**: field, and the amount of the total charge in the **Escrow Fee Amount**: field. If the ":T" payee was identified in the payee field of line 1102, the **Income Code** dropdown will be enabled and the appropriate code should be selected. The WTH and POC check boxes are provided, as are the **Buyer Amount**, **Seller Credit to Buyer** and **Seller Amount** fields.

Items that are payable to the Company (:T payee) will have the total amount charged for the item entered into the **Escrow Fee Amount** field, and the buyer's charge (from the GFE) would be entered into the **Buyer Amount** column while any seller paid, non-GFE amount, would be entered into the **Seller Amount** column. If the seller is paying for some or all of the **Buyer Amount**, the amount the seller is paying is to be entered into the **Seller Credit to Buyer** column. This credit will be accumulated with any others into one figure on page 1 of the HUD.

The **Escrow Fee Amount** must total the sum of the **Buyer Amount** and **Seller Amount** fields for the primary entry (the one on the top half of the screen).

Click on the New Item icon, in the top left corner of the Additional Charges section of the screen, to add additional charge records. The following screen will be superimposed over the Settlement or Closing Fees screen.

Enter the detail for the additional charge and then either click on the Add Another button, lower left, to save the information on the added charge, and refresh with a blank screen to add another charge, or click on OK to return to the initial screen. All entered charges will be summed in the boxed fields for **Buyer Amount** and Paid From Sellers Funds at Settlement on line 1102. The **Buyer Amounts** (only) will roll up into the Paid From Borrower Funds at Settlement field on line 1101.

Non-GFE, paid by Seller, charges will not roll up into 1101.

The total amount of any entries in the Seller Credit to Buyer fields will not be presented on the 1100 screen.
Line 1103 Owner’s Title Insurance

The Owner's Policy and Additional Charges data entry/edit screen, reached via the Modify icon on line 1103, is shown below. It is similar to the Settlement or Closing Fees screen, but there are some fundamental differences.

The Owner's Policy Description should be entered into the field of that name, at the top of the form. If the Title Rate Description table is properly configured, the policy description should default from the selected Premium Rate entered on the first screen of Initial Questions. The Owner’s Policy Liability should be defaulted, from the Sales Price. The premium should be entered in the Owner's Policy Premium field. The appropriate income code should be entered; the dropdown can be used to assist with that. The WTH and POC check boxes are provided. Also provided are the Buyer Amount field and a field labeled Seller Credit to Buyer. You should enter the full premium in the Buyer Amount column and the amount being paid by the seller (if any) in the Seller Credit to Buyer field. If the seller is paying all, or part of, the owner’s policy premium, it is not shown as a seller charge on page 2 of the HUD, but is shown on page 1 as a debit to the seller and a credit to the buyer – on lines 207 and 507.

The New Item icon on this screen is used to add information on endorsements or other policy related charges. The Charge Type (Endorsement or Other) should be selected, then the Description of the item, Income Code and Amounts are entered. Like the other screens like this, the Add Another button will let you add more items, as needed. Only Endorsement entry amounts will be included, along with the premiums, for the line 1107 & 1108 calculations.
Line 1104 Lender’s Title Insurance

The Lender’s Policy and Additional Charges data entry/edit screen, reached via the Modify icon on line 1104, is shown below, and is identical in format and function as the Owner’s Policy and Additional Charges data entry/edit screen, so will not be further explained. See the discussion above regarding line 1103.

The GFE figure related to this line is included in the GFE Amount entered on line 1101, which typically includes the GFE amount relating to line 1102 as well.

The charges entered on the 1102, 1103 & 1104 breakdown screens can be printed out via the Fee Check Invoice report (Disburse > Fee Check Invoice).

Computer to calculate fees

Please note that the Rate Calculator in Impact/SQL does not currently handle some common pricing practices and is under review for revision (as of September 2013). Therefore, a full description of the Rate Calculator will not be included in this section of the Escrow manual.

NOTE: If the rate calculator is used, the primary Escrow Fee Amount, Owner’s Policy Premium, and Lender’s Policy Premium fields, on the 1102, 1103 and 1104 date entry/edit screens will not be able to be edited. A message to that effect will present on those screens. Also, the payee fields, on those lines, will be defaulted to “:T” and disabled. Additional charges (endorsements and other) will be able to be added on those screens.
Form 1100 - Title Charges (B) and (L)

Additional title charges, to be paid to outside parties, should be detailed on the Title Charges (B) and Title Charges (L) screens. Charges entered on these lines will appear on the HUD (as opposed to the summary figures presented for charges entered in the breakdown screens on lines 1102, 1103 and 1104). These charges may or may not have been identified on the lender’s GFE, and the From GFE field is used to identify whether each charge was on the GFE and, if it were, in which box (#4 or #5) was it included. The From GFE options are None, #4 (HUD 1101) and #5 (HUD 1103).

The values entered in the Paid From Borrowers Funds at Settlement field, on lines in which the From GFE entry is other than None, will total into the boxed figures, under the Paid From Borrower's Funds at Settlement on lines 1101 and 1103, as appropriate, on the Title Charges (A) screen.

Fees with From GFE entries of #4 (HUD 1101) or #5 (HUD 1103) should have the full amount of the charge entered in the Paid From Borrowers Funds at Settlement column and any seller paid portion of the charge should be entered in the Paid From Sellers Funds at Settlement column. Any values entered in the Paid From Sellers Funds at Settlement field, on lines in which the From GFE entry is #4 (HUD 1101) or #5 (HUD 1103) (rolling into 1101 or 1103), will be accumulated with the other Seller Credit to Buyer figures and will not be treated as Seller Paid items (the way the column header implies).

Only entries with None in the From GFE field, with amounts in the Paid From Sellers Funds at Settlement, are treated as Seller Paid items.

The charge Description is entered to the left-most field, the payee in the “to” field. The Payee Name and Address icon will open the payee name and address detail screen which can be used to complete the “to” field; and the NAF icon can facilitate that as well. The From GFE option is selected via the dropdown provided; and, the WTH and POC checkboxes, and POC Modify button are provided.

The Title Charges (B) screen covers lines 1109 through 1120.

The Title Charges (L) screen is identical to the Title Charges (B) screen, covering lines 1121 through 1132.
HUD Form 1200. Government Recording and Transfer Charges

The 1200 lines’ screen has the same three Lender icons, used to switch between lenders, at the top of the screen, along with the NAF icon, which will be enabled when appropriate. For each lender, there are three tabs (A, B & L). Recording Charges (A) is presented first below. The routine recording and transfer tax charges are entered on this screen.

Should there be more than one lender, care must be taken to properly record recording charges on the appropriate lenders’ screens, so that the GFE Comparisons generated are accurate.

A “switch” is set, at the top of Recording Charges (A), labeled Disclose Seller Amounts in Sellers Column. This switch is available, on the 1200 section only, to provide for Paid From Sellers Funds at Settlement figures to be presented on the HUD lines they are entered on and so that they will not roll up to 1201 or 1203 like the Buyer Amounts, when the switch is CHECKED. Left UNCHECKED, Seller Amounts will roll up into the 1201 or 1203 lines in the Seller’s column as directed. The default setting (checked or unchecked) can be set, for the database, in Utilities, by the System Administrator.

The screen shots below reflect the changes in screen appearance, of Recording Charges (A), when the Disclose Seller Amounts in Sellers Column checkbox is checked and when it is unchecked. The screen will be discussed in more detail on the following pages.

When Checked, the seller amount fields are placed on the far right of the screen, under the Paid From Sellers Funds at Settlement heading. The values entered into those fields are direct, seller paid, items that will present on the HUD on the line number where entered.

When Unchecked, the Seller Amount fields are placed in the body of the screen to signify that amounts entered into them will appear outside of the columns on the HUD and will roll up to 1201 or 1203 as appropriate. As will be seen below, this can apply to items on the other two tabs as well.
**Line 1201 Government Recording Charges**

If the **Disclose Seller Amounts in Sellers Column** switch is **UNCHECKED**: the summary figures, on the right side of the screen on line 1201, under the **Paid From Borrowers Funds at Settlement** and **Paid From Sellers Funds at Settlement** headings, will reflect the **Government recording charges** as entered/computed on line 1202, in the **Buyer Amount** and **Seller Amount** fields, and all buyer and seller entries on **Recording Charges (B)** & **Recording Charges (L)** flagged with From GFE code #7 (HUD 1201) (explained below). The **GFE Amount** field, on line 1201, is used to enter the amount from the **Lender’s GFE, box #7**. Seller paid portions of the buyer’s GFE charges are entered into the **Seller Credit to Buyer** column and will accumulate to a credit on the first page of the HUD.

If the **Disclose Seller Amounts in Sellers Column** switch is **CHECKED**: only the summary figure, on the right side of the screen on line 1201, under the **Paid From Borrowers Funds at Settlement** heading is utilized; it will reflect the **Government recording charges** as entered/computed on line 1202, in the **Buyer Amount** field, and all buyer entries on **Recording Charges (B)** & **Recording Charges (L)** flagged with From GFE code #7 (HUD 1201) (explained below). The **GFE Amount** field, on line 1201, is used to enter the amount from the **Lender’s GFE, box #7**. Seller paid portions of the buyer’s GFE charges are entered into the **Seller Credit to Buyer** column and will accumulate to a credit on the first page of the HUD.

In all instances, if the seller is paying for some or all of the **Buyer Amount**, the amount the seller is paying is to be entered into the **Seller Credit to Buyer** column, while the full charge is entered into the **Buyer Amount** field. This credit will be accumulated with any others into one figure on page 1 of the HUD.

The **Payee Name and Address** icon and **Calculator** icon (used elsewhere to open proration screens) are used on this screen and behave in the same manner as with the other screens. The calculation screens will be discussed below.
Line 1202 Recording Charges

On line 1202, there are three options for entering recording charges: Aggregate, calculated or manual entry.

Aggregate

If the Company is utilizing the aggregate charge methodology, for recording charges, the user would click on the Aggregate Recording checkbox, at the far left of line 1202, and manually enter the figures provided by Escrow Administration into the Buyer Amount field (and Seller Credit to Buyer or Seller Amount or Paid From Sellers Funds at Settlement fields, as appropriate). This will then create an automatic description on HUD line 1207 that reads “Aggregate Recording Fee”, with a payee field filled with the payee from line 1202, and will display the total amount. This amount will flow to the summary amount on line 1201.

Calculated

If the system has been configured with the recording charge calculation details for the state and county of the property involved in the transaction, the Calculator icon should be clicked on to open the Recording Fees calculation screen. If the system has NOT been configured to calculate recording fees for the state and county of the property, the Calculator icon will not be active (it will be grayed out) and the user will not be able to have the system calculate the fees. The user should enter the number of pages for each document type and the system will compute a Total Charge (middle of the screen shown below) and will default the Buyer Amount and Seller Amount fields, based on the settings the database is configured with. The user can then edit the Buyer Amount and Seller Amount values if need be. The Seller Amount fields here will populate the Seller Amount or the Paid from Sellers Funds at Settlement field on line 1202, depending on configuration. Click on the Remove button to delete all entries (this will remove the detail from the Recording Fees screen, but if the data had been saved earlier, the data will remain in the fields on line 1202, where it can be edited manually). Click on Cancel to exit without saving changes and OK to save and exit.

Manual Entry

Should the Aggregate Recording option not be chosen, and if the system is not configured to calculate recording fees for the state and county involved, the user can manually enter values into the Deed $, Mortgage $, Release $ and Buyer and Seller Amount fields on line 1202.
**Line 1203 Transfer Taxes**

If the Disclose Seller Amounts in Sellers Column switch is **UNCHECKED**: the boxed figures, on the right side of the screen on line 1203, under the Paid From Borrowers Funds at Settlement and Paid From Sellers Funds at Settlement headings, will reflect the sum of all of the other figures entered on Recording Charges (A) lines 1204 and 1205 in the Buyer Amount and Seller Amount fields, and all buyer and seller entries on Recording Charges (B) and Recording Charges (L) flagged with From GFE code #8 (HUD 1203) (explained below). The boxed figures on line 1204, under the Buyer Amount and Seller Amount columns (mid-screen) are the sum of the City and County tax stamp and transfer tax Buyer Amounts and Seller Amounts. The GFE Amount field, on line 1203, is used to enter the amount from the Lender’s GFE, box #8. Seller paid portions of the buyer’s GFE charges are entered into the Seller Credit to Buyer column and will accumulate to a credit on the first page of the HUD.

If the Disclose Seller Amounts in Sellers Column switch is **CHECKED**: only the summary figure, on the right side of the screen on line 1203, under the Paid From Borrowers Funds at Settlement heading, is utilized; it will reflect the sum of all of the other figures entered on Recording Charges (A) lines 1204 and 1205 in the Buyer Amount fields, and all buyer entries on Recording Charges (B) and Recording Charges (L) flagged with From GFE code #8 (HUD 1203) (explained below). The boxed figure on line 1204, under the Buyer Amount column (mid-screen) is the sum of the City and County tax stamp and transfer tax Buyer Amounts. The GFE Amount field, on line 1203, is used to enter the amount from the Lender’s GFE, box #8. Seller paid portions of the buyer’s GFE charges are entered into the Seller Credit to Buyer column and will accumulate to a credit on the first page of the HUD.

**Lines 1204 – 1206 Tax Stamp and Transfer Taxes**

The same calculated and manual data entry options discussed above, for line 1202, exist for these lines. While the data entry/edit screens are different in content, the concepts are the same. Please refer to that section for details, they will not be repeated here.
1200 – Recording Charges (B) & (L)

Additional recording charges should be detailed on the Recording Charges (B) & (L) screens. These charges may or may not have been identified on the lender’s GFE. The From GFE field is used to identify whether each charge was on the GFE and, if so, in which box (#7 or #8) it was included. The From GFE options are None, #7 (HUD 1201) and #8 (HUD 1203).

The charge Description is entered to the left-most field, the payee in the “to” field. The Payee Name and Address icon will open the payee name and address detail screen which can be used to complete the “to” field; and the NAF icon can facilitate that as well. The From GFE option is selected via the dropdown provided; and the POC checkbox, and POC Modify button are provided.

The values entered in the Buyer Amount fields, on lines in which the From GFE entry is other than None, will total into the summary figures, under the Paid From Borrower’s Funds at Settlement on lines 1201 and 1203, as appropriate, on the Recording Charges (A) screen. Any seller paid portion of the GFE charge should be entered in the Seller Credit to Buyer Amount column.

Any values entered in the Paid From Sellers Funds at Settlement field, on lines in which the From GFE entry is #7 (HUD 1201) or #8 (HUD 1203) will not roll up but will present on the indicated line of the HUD if the Disclose Seller Amounts in Sellers Column switch is CHECKED.

Any values entered in the Seller Amount fields, on lines in which the From GFE entry is #7 (HUD 1201) or #8 (HUD 1203) will roll up to 1201 or 1203 if the Disclose Seller Amounts in Sellers Column switch is UNCHECKED. The Seller Amount field is presented in the body of the screen in this situation.
HUD Form 1300. Additional Settlement Charges

The 1300 section of the HUD has also changed with the 2010 RESPA requirements. The new screens are shown below. The Payee Name and Address icon and Calculator icon are utilized on the four pages (Add'l Charges (A) – Add'l Charges (D)) that exist for each of the three lenders, selected with the Lender #1-#3 icons. The NAF icon will be enabled when appropriate. Should there be more than one lender, care must be taken to properly record additional lender charges on the appropriate lenders’ screens, so that the GFE Comparisons generated are accurate.

Note that Add'l Charges (A) is unique in that it only reflects two lines for charges. These lines always roll up into summary amount on line 1301, reflecting a total of buyer charges and tie to the amount on page 2 of the GFE, on line #6.

The non-GFE HUD reflected hard-coded descriptions on lines 1301 (Survey) and 1302 (Pest Inspection). These are not hard-coded on the GFE HUD. In fact, line 1301 is used as purely a descriptive heading: “Required Services that you can shop for” (these are, by definition, Category 3 items, thus the default of that GFE Category in that column).

If the seller pays either of the two items on screen A, the full charge should be entered in the Paid from Buyer’s Funds at Settlement column and the amount being paid by the seller should be entered into the column labeled Seller Paid (Credit to Buyer Amount). The seller paid amount will appear as a Seller Paid Credit on page 1 of the HUD. On screens B-D, if the Include in 1301 checkbox is checked on an item that the seller is paying in part or in whole, the full amount of the charge must be entered into the Paid From Borrower’s Funds at Settlement column and the amount being paid by the seller should be entered into the Paid From Seller’s Funds at Settlement; it will be included in the Seller Paid Credit on page 1 of the HUD, as the column is labeled on screen A, otherwise (unchecked Include in 1301 box) charges with seller amounts are truly treated as seller paid charges.
Screens Add’l Charges (B) – Add’l Charges (D) are common in format, as shown below. Additional lines can be forced to roll up into 1301 with the Include in 1301 checkboxes. Charges to be included in 1301 must be listed before charges that will not be rolled up. The Include in 1301 checkboxes on Add’l Charges (B) – Add’l Charges (D) only are available one at a time, and cease to be available once a line does not have its box checked. There are two new columns on these screens: GFE Amount and GFE Category, and they have been explained previously. If the charge is not a lender mandate (not on the GFE), do not enter a GFE Amount for it, on screens (B), (L) or (D).

**HUD Summary**

This is the balancing screen that summarizes the entries made on all HUD lines and shows the amounts due to/from the buyer and seller.

Any checks for amounts listed on line 303 or line 603 can be split among several payees by using the Split icon next to the disbursement item on the Disburse > Create & Print Checks screen.
**Lender Summary**

The Lender Summary screen presents a **GFE Total** figure in the lower left of the screen, on “with GFE” files; sample shown below. This figure is provided so the user can compare it to the **A + B Total Estimated Settlement Charges** figure found on the Lender’s GFE, both on the bottom of GFE page 1 and the bottom of GFE page 2. If it is the same on this screen as on the Lender’s GFE, then all of the values have likely been entered properly on the preceding screens (barring offsetting errors). Unfortunately, if the figures do not match, no guidance can be provided as to where the error might be other than to compute the difference and see if a single item matches that figure (not likely to be so lucky). A review of each **GFE Amount** field, vs. the Lender’s GFE, will be needed to locate the discrepancy.

![Lender Summary Screen](image)

**Held Funds**

The treatment of funds held by the **Listing, Selling** or **Other Agent** is modified under the 2010 RESPA regulations. The user will still enter the amount held, and the party, on the **Dates/Transaction Information** screen. A message, in red text, will appear on the upper right of the 700 screen detailing the held funds (as shown here).

![Held Funds Message](image)

A **Funds held by broker** description will appear in the 200 section, as always, but is now mirrored on the 500 section and the funds presented in the Seller’s column, on line 703 are net of the held funds and a POC entry is reflected on line 704, in the amount of the held funds.
The 2010 RESPA HUD-1

For files prepared under the “with GFE” file types (selected on the top of the first page of Initial Questions) the 2010 RESPA HUD-1 is a three page document, minimum. The first and second pages are familiar, albeit with some changes, and the third page is the GFEC (Comparison of Good Faith Estimate and HUD-1 Charges, with the Loan Terms). For each additional loan, there will be another GFEC. Should there be payoffs, entered through the primary and secondary payoff screens, the traditional payoff detail schedule page will print. The first two buyers and/or sellers names and addresses, if not too long, will appear on page 1 of the HUD; but, if the names/addresses are too long, or there are more than two buyers and/or sellers, there will be a “Buyers and Sellers Addendum” page printed, listing those additional parties. All buyers’ and sellers’ names and addresses must be presented, per the new regulations.

The Print HUD with GFEC control panel, presented below, provides a variety of settings that the user can use to generate a variety of HUD’s.

The HUD Selection dropdown option provides for a Combined HUD, a Buyer Only HUD or a Seller Only HUD.

For files with more than one loan, it is possible to print a combined HUD or separate HUD’s for each loan. In the Options box, the user would click on the Separate Lenders checkbox to generate separate HUDs by loan; leave unchecked for a combined HUD. Either way, each loan will have a separate GFEC. The Lender 1 HUD will show the proceeds of the second (and third, if entered) loan on page 1.

An addendum which itemizes the Seller Paid Borrower Charges (GFE items paid by the seller on behalf of the buyer), which are lumped into a Seller Paid Credit on page 1 of the HUD, can be printed on request, utilizing the Itemize Seller Paid Borrower Charges option.

The HUD-1A is not supported/provided for “with GFE” files in Impact/SQL.
Residential – With-GFE Worksheet Data Entry

The “with GFE” worksheet style of data entry screens are virtually identical to those of the “with GFE” HUD style of data entry screens (discussed earlier in this documentation), with the primary difference being that the 207/208 & 507/508 lines cannot be accessed via this data entry path. Due to the lack of HUD line numbering in the worksheet style of data entry, it will likely prove more difficult to use the worksheet style than the HUD style, for “with GFE” files and, therefore, the use of the worksheet style for “with GFE” files is not recommended.
Settlement Entry – Commercial

The data entry of settlement items for Commercial files was introduced in version 7.6 of Impact/SQL and is completely different from the HUD or Worksheet data entry styles. Only a Settlement Statement can be generated out of a Commercial file; no HUD’s.

The Settlement Entry menu has two selections on it: Parties and Settlement Items.

**Parties**

The Parties menu entry, on the Settlement Entry menu, takes the user to the Parties screen, where party information can be edited, just as under the Initial Questions > Parties, menu option. Having this function available on the Settlement Entry menu lets the user “Jump” from Settlement Items to Parties and back again, which will assist in data entry.

**Large Dollar Amounts**

There is now support for large dollar amounts, up to $2,337,203,685,476.00, for Commercial transactions.

**Settlement Items**

The Settlement Items menu selection is the replacement for the traditional Worksheet Style entry that users had used for commercial transactions, prior to version 7.6 of Impact/SQL. There is not a HUD Style of data entry for Commercial files. The Settlement Items style of data entry is configured the way it is to allow for an unlimited number of settlement items to be entered in a file.

The Settlement Items menu selection will present the user with the Settlement Charges screen below, through which the entry of settlement items will be initiated.
At the top of the Settlement Charges screen the Save & Exit icon will save changes and return the user to the Impact desktop.

The Print icon is used to generate either a Settlement Statement or Title Instructions.

The action icons Previous, Jump and Next are available for moving back to Parties or forward to Settlement Charges (depending on where the user is). Jump can also be used to get to Initial Questions.

The Title Charges icon will be discussed later in this documentation.

On the left side of the screen, the user will see a “tree-view” of Settlement Items. When first loaded, the Settlement Summary entry, of the tree, will be highlighted, and the Settlement Summary screen (shown on the prior page) will be displayed.

At the bottom of the tree-view of Settlement Items, there are three buttons.

- Expand All – used to present full tree detail. Individual branches can be expanded by clicking on the “+” plus sign in front of the category name.

- Collapse All – will bring the tree-view back to that shown to the right, with no sub-level branches shown.

- The Toggle icon, to the right of the Collapse All button, is used to alter how the Lender Items are presented. There are two options: Lender Items by Lender and Lender Items by Category. The resulting presentation alternatives are shown below.

At the top of the tree-view of Settlement Items, there is an Add New Settlement Item icon. It is used to create a new settlement item entry. When clicked on, a dialog will present listing the types of items that can be created, and the user should select the type of item they wish to add. Alternatively, when a particular category is highlighted, on the tree-view, and the display on the right side of the screen changes to detail of the category selected, there is an icon on that display for adding an item of the type highlighted.


**Settlement Summary**

On the Settlement Summary (shown below), there is a Buyer Summary and Seller Summary of debits and credits at the top of the screen. If data has been entered, on the Buyer and Seller entries indicating percentage ownership, the bottom half of the Settlement Summary presents two tabs of data, one for **Fractionalized Buyer** data and the other for **Fractionalized Seller** data. Those tabs reflect the **Balance Due** from or **Refund Due** to the listed parties. Their fractional interest percentage is presented before the party names.

![Settlement Summary Diagram](image)

---

**Prorations**

**Prorations** is the first category on the tree-view below the **Settlement Summary** entry. When **Prorations** is highlighted, the screen on the right will switch to a listing of existing prorations entered for the file.

The **New Proration** icon will bring up the Proration entry screen shown below, through which proration items are added to the file.

![Prorations Screen](image)
The **Information** tab is selected upon presentation of the screen, and this is where details of the proration item are entered, or the **Proration Calculation** tool is invoked.

The **Description** of the proration should be entered in the field of that name at the top of the form. The user can complete the other fields manually, but normally will select the **Calculator** icon to pull up the **Proration Calculator** screen.

The **Total to Prorate**, the **Starting Date** and **Ending Date**, the **Total to Prorate Based On** option, the **Proration Based On** option and the **Give Credit** to option are to be entered/selected by the user and then the **Calculate** button is used to perform the calculation. Clicking on the **OK** button will have the effect of performing the calculation and returning the user to the **Prorations** screen. The **Cancel** button is used to exit the screen without saving any entries or changes. The **Remove** button is used to delete the proration entry’s detail, but leave the previously calculated data available for editing.

Once an entry’s detail has been entered and the **OK** button is clicked on, the user is returned to the **Proration** screen, **Information** tab selected. In the sample below, $5,000 was prorated, on an Annual, 365 Day with Credit to Buyer basis, for the period 07/01/13 to 09/23/13. Because the Proration Calculator was used to develop the proration, all of the fields other than **Description** are grayed out and cannot be edited from this form. The user can hit the **Proration Calculator** icon to get back to the screen above, where changes can be made, if need be.

The **Add Another** button can be used to add another proration item.

The **Cancel** button will let the user abandon the addition of the proration.

The **OK** button will save the entry and return the user to the **Proration** screen.

The **Notes** tab, on the **Proration** screen will let the user add comments to the item. Those comments will print on the Settlement Statement.
The screen shot below displays the Prorations screen. On the right of each entry, there are two icons. The Modify icon is used to bring up the Proration entry screen with the detail of the selected item loaded. The Delete icon is used to remove the proration item; the user will be prompted to be sure they intended to delete the item before it is removed. These two icons appear on all of the settlement items screens and have the same purpose on each.

Once more than one entry exists on the Prorations screen, the Rearrange Items icon is enabled and is used to re-order the items, for their preferred presentation on the Settlement Statement. A screen will present that will let the user move a selected item up or down the list, as desired.
Additional Deposits

There are two sub-category entries, under the Settlement Items tree-view Additional Deposits category: Buyer and Seller. If the main category, Additional Deposits, is highlighted, the screen presented on the right has a Party field at the start of each record, as shown below.

If the Buyer or Seller categories are highlighted, then the Party field is not presented and the screen title changes to Additional Buyer (or Seller) Deposits, as shown below.

Either way, when the New Additional Deposit icon is clicked upon, the screen below is presented. Notes entered will present on the Settlement Statement.

If the setup option is not flagged regarding requiring a receipt upon entry of an additional deposit (really mis-named, it should be make receipt entry optional), the check box “Enter Receipt”, seen to the right, will not present. The party for whom the deposit is for the benefit of should be selected with the dropdown provided. Once the Description and Amount are entered, and the user clicks on OK, the receipt entry screen will present as usual, unless the Enter Receipt checkbox is unchecked.

If an additional deposit is made for the Benefit of the Seller, while the user has selected the Buyer sub-category to view, the newly entered item will not be seen until the Additional Deposits main category or the Seller sub-category, on the tree-view, is selected.

The presence of a receipt related to the additional deposit is indicated by the checkmark on the listing of deposits, under the Has Receipt column header, as shown above…the Buyer deposit has a receipt, the Seller deposit does not.
Rent Schedule

The Rent Schedule Settlement Items category is used to enter details of rent prorations.

The New Rent Proration icon is used to bring up the data entry screen for the detail of each rental. The Description field is used to identify the rental, in whatever manner the user desires. The functionality of this screen is identical to the Proration screen discussed earlier, and so will not be described again here.

The Print icon will generate a report of all of the items entered, in a complete Rent Schedule.

Once more than one entry exists on the Rent Schedule screen, the Rearrange Items icon is enabled and is used to re-order the items, for their preferred presentation on the Settlement Statement. A screen will present that will let the user move a selected item up or down the list, as desired.
Payoffs

As with the Additional Deposits category, in the Settlement Items tree-view, there are two sub-category entries, under the Settlement Items tree-view Payoffs category: Buyer and Seller. If the main category, Payoffs, is highlighted, the screen presented on the right has a Party field at the start of each record, as shown below.

If the Buyer or Seller categories are highlighted, then the Party field is not presented and the screen title changes to Buyer Payoffs (or Seller Payoffs).

Either way, when the New Payoff icon is clicked upon, the screen below is presented. It is the same as that seen in Residential files in Impact, with the only change being that the “Benefit of:” field, at the top of the screen, is open for the user to make a selection of either Buyer or Seller. Seller is the default entry.

The reader is referred to the earlier discussion of the Payoff Details screen, in this documentation, for full details – they will not be repeated here.

The Print icon, on the main Payoffs screen, will generate a Payoff Schedule of all of the payoffs that have been entered.
Agent Commissions

The Agent Commissions category of Settlement Items is where the Listing and Selling Brokers’ commissions are defined and detailed. The screenshot below reflects a file with a Listing Agent, a Selling Agent and one Other Agent. The screen presented is that which is displayed when the Agent Commissions category is highlighted in the tree-view.

The top of the Agent Commissions summary screen, on the right, reflects Base Amount (begins with the total of Sales Prices – but can be changed) and the overall Percent (when it has been entered) and the Total Commission to be distributed among the agents. Note, in the screen shot above, that the warning, at the top of the Agent Commissions summary that “The total commission has not been entered.” This is because, in this example, the information has yet to be provided. The Modify icon, at the top right of the Agent Commissions summary screen, is used to open the edit screen for the Total Commissions, which has three fields on it, as shown here.

If the Base Amount is not the sum of the sales prices of the properties, enter the appropriate value in that field. If the overall commission is then a percentage of the Base Amount (rather than a hard total), then enter the percentage (enter 3 for 3.00%, for example); once a percentage is entered, the Total Commission will be calculated. If the Total Commission is not a percentage of the Base Amount, leave the Percent field blank and enter the Total Commission manually. Once a Total Commission amount has been entered, the agent breakdowns must balance to it before the user can leave the Settlement Items screens.

The bottom of the Agent Commissions screen reflects the Agent Breakdown section, which, to start, reflects just the agent names and their commission summary information. There are up to three sub-categories to the Agent Commissions category: Listing, Selling and Other Agents. When the Settlement Items tree-view category is expanded, and one of the sub-categories is highlighted, the information displayed on the right side of the screen will change to that agent’s detailed commission information, as shown to the right.
The Modify icon, in the upper right corner of the Agent Commission screen, of the selected agent, will bring up the screen presented below. The Modify icon on this screen will let the user edit the party information for the selected agent. There are four tabs on the screen:

- **Information** tab is where the agent’s commission is calculated or manually entered. Depending on system configuration, the Agent Percent will either be a percentage of the base amount or of the total commission. The percentage can be taken out to four (4) decimal places. Once a value is entered in the field, the Agent Amount will calculate, and will be defaulted to the Seller Debit field. It can be manually split or moved by the user. If the commission is a POC’d item, details are entered at the bottom of this tab, starting with checking the POC: checkbox.

- **Sales Tax** – if applicable, sales tax information is entered on the tab of that name. The Sales Tax Percent is entered and the Sales Tax Amount will calculate. The user can move or split the amount as needed between parties.

- **Sub-Agents** – an unlimited number of sub-agent entries can be made. When the Sub-Agents tab is clicked on, a listing of existing entries will be presented, and at that top of the tab the New Sub-Agent icon is used to bring up the data entry screen for the sub-agent, shown here. The amount can either be entered directly, or calculated as a percentage of the agent’s total.

- **Notes** – notes entered on an agent commission, or sub-agent commission, via the Notes tabs, will present on the Settlement Statement.
**Miscellaneous Commissions**

The **Miscellaneous Commission** Settlement Item category is used to enter any additional charge that should appear in the Commission section of the Settlement Statement. When the **New Misc Commission** icon is clicked upon, the following screen will present (absent of any data). The description of the item and the amount to be debited or credited for buyers and sellers are entered in the top third of the screen.

The **Total Amount** field seen on this screen, and many of the other Settlement Item screens, will reflect the net disbursable dollars. In the sample below, a seller credit of $200 is being applied to a buyer charge of $400. This demonstrates providing the credit on the same entry as the charge.

![Misc Commission Screen](image)

If the item is a **POC** item (complete or partial), that detail is entered in the middle of the screen.

The **Payee Information** is entered at the bottom of the screen. The **Search for Payee** icon is used to bring up a listing of all parties entered on the file, for selection of one as the payee. There is the ability to edit the parties, from the listing presented, if need be. The **NAF** icon will be enabled when the cursor is placed in the **Name** field, so the user can select from the NAF for the payee. If the payee is not a party and is not in the NAF, the user can simply enter the payee’s information. The **Remove Payee** icon will be enabled once payee data is entered via the **Search for Payee** icon and clicking on it will clear all of the **Payee Information** fields.

**Notes** entered on **Miscellaneous Commission** entries will present on the Settlement Statement.
Lender Items by Lender / Lender Items by Category

The **Lender Items** category of Settlement items, cover the following charge sub-categories:

- Loan Charges
- Loan Paid in Advance
- Reserves

The ☰ toggle icon, to the right of the Collapse All button at the bottom of the Settlement Items tree-view, is used to alter how the **Lender Items** are presented. There are two options: Lender Items by Lender and Lender Items by Category. The resulting presentation alternatives are shown below.

When the **Lender Items by Lender** option is presented, and a lender is highlighted, the Lender Summary screen is presented on the right side of the Settlement Items screen, showing the gross loan amount, the amount withheld and the net amount due from the lender. A listing of the withheld items is also presented. As specific charge categories, under a lender are then selected on the tree-view, a listing of any charges entered for that sub-category, for that lender, will be presented on the right side of the screen and new items can be added there.

When the **Lender Items by Category** option is presented, and the main category heading is highlighted, a Summary of Lender Items by Category screen is presented on the right side of the screen, as shown below.
When the Lender Items by Category option is presented, and the sub-category heading for a charge type is highlighted, a Summary of [the sub-category selected] screen is presented. The Summary of Loan Charges screen is an example, shown below.

When a lender name is highlighted, under the sub-category heading, a listing of any charges entered for that sub-category, for that lender, will be presented on the right side of the screen and new items can be added there. Each will be discussed below.

### Loan Charges

The Loan Charges screen, reached via the New Loan Charge icon and shown below, will have the lender name defaulted from the path taken to get to the screen or will be the first lender, if the path taken was not through a lender reference. It can be changed, if need be, with the Lender dropdown arrow. The lender's Loan Amount will present to the right.

The Type of loan charge should be selected from the dropdown for that field. The options are shown to the right, below.
If the **Type** of charge selected is **Loan Origination** or **Loan Discount**, the **Percent** and **Total** fields will be enabled so the percentage to utilize for the charge can be entered. With either of these two charge types, the credit amount fields will be disabled and debits calculated will be applied to the party the loan is for the benefit of. The **Payee Information**, on these two types, will default to the lender and will be locked, but can be removed with the **Remove Payee** icon, then can be linked to another party with the **Search for Payee** icon or manually entered (with the **NAF**, if desired).

**POC** and **Payee Information** are the same as with the **Miscellaneous Commission** screen, with the addition of the **Withheld** checkbox.

Lender credits, when being overfunded, are managed by entering a buyer or seller credit (as applicable) and the **Withheld** checkbox would be checked (as shown to the right). Note that the **Total Amount** field name changes to **Total Withheld**.

The **Lender Summary** for the lender identified would show the negative withhold, representing the overfunding.

---

**Loan Paid in Advance**

The **Loan Paid in Advance** item type has a similar data entry screen to the **Loan Charges** screen (bottom two-thirds are identical) but the top third is a bit different, and can vary depending on the **Type** of item being entered.

There are four **Types** of **Loan Paid in Advance** items, as shown above, and discussed in the next section.
**DAILY INTEREST**

If **Daily Interest** is selected, that text will fill the **Description** field and three new fields will present below **Description**: **Start Date**, **End Date** and **Per Diem**. The user can enter values or click on the **Calculate Proration** button to pull up that tool.

![Image of the Proration Calculator](image)

The **Proration Calculator** has two **Proration Type** options: **Interest** and **Per Diem**. Selecting the type of choice will change the description of the second field, to either **Interest Rate** (as shown) or **Per Diem**. The user will enter the appropriate rate or amount, the dates, and the proration basis (365 or 360) and the **Prorated Amount** will be produced when the **Calculate** button or **OK** is clicked on. Depending on which party the loan is related to, the charge will be put in the appropriate debit bucket and the credit fields will be disabled. Should a manual override be desired, after values have been calculated, re-open the **Proration Calculator**, click on the **Remove** button then the **OK** button and the tool will close and the debit/credit fields will be unlocked, but not emptied, and the user can then edit the amounts displayed.
**MORTGAGE INSURANCE PREMIUM**

If the **Type** selected is **Mortgage Insurance Premium**, that text will fill the **Description** field and a **Period** field will be added to the screen. The user should enter the time period in the **Period** field, (“6 months” or “1 year”, for example), and then enter the appropriate dollar amount in the **Buyer Debit** column (or split the charge as agreed upon by the parties). The credit fields are available as needed.

![Mortgage Insurance Premium](image)

**HAZARD INSURANCE PREMIUM**

The **Hazard Insurance Premium** type behaves exactly as the **Mortgage Insurance Premium** type, with just the **Description** changing. Again, the **Period** entry is the time period (“6 months” or “1 year”, for example).

**OTHER**

The **Other** Paid in Advance expense type, when selected, will open up the **Description** field for user edit, and will remove the supplemental field(s) of the other types of **Paid in Advance** items.

![Other Paid in Advance](image)
**Reserves**

The **Reserve Item with Lender** data entry screen is used to record lender reserves for **Hazard Insurance**, **Mortgage Insurance**, **City Property Taxes**, **County Property Taxes**, **Annual Assessments** or **Other**. The user should select the **Type** being entered, from the dropdown. There is the routine POC section of the screen, but there is not a Payee Information section, as it is not applicable.

![Reserve Item with Lender data entry screen](image)

Selecting any **Type** other than **Other**, will force the type selected into the **Description** field. Selecting **Other** will leave that field open for the user to enter any description desired.

If the charge should be calculated, the number of **Months** and the dollars **Per Month** should be entered and the total will calculate, and the debit will be applied to the party the loan is for the benefit of, and the other fields will be locked.

If the charge is not to be calculated, no amounts should be entered in the **Months** and **Per Month** fields and the appropriate amounts are then entered, by the user, in the applicable debit &/or credit buckets.
**Escrow Charges**

The Escrow Charges Settlement Items category is used to enter escrow charges. The "New Escrow Charge" icon is used to create a new entry.

The Escrow Charges item entry screen has the same POC and Payee Information sections on it as the Loan Charges screen does.

The top portion of the screen concerns the charge information. There is, currently only one charge type (Escrow Charge) and that defaults in the Type field. It is possible other Types may be added in the future.

The Description field will default to "Escrow Charge" but the user can edit the charge description.

Should the charge be a Company fee, the appropriate Income Code should be selected for the charge being entered, using the dropdown list. Once an income code is selected, the Payee Information section of the screen will auto-fill with the Company Name (T payee information) and Branch Address. The Payee Information fields will then also be grayed out and will be not be able to be edited.

The user should enter the charge figures in the appropriate debit/credit fields.

Notes can be added and will appear on the Settlement Statement.
**Title Charges**

The **Title Charges** Settlement Items category is used to enter title charges and lender & owner policy premiums. The **New Title Charge** icon is used to create a new entry.

The **Title Charges** item entry screen has the same **POC** and **Payee Information** sections on it as the Escrow Charges screen does.

The top portion of the screen concerns the charge information. There are, currently, three charge types (**Title Charge**, **Lenders Policy** and **Owners Policy**) and **Title Charge** defaults in the **Type** field. It is possible other Types may be added in the future.

When the **Lenders Policy** or **Owners Policy** types are selected, the **Description** field will default with the text selected, but will be left editable so the user can describe the policy being issued.

If the **Lenders Policy** type is selected, the **Liability From** field will be activated and the user will need to select the **Lender** to use to drive the value entered in the **Liability From** field; the lender’s loan amount will populate the **Liability From** field. The field will remain editable so the user can change the liability amount.

If the **Owners Policy** type is selected, the gross sales price aggregate will be entered in the **Liability From** field. The field will remain editable so the user can change the liability amount.

Should the charge be a **Company** fee, the appropriate **Income Code** should be selected for the charge being entered, using the dropdown list. Once an income code is selected, the **Payee Information** section of the screen will auto-fill with the **Company Name** (:T payee information) and **Branch Address**. The **Payee Information** fields will then also be grayed out and will be not be able to be edited.

The user should enter the charge in the appropriate debit/credit fields.

**Notes** can be added and will appear on the Settlement Statement.
Recording Fees

The Recording Fees Settlement Items category is used to enter recording fees. The New Recording Fee icon is used to create a new entry.

The Recording Fee item entry screen also has the POC and Payee Information sections. There are six Types of fees that can be selected, as shown in the screen shot below.

Should the charge be a Company fee, the appropriate Income Code should be selected for the charge being entered, using the dropdown list. Once an income code is selected, the Payee Information section of the screen will auto-fill with the Company Name (T payee information) and Branch Address. The Payee Information fields will then also be grayed out and will be not be able to be edited.

All of the Types, except for “Other”, when selected will have their text auto-fill the Description field but the user field will remain editable. The “Other” type will leave the Description field blank and open for editing by the user.

When the “Recording Fee” type is selected, the Deed $, Mortgage $ and Release $ fields will be opened up for data entry. As dollar amounts are entered in those fields, they will pass also to the debit fields: the Deed $ and Mortgage $ amounts will sum into the Buyer Debit field and the Release $ amount will auto-fill the Seller Debit column. The user may move those amounts.

The Property field is used to tie fees to a particular property. Rates cannot be calculated if a property is not identified. If a property is deleted, and there are recording fees tied to it, the user will be warned that the charges will be deleted, along with the property.

If the rate tables have not been established for the County of the Property, a warning like that shown to the right will present. If there is no such warning, the traditional recording fee calculation screen can be utilized, called for with the Recording Fee Calculator icon. (In this sample, the county was forced to be wrong, for demonstration purposes).
When the **City/County Tax/Stamps** expense **Type** is selected, the screen will alter somewhat. The **Release $** field is disabled, as it is not required. Dollars entered manually into the **Deed $** and **Mortgage $** fields do not auto-fill any of the debit/credit fields. The **Calculator** icon will be enabled if rates have been entered for the property city &/or county. A message that the rates have not been set up will be presented if that is the case.

The **State Tax/Stamp** expense **Type** behaves the same as the **City/County Tax/Stamps** type.

The **City** and **County Transfer Tax** expense **Types** disable all three of the document type fields. The calculator button will be enabled if rates have been entered for the city &/or county. A message that the rates have not been set up will be presented if that is the case.

### Additional Charges

The **Additional Charge** Settlement Items entry screen is used to enter charges that do not fall into the other categories. The **New Additional Charge** icon is used to create a new entry.

The **POC** and **Payee Information** sections are on this screen as well.

![Additional Charge Screen](image)

The user can enter whatever **Description** is desired, and can enter the amounts in the appropriate debit/credit fields. The **Proration Calculator** can be used as well.

Should the charge be a **Company** fee, the appropriate **Income Code** should be selected for the charge being entered, using the dropdown list. Once an income code is selected, the **Payee Information** section of the screen will auto-fill with the **Company Name** (:T payee information) and **Branch Address**. The **Payee Information** fields will then also be grayed out and will be not be able to be edited.

That completes the discussion of **Settlement Items**.
**Settlement Statements**

The Settlement Statement template files in use in the past were replaced with a single new template with version 7.6 of Impact/SQL. Customization at any site was preserved.

Settlement Statements, on Commercial files, can be **Fractional** statements. These statements will divide up the transaction figures by the parties’ ownership interests. **Fractional** statements are only available if **Both, Buyer or Seller** are picked in the Selection area of the print dialog (shown below).

The 📧 **Print** icon, followed by the selection of **Settlement Statement**, is used to open the **Print Settlement Statement** print dialog box, from within the **Settlement Items** window. The user can also run the **Settlement Statement**, from the **Documents** menu in Escrow, as has historically been the path.

The **Print Settlement Statement** print dialog window is presented here.

The **Type** of statement selection is variable by Impact database. The text selected will normally print at the top of the statement. Some companies have additional verbiage on some versions of the statements.

The **Selection** dropdown is used to identify whether **Both** (buyers and sellers), **Buyers, Sellers** or a **Combined** statement are to be produced.

If **Certification Stamps** are enabled, that option will be available for selection.

The user should check the **Include Certification Page** option to get a signature page printed with the statement(s).
The user should check the **Fractional Statements** option to get split statements. Again, this is only enabled if **Both**, **Buyer** or **Seller** are selected in the **Selection** section. Below, the selection screen that pops up when the **Fractional Statements Print Option** is selected (in this case, **Buyer** was the **Selection**). The user should check the party or parties for whom statements should be printed. Clicking on the checkbox at the top left, next to the **Party** heading, will check, or uncheck, all parties listed.

The **Exchange Statements Print Option** would be used in a 1031 Exchange situation where the Accommodators are desired to be shown as the **Seller** or **Buyer/Borrower**. When selected, the user will be prompted with a screen like that shown below (if **Both** was the Selection made; if only **Buyer** or **Seller** were selected, only the Accommodator(s) related to that party type would present). They should check the parties to report with. The party will report with the "**Accommodator**" label at the top of the settlement statement.
Ticklers Menu

These menu items will appear under the Ticklers menu:

- Select and Edit
- Print
- Reminders
- Group Maintenance

Ticklers are reminders to perform tasks for a specific escrow file. If ticklers are used, and some are assigned to you, the Tickler Reminders widget can be used to monitor your tickler items. The Impact Widget Dashboard is discussed earlier in this document.

Ticklers may be useful for various situations such as:

- specific procedures need to be followed during a special or unusual escrow,
- the escrow officer plans for an extended absence and needs to assign tasks for a specific escrow,
- while training a new assistant, as a reminder for the assistant to do certain things within the escrow file,
- to ensure that all routine tasks are performed; and,
- once an escrow is closed, the escrow officer can check if the assignee(s) accomplished the specified items.

If your company's configuration is set for Automatic Ticklers, Impact may be configured to create some pre-determined reminders when a new escrow file is created. Automatic Ticklers can be created for "All" files – or assigned to specific transaction types. They may also be driven by the Open or expected Close dates. Lastly, they can be triggered by specific data being entered in the system for a file.

The designated escrow officer of the escrow file is allowed to set up ticklers for themselves, and ticklers can be Assigned To other members within their branch that are working on the file. If a tickler is Assigned To a member of the branch, it is immediately viewable by that person. The escrow officer can see all of the ticklers on their files, including those that they Assigned To someone else. The assignee only sees the ticklers assigned to them.

Before an escrow officer can assign ticklers to someone else, he/she must add the assignee(s) to their tickler "group". See the section on Group Maintenance (in the following pages) for this procedure.
Ticklers remain with the escrow file unless they are deleted, or the file is cancelled. Ticklers are not global; they are only attached to one (1) specific escrow file. Once an escrow file is closed, the ticklers related to it, will continue to appear in the Tickler Reminders list until they are individually closed, or flagged “Not Applicable” or are deleted. Reports may be generated on pending, completed or all ticklers.

**Select and Edit**

Selecting Select and Edit from the Ticklers menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter The Escrow Number field is pre-filled with the current open escrow number. If no file is open on the desktop, the field is blank, and the user should type in a pre-existing escrow number, then click on the OK button to proceed to the Ticklers screen for the specified file.

If the user wants to use a different escrow number, but is uncertain of what it is, they can click on the Search icon to open the File Search dialogue box. See the File Search section, earlier in this manual, for details on how to use this function.

Clicking on the Cancel button closes the Escrow Number Entry dialogue box.
The **Ticklers** screen that is presented is shown to the right. Existing tickler items are listed, along with indications if they have been **Completed**, are **Not Applicable** and if they were **Auto-generated** by the system.

The **New Tickler** icon, at the top of the screen, is used to add a new tickler item to the file. The **New Tickler** screen is shown below.

The user should select, from the **Assigned To** dropdown list (of all members of the EO’s “group”) the person responsible for completion of the tickled item.

The **Tickler Date** is the date on which the tickler item will first appear on the **Tickler Reminders** screen. This date is displayed and is the date driving the status icons in front of the items (discussed below) on the **Tickler Reminders** screen. The **Calendar** tool can be used to fill the **Tickler Date** field, or the user can enter the date manually in “mmdd” form, for the current year; “mmddyy” for non-current-year dates.

At initial setup of an item, the only other field completed would be the **Description** field, detailing the tickler item. **Descriptions** on auto-created ticklers cannot be edited.

The **Add Another** button can be used to go directly to another **New Tickler** item.

The **OK** button will save the item and return the user to the **Ticklers** screen. **Cancel** will exit without saving.

From the **Ticklers** screen, shown in the upper right of this page, the user can **Modify** or **Delete** an existing item.

When the **Modify** icon is clicked on, the **Modify Tickler** screen appears, presenting the information for the tickler item selected. The screen is identical to that shown above (left), except the screen label is **Modify Tickler**.

The **Completion Date** is the date on which the item in the **Description** field is completed by the assignee. Upon a **Completion Date** being entered, the tickler will no longer be displayed when the **Tickler Reminders** screen is viewed.

The **Not Applicable** checkbox can be used to indicate an item need not be addressed, and need no longer appear on the **Tickler Reminders** screen, without deleting the item.

**Descriptions** on auto-created ticklers cannot be edited.

The **Print** icon, at the top of the screen, will take the user to the **Print Ticklers** screen, discussed next.
Print

Selecting **Print** from the **Ticklers** menu opens the **Print Ticklers** dialogue box.

If the user has a file open on the desktop, the **Specific Escrow** field, in the **Selection** box, will be selected and the file number pre-entered in the field. The user can change the file number if another is to be reported on.

If the user wishes to print ticklers for a specific Escrow Officer, the **By Escrow Officer** selection should be clicked on and the EO should be selected from the dropdown of available EO’s.

If the user wishes to print ticklers for a specific assignee, the **Assigned To** selection should be checked and the assignee should be selected from the dropdown of available assignees.

The desired **Print Selection** option should be selected: All items, Completed Only or Pending Only.

And, finally, the user should use the date fields, in the **Select Date Range** box, to detail the range of dates to cover with the report request.

Reminders

Selecting **Reminders** from the **Ticklers** menu opens up the **Tickler Reminders** screen.

An Escrow Officer can see all of the ticklers on their files, including those that they **Assigned To** someone else. An assignee only sees the ticklers assigned to them.

The seller/buyer names are shown as an added reference beside the escrow file number.

The **New Tickler** icon can be used to add an item from this screen.

The **Modify** icon can be used to edit a selected item.

If a file number is selected, the **Delete Ticklers** icon will remove all ticklers for the specified files. If a specific item is highlighted, the **Delete** icon will only remove the one item.

The **Print** icon is used to get to the screen discussed above.

The **Past Due** icon, in front of an item, indicates it is past its Tickler Date. The **Today** icon indicates the item is due to be worked today. The **Calendar** icon indicates the item is to be worked in the future.
Group Maintenance

Selecting **Group Maintenance** from the **Ticklers** menu opens up the **Tickler Group Maintenance** screen, shown below on the left. A “**Group**” is an **Escrow Officer** and any other employees in the branch that are assigned to that EO’s group. One person might be in several groups. An EO may be in another EO’s group.

Any user that appears in the **Escrow Officer** dropdown list for a branch may maintain **Groups** in that branch.

The 🍀 **Modify Groups** icon, at the top of the screen, will bring up the **Ticklers Maintenance** screen, shown to the right, which presents a listing of all of the people in the branch who are flagged to appear in the Escrow Officer dropdown list for the branch. If there is a check in the checkbox in front of a user’s initials, they will appear as a **Group** leader on the **Tickler Group Maintenance** screen. Unchecking an entry will remove their **Group**.

The 🍀 **Modify Members** icon, on the **Tickler Group Maintenance** screen, will bring up the **Ticklers Maintenance** screen, presenting all of the people assigned to the branch. A check should be placed in front of each user who will be an assignee to the Group specified in the heading. Those people will then be available to assign tasks to.

Click on **Cancel** to exit without saving changes.

Click on **OK** to save and exit.
Disburse Menu

Disbursements from escrow files, by check, wire or transfer slip, are administered from the Disburse menu. Depending on your system configuration, different menu items may appear under the Disburse menu. A complete listing is presented here:

- Create & Print Checks
- Create & Print Individual Checks
- Print Final Disbursement Report
- Fee Check Invoice
- 1099S
- Close File
- Balance Statement
- Update Reason Funds Held
- Disbursements Pending Approval (optional)

A Preliminary Disbursement Report can be printed from the Create & Print Checks > Print > Preliminary Report menu option, and the Print Final Disbursement Report option is available directly from the Disburse menu.

Impact supports laser printer generated checks with MICR encoding, utilizing MICR toner cartridges. While you can use preprinted checks with preprinted check numbers in Impact, it is NOT recommended. There is no longer a mechanism in Impact to easily confirm or reset the next check number prior to printing the checks.
Create & Print Checks

The Create & Print Checks function is used to generate a working set of data, from that entered on the file, that is used to generate disbursements for the file. The function can be re-started, and should be, if financial data has been changed on a file and disbursements have not been completed. When Create & Print Checks is selected from the Disburse menu, Impact will review the data entered into the assorted data entry screens and create a disbursement file of all items ready to be produced.

NOTE: You may Modify, Add, or Delete any disbursement item, but this will not update any data fields on the Initial Questions, HUD Style Entry, Worksheet Style Entry or Settlement Items Entry screens.

If changes are made on the Initial Questions, HUD Style Entry, Worksheet Style Entry or Settlement Items Entry screens, and the user re-enters the Create & Print Checks menu option, then depending on the changes made, the user may wish to click on Yes to start over (in response to the prompt shown below), thereby refreshing the disbursement file. If this is done after some checks have been cut, those items already issued will be re-presented and will need to be deleted, or at least not reprinted.

Should there be no funds in the file, and the user attempts to open the disbursement screen, they will get a message to that effect, asking if they wish to continue to the disbursement screen.
At the top of the Disbursements screen are up to five (5) tabs (depending on system configuration), Pending Items, Receipts, Checks, Wire Outs, and Receivables. To switch from the Pending Items tab to the Receipts (or any other) tab, click on the Receipts (or any other) tab with the mouse, or use the Quick Keys (ALT+"underlined letter in tab label"). As with other tabs in Impact/SQL, the presence of data on the tab will be indicated by a red diamond icon in front of the tab label, as shown below.

At the top left corner of the Disbursements screen the Print icon can be used to access the menu of reports that can be generated. See the Print section below for details on using the Preliminary Report, Print Checks, or Print Final Report functions accessed from this Print menu.

**Pending Items Tab**

On the lower portion of the Pending Items tab is the listing of the disbursement items prepared from the data entered on the file showing, in three (3) columns of data, the Status, Payee, and Amount of each item. There are also icons on the individual entries, and they will be discussed below.

The Status column is used to distinguish if the item will be disbursed as a check, a file transfer or a wire out, or whether it will be prepared for disbursement but put on hold or simply skipped for the time being. The Status is modified by selecting the appropriate Status from the dropdown list. The options are: Skip, Check, Hold, Transfer, or Wire-Out. These options are discussed on the next page. When the Disbursement screen is first opened, any Payoff item will be set with a status of Check, all other items will be flagged Skip.

Select the ☑ Mark All icon at the top left corner of the listing of disbursements, to change the Status of ALL the listed items to the status of Check.

The ☀ New Disbursement icon, in the same location, is used to add a disbursement item to the list.
**Check**

Changing the status of an item to **Check**, will bring up the **Modify Disbursement Item** screen (shown below) on which the details of the disbursement can be reviewed and modified if need be. Once the item is worked up, and the status is **Check**, the **Print Checks** function, off the menu opened with the 🎨 **Print** icon, will cause a check to print for the item, along with all other items with a status of **Check**, at the time the printing of checks is invoked. The 📄 **Modify** icon, on the Disbursements screen, will bring up this screen as well.

![Modify Disbursement Item Screen](image)

The status of the item can also be changed from the **Modify Disbursement Item** screen, by selecting the desired option from the box in the upper right of the screen. Typically, if data entry was done properly in the file, the full **Payee Name** and **Address** information would already be on the disbursement, but if it was not, or needs to be changed, it can be in the top portion of the screen. The bottom of the screen is used for the disbursement detail lines.

The 📄 **New Line** icon can be used to enter additional breakdown lines. Each stub line **Description** can be up to fifty characters. Press **TAB** to move the cursor to the **Amount** field, and then enter an amount. Should the payee be the “:T” (your Company) payee shortcut, indicating a fee slip or fee check is to be generated, the **Code** (Income Code) and **Liability** fields will open up on the detail lines for those entries to be made.

If the number of stub lines are more than the check stub will hold (normally over ten items), then the check stub will print “See attachment for breakdown”. The attached breakdown will print off as a separate page.

The ✗ **Delete** icon can be used to remove a detail line.

Click on **OK** to exit back to the **Pending Items** tab. The disbursement amount for the item will be updated to reflect any changes made on this screen.
**Hold**

The disbursement status of **Hold** is used to place an item on hold. When the status flag is set to **Hold**, the same **Modify Disbursement Item** screen shown on the prior page is brought up for the user to use to confirm the details of the disbursement. The only difference is that now the **Hold Until** and **Hold Reason** fields are now open and available for use.

The user should select the date the hold is expected to be released (there is NOT an automatic release of disbursement holds), and enter a reason for the hold. The item will not be able to be disbursed until the **Hold Until** date is removed.

Placing a check on **Hold** does not prevent the funds from being disbursed in a different check.

**Transfer**

Depending on the Company's system configuration the user may have the ability to transfer funds from one file to another file. The **Transfer** status option will create a debit receipt taking funds out of the escrow file whose Disbursement screen is being worked and a credit receipt adding the funds to a different escrow file. Selecting the **Transfer** status on a Disbursement item will bring up the **Transfer Funds** screen shown here.

The user should enter the appropriate information in the **To Escrow Number** and the **Reason for Transfer** fields, and then click on **OK** to continue with the transfer. Clicking on **Cancel** will stop the process.
**Wire-Out**

There are two (2) Wire-Out configurations possible. Your Company’s configuration setting will determine what option is used.

**Option 1: Centralized Wire Desk Processing and ABA validation**

This Wire-Out option provides a method by which escrow personnel can notify a central wire desk of an outgoing wire they wish to send. Upon completion of the outgoing wire form, the funds will be subtracted from the ledger balance of the file involved and the wire desk will see the outgoing wire request. Once the wire desk confirms the wire out has been sent, they will so indicate that fact, through the Accounting module, and the escrow personnel will get an e-mail notification. This method will require the ABA routing number of the sending bank – and that ABA number will be validated by the system before the wire-out is sent to the Accounting module.

Select the Wire-Out status on the Disbursements screen to open the Wire-Outs screen. Alternatively, if the status is changed to Wire-Out on the Modify Disbursement Item screen and then the OK button is clicked, the Wire-Outs screen will open up.

The Amount field is pre-filled.

If appropriate, enter a number in the Payoff Loan Number field, or enter n/a if not applicable. The field will be pre-filled if the data was entered into the file in the appropriate location. This field must contain data.

The Other Wire Reference field should have relevant data entered to aid the receiving entity in understanding what the wired funds are for.

The fields in the Receiving Bank Information section should be completed, either manually, or place the mouse in the Bank Name field, then click on the NAF icon, in the upper right corner of the screen, to auto-fill this information (see the discussion of the Name and Address File (NAF)). The ABA entry will be validated against a table of valid entries and the user will be prompted if there is not a match. If the ABA number is entered manually, the Bank Name field will be populated from the ABA table data.
The **Off Line Bank Information** field is used for a bank that is not directly linked to the Federal Reserve wire system. All Off Line Banks will have correspondent bank routing information – and that information should be entered in the **Receiving Bank Information** area. This area of the screen is also used to enter information for foreign banks. If this section is needed fill out the **Off Line Bank Information**.

Should there be additional comments that Escrow wishes to make to Accounting, the **Notes** field is the place they should be entered.

Depending on Company configuration, the **Hold Until Date** and **Hold Until Reason** fields may be available below the **Notes** area of the screen. The **Hold Until Date** allows the information for a wire out to be entered but Accounting will not be aware that it exists until Escrow removes the **Hold Until Date**. If a wire out request is placed on hold, Escrow must **Modify** the “held” wire and remove the entry from the **Hold Until Date** in order for Accounting to receive the wire out request. As long as a wire out has not been sent, the wire out can be modified or deleted from the list in the **History** tab on the **Disbursements** screen (discussed below). The **History** tab on the **Wire Outs** screen will present outgoing wire information on the existing file, but no action on those items can be taken on that screen.

Once the Wire Outs form is completed and the wire is ready to be sent, the user would click on the **OK** button to confirm the entry and send the wire; or, click on **Cancel** to discard the entry, and exit back to the **Pending Items** tab. The user must be clear that the wire will be sent at this point, if OK is clicked on.

Once the **OK** button is clicked, the user will be prompted to print an **Outgoing Wire Request**. This is the notification that the user has requested a wire out. Some companies have users sign the **Outgoing Wire Request** and fax it to Accounting to confirm the wire should be sent. Depending on the Company’s system configuration, a wire out approver may have to approve the wire before it goes to Accounting.

If the Company is using the Impact feature of **Dual Authorization of Wires Out** then an individual designated as an approver for wire outs must go under the **Wire** menu and approve the wire before it will be sent to the central wire out desk.

With the centralized wire desk function, on the **Wire Outs** tab, on the **Disbursements** screen, the user will see a listing of all wires processed for the file. Those that are still in a **Pending** status can be modified or deleted. The ✂️ **Modify** icon will be available on those items that can be edited. The ✗ **Delete** icon is also available, if the item is **Pending**. The 📏 **Information** icon can be used to pull up detail on the wires.
**Option 2: Standard Wire Processing**

If the Company does not have the centralized wire processing option turned on, the “short form” Wire-Out option is the alternative; this option will not notify a central wire desk. The user must submit the wire-out form to their Accounting Department by e-mail or fax, or contact the bank directly, to have the wire out processed. This Wire-Out option does not require an ABA routing number.

The user would select the Wire-Out status on a disbursement and the “short form” wire out screen will present, as shown here.

The Date field will default and be locked.

The Wire To field will be filled with the payee from the Disbursement screen.

The Description field should be used to enter any relevant information the user wishes.

The Amount field will be pre-filled with the amount of the disbursement, and will be locked.

The user should click on OK to confirm the entry and move onto the Print screen to generate the Outgoing Wire Request form; or, Cancel to discard the changes, and exit back to the Pending Items tab. Once the wire is “sent” (meaning the Outgoing Wire Request form has been printed) the item will no longer be on the Pending Items tab of the Disbursements screen, but will appear on the Wire Outs tab. The user must take action to have the actual wire processed at the bank – following their Company’s procedures.

**Skip**

As was discussed earlier, all items except for Payoff disbursements are flagged with the status of Skip when the Disbursements screen is first opened. That status will result in no action if the Print Checks function is run. Select the Skip status to remove an existing status.
Modify, Delete and Split

On the Disbursements screen, to the right of each disbursement item in the grid at the bottom half of the screen, there are action icons next to each disbursement item.

The **Modify** icon will bring up the **Modify Disbursement Item** screen discussed above.

The **Delete** icon will remove the disbursement item from the listing. This is handy if the disbursements have been re-built after some have been made, and the user wishes to focus only on those that have not been made – he/she can delete those that have already been worked. The user will be prompted to be sure the deletion is intended.

The **Split** icon is used to bring up the **Split Disbursement** screen through which an item can be split into two or more disbursements.

The **New Disbursement** button is used to start the “split” process. When clicked, the user will be prompted as to whether the new item should use the original payee name and address information for the new disbursement. If one of the resulting items should use the original payee information, the user should reply in the affirmative. If the payee is to be different, reply in the negative. The **Split Disbursement** detail screen (below) will then appear, with or without the payee information defaulted, depending on the user’s response to the prompt.

The screen is virtually identical to the **Modify Disbursement Item** screen, with the addition of the **Percent** field, into which the user can enter a split percentage for the new item. Once entered, a detail line will immediately be created with the **Amount** reflecting the percentage times the original full disbursement amount. The **Description** line will be opened for editing. Alternatively, the user can click on the **New Line** icon to create an entry for a specific dollar amount – skipping the **Percent** field. Once the **OK** button is clicked the user is returned to the **Split Disbursement** summary screen (above) where the **New Disbursement** button is used again to create the next split item. This process is repeated until all the dollars are used up. If the user “X’s” out of the screen when an **Amount Remaining** exists, he/she is taken to the **Modify Disbursement Item** screen with the remaining balance applied to the item and the **Description** available for edit.
**Fee Check/ Fee Transfer Slip**

Impact can be configured to issue a Fee Check or a Fee Transfer Slip. Most sites utilize fee transfer slips as they are non-negotiable items and facilitate the collection of fees en masse rather than check-by-check. In addition, there is a setup option that can require fee checks/fee slips to have income codes on every detail line; this option is normally on. Regardless of configuration, the Company’s revenue check should be verified on every escrow before checks are printed.

The stub lines display the income codes for each item. On GFE Residential files, most of the income codes are entered during data entry. On rare occasion, a fee item may be entered in a location that does not require a code, so the code will need to be entered on the disbursement detail line. On non-GFE Residential files the codes may be defaulted, but if not they must be entered to the disbursement detail records. All Commercial file title and escrow charges can have their income codes entered during data entry – but they should be confirmed in Disbursements to make sure they are correct. If the Code is blank or incorrect, click on the Code field dropdown for the stub line in question and then select the proper income code. The income Code field is only available for the revenue Fee Check, or Fee Transfer Slip – those items with the “T” payee shortcut (the Company Name of the database) on them. The Liability amounts will be pulled from the data entry, and, if non-zero, cannot be changed on this screen.

![Modify Disbursement Item](image)

Depending on the system configuration, the file’s funds might only be able to be disbursed if the file balance goes to zero ($0.00). If this configuration option is set, Impact will display a pop up dialogue box with a “File balance not = 0” message when funds are left in the disbursement file.

Also depending on the system configuration, it can be required that a reason must be entered explaining why funds are left in the disbursement file upon issuance of the fee check (or fee transfer slip).

Depending on company configuration, the Closing Date and Recording Date can be set automatically when the fee check or fee transfer slip is printed. Alternatively, the Date Closed and Date Recorded fields can be set and modified with the Close File menu option, if enabled for Escrow.
Receipts Tab

The Receipts tab, on the Disbursements screen, is available to the user to check on funds that have been receipted into the file. In addition, the New Receipt icon can be used to enter a receipt from this tab.

When the New Receipt icon is clicked on the Receipts tab, the Receipts screen is presented. See the Receipts > View Receipts > New Receipt section, later in this manual, for details on entering a receipt.

Checks Tab

The Checks tab shows a listing of all the checks previously printed for the escrow file. This tab should be referred to, especially after re-starting Disbursements, to ensure that duplicate disbursements are not attempted. In addition, this tab can be used to void unposted checks. Generally, systems are configured to allow Escrow to void checks on the date of issue, so that errors can be quickly addressed. Generally, systems are configured to require Accounting to void checks older than the date of issue – to assist in enforcing policies on confirming checks being voided, which might be in circulation, are “stopped” at the bank to avoid duplicate payments.

To void a check on this tab, click on the Void icon on the right of the item. When the Void icon is clicked, the Void Check screen opens. The Memo field is defaulted with the text “VOID VOID VOID” but can be edited as Company policy dictates. Click on OK to proceed with voiding the check or Cancel to abort any changes. If the system configuration allows current day only voids, you will only be allowed to Void a check on the date it was originally printed.

The Void All Unposted Checks icon, at the top left of the check listing, can be used to do just that…void all unposted checks that have been issued in one step, rather than individually. This can be a time-saver if many checks were issued and need to all be reworked for some reason.

The Status column will reflect the date a check was voided. If the system is so configured, a voided item can have its void status reversed if the item hasn’t been “cleared” via a reconciliation. The user would click on the Void icon to the right of the item, if available, to reverse the void.

If a check is voided, for whatever reason, then a new check can be issued by selecting New Disbursement, from the Pending Items tab, on the Disbursements screen. Impact does not automatically re-issue an item when a check is voided.
**Wire Outs Tab**

The **Wire Outs** tab show a listing of all outgoing wires that have been processed for the file. This tab should be referred to, especially after re-starting Disbursements, to ensure that duplicate disbursements are not attempted.

The user can click on the **New Outgoing Wire** to create a new wire out from this screen.

See the **Wire Out** section above for further details.

**Receivables Tab**

If the system is configured for the **Receivables** function, the **Receivables** tab will be available. The **Receivables** tab shows all the receivables due on a file, for example, pending loan funds from the lender(s), funds due from the broker, buyer or seller, based on the data entered into the file.

The details on the **Receivables** tab are used on the **Pending Items** tab to reflect the “**Receivables (less Deposited)**” amount in the **Receipts** box. That figure is the total of the receivables less any and all receipted amounts. The “**Receivables (less Deposited)**” amount will also be included when calculating the file balance on the **Pending Items** screen.
Print

The Print icon, in the top left corner of the Disbursements screen, provides for the printing of the Preliminary Disbursement Report, printing of checks and fee slips, and the printing of the Final Disbursement Report.

Preliminary Report

The Preliminary Report option is used to generate a report of what the file’s funding, checks and other disbursements will look like as already completed or when generated based on the existing data. The option will print the Preliminary Disbursement Report, which presents any existing receipts in the file, any receivables (if enabled) and all completed and pending disbursements.

Print Checks

The Print Checks option is used to print checks flagged as ready to print (Status of Check).

When Print Checks is selected, then all the items on the Pending Items tab with Check in the Status column will be printed.

Selecting Print Checks will open the Print Checks screen. The screen will show the Escrow File number, the Bank on which the checks will be drawn, the Escrow Balance, the Number of Checks to be printed, the Disbursed Amount total of the checks that are to be printed, and, if configured for post-dating of checks, a field for the Check Date. If configured for post-dating of checks, the Check Date defaults to show the current date but may be able to be modified so checks can be post-dated up to five (5) days from the Check Date currently displayed. The Check Date field will not display if post-dating of checks is not enabled.
**Disbursement File Overdraft**

Depending on the configuration of the system, it may be possible to create an overdraft situation with the escrow disbursement file. Also depending on a separate configuration option’s setting, if an overdraft occurs, a reason for the overdraft may be required. This reason will be listed on the Overdraft Report created in the Impact Accounting module. The system can also be configured to not permit Escrow to overdraft a file.

The system can be configured to require a password for Escrow to overdraft a file. There are two password options: dynamic and static. The dynamic password process follows a two-step process to get a valid password. First, Escrow generates a “seed number” that must be given to someone using the Accounting module. Second, the Accounting module uses this “seed number” to generate a valid password that can only be used as the password on the current Disbursements screen in Escrow. The password becomes invalid as soon as the Disbursements screen is closed. Alternatively, the system can be configured to use a static password.

**Print Final Report**

The Print Final Report option is used to print the Final Disbursement Report. This report presents all receipts and disbursements processed in a file. It is normally run after the file is fully disbursed, to present a final overview of the accounting activity on the file. Full check detail, including check number, check date and the line items, is presented on the Final Disbursement Report.
Dual Authorization of Disbursements (optional)

There is a system configuration option that provides for dual authorization of disbursements (checks), separate and distinct from the dual authorization of wires outgoing. The option requires one user to create disbursements, and another to approve them, before they can be printed. Users cannot approve their own submitted checks.

On the Disbursements window, once a user has worked up the check(s) they wish to print, they will click on the ➤ Submit arrow at the top of the screen, and the Disbursements screen will close.

At this point, another user in the branch, with Approval authority, will use the Disbursements Pending Approval option, on the Disburse menu, to pull up the Disbursements Pending Approval screen, shown below.

![Disbursements Pending Approval](image1)

On this screen, the View and Approve icon, to the right of each item can be clicked on to pull up full detail on the disbursement. There is an Approve icon on the Check Detail screen; alternatively, the user can check of the checks to approve on the Disbursements Pending Approval screen and click on the Approve Selected icon at the top of the screen.

After items have been approved, they will reflect their approved status, with the Approved, as shown here, and can then be printed.
Create & Print Individual Checks

The Create & Print Individual Checks menu item, on the Disburse menu, is used if one or more checks are to be generated based on data that is not in the system, therefore are not checks that would be generated through the Create & Print Checks function. For example, an escrow file was opened but the transaction is now being cancelled and the Initial Deposit needs to be refunded. If a disbursement file has not already been prepared, the system will open the Disbursements screen with no detailed disbursements. The user will use the New Disbursement icon to create the disbursement. If a disbursement file had already been prepared, and the user responded to not “start over” the existing disbursements would present; if the user responded to “start over” the existing disbursement file would be purged and a blank Disbursements screen presented. The discussion earlier in this manual on the Disbursements screen should be referred to for further details.

Print Final Disbursement Report

The Print Final Disbursement Report menu item, on the Disburse menu, is used to generate the Final Disbursement Report. This report presents all receipts and disbursements processed in a file. It is normally run after the file is fully disbursed, to present a final overview of the accounting activity on the file. Full check detail, including check number, check date and the line items, is presented on the Final Disbursement Report.

Fee Check Invoice

The Fee Check Invoice menu item, on the Disburse menu, is used to generate the Fee Check Invoice Report. The report presents all of the disbursement data entry items (HUD, Worksheet or Settlement Items entry – not checks) tagged with the “.T” payee shortcut (and “.E”, if used) – representing the Company’s fees. The detail on this report should make up the fee check or fee slip balance.
1099-S

The IRS Form 1099-S, if required, is prepared in Impact/SQL and is given to the customer(s) at the time of closing. The 1099-S data is aggregated throughout the year and there is a function in Accounting for preparing the data for submission to the IRS. The 1099-S menu entry, on the Disburse menu, is used to initiate the function for reviewing and/or preparing 1099-S items for distribution. Any escrow may have several Form 1099-S’ created in it, but each Form 1099-S in a file must have a unique Tax ID number assigned to it.

NOTE: If there is not at least one Form 1099-S filled out for a file, and the file is flagged “reportable to the IRS”, the Closing Report (Reports > Closing Report) will show “Not Reported”, in the IRS column.

Selecting 1099-S from the Disburse menu opens the IRS 1099-S Reporting screen, after requesting the file number to be worked with.

The user would click on the New Entry icon to create a new 1099-S item. The first time this is done on a file that is flagged reportable, and where there is a property and a seller defined, the screen that is brought up, after the New Entry icon is clicked, will be populated with the first seller’s information, sales price and the property information. The information should be reviewed for accuracy, and if the sales proceeds and real estate tax figures need to be altered (to split with another seller) they should be. Once the data is correct, the user will click OK to print the 1099-S.
The **Exchange** checkbox is used if the transaction is involved in a 1031 Exchange and that should be noted on the 1099-S when printed.

The **Tax ID Type** options are **SSN/ITIN** (Social Security Number or Individual Tax ID Number) or **EIN** (Employer Identification Number). If the correct flag is not set, it should be altered. Note, however, that the data is coming from the Seller Party data and so if wrong here, should be corrected in the seller’s data as well (changes made here will NOT flow back to the seller data).

If there is not a Tax ID number, but one has been applied for, the **Applied For** checkbox should be checked.

If the **Foreign Person** checkbox is checked, a message will pop up discussing the likely need for a W-8 form and for Form 8288 to be filed.

Checking the **Foreign Address** checkbox will result in the **City**, **State** and **Zip Code** fields being replaced by a **Location** field, into which the proper mailing information can be entered.

If the **HUD Style Entry** was used, and on HUD lines 107-407 county taxes are entered, then the amount will appear on the 1099-S in the **Buyer’s Part of Real Estate Tax** field. Alternatively, if the **Worksheet Style Entry** was used and county taxes are being credited to the seller, then the amount will appear on the 1099-S in the **Buyer’s Part of Real Estate Tax** field.

Once completed, the 1099-S will appear on the IRS 1099-S Reporting screen, from where it can be **Printed**, **Emailed** or **Published** (if so configured), by checking the checkbox in front of the item and clicking on the appropriate icon at the top of the screen. The **Modify** icon can be used to edit the 1099-S and the **Delete** icon can be used to remove it.

The user would click on the **New Entry** icon, at the top of the screen to add another 1099-S, if more than one is required. The screen on subsequent 1099-S’s will be blank when first opened. Clicking on the ellipse (…) button next to the **Name** field will bring up a screen of the **Sellers** in the file. The user can then double click on the party to use for the new 1099-S and all available data will pull to the 1099-S screen. The user will need to enter the **Sales Price** applicable to the new 1099-S, and any tax that should be noted.
Close File

Depending on the Company’s system configuration, the Closing Date and Recording Date may be set automatically when the fee check or transfer fee slip (the :T payee item) is printed. Also, depending on the Company’s system configuration, the Escrow user may have the ability to modify the Closing Date and Recording Date. If Escrow does not have the option available, the Close File menu item will not be presented on the Disburse menu. If it is available, and is selected, a screen like the one shown below will present.

![Close File Image](image)

If funds are left in the file when the user sets the Close Date manually, he/she will be prompted to enter a reason. The reason can be shown on the standard Trial Balance, if that print option is selected. Once the escrow balance is reduced to zero (0), the reason is removed from the standard Trial Balance.

Balance Statement

The Balance Statement menu option, on the Disburse menu, prompts the user for the file to report on and will produce a report of all the Deposits & Credits and Disbursements on the file – from data entered on the file (not ledger data). It also presents all Lender Summaries, to support the lender figures on the main report. Once the report total reflects a zero balance, the file is “in balance”. This report is helpful to identify missing payees on disbursement items. This is a variant of the Preliminary Disbursement report.

Update Reason Funds Held

The last menu entry on the Disburse menu (if Dual Authorization of Disbursements is not enabled) is Update Reason Funds Held. This function will prompt the user for the file number to work with and will then present a screen reflecting the file balance and a Reason field into which the user can detail why there are funds held in the file. This reason can print on a version of the Trial Balance. Typically, the user will have provided a reason when the fee check was disbursed, and a balance was left in the file. This option lets that reason be updated to reflect new information.
Disbursements Pending Approval (optional)

If Dual Authorization of Disbursements is enabled, the last entry on the Disburse menu will be **Disbursements Pending Approval**. This function is discussed earlier in this Disburse menu section, and so will not be repeated here.
Wires Menu (optional)

The Wires menu may contain up to four options, depending on the system configuration and specific user permissions; or it may not appear at all. It will not appear if neither of the options for centralized wire processing are enabled. The four possible options are:

- View Incoming Wires
- View Outgoing Wires
- Approval
- Wire Out Audit Report

View Incoming Wires

Assuming that the Incoming Wires module is made available, through the system configuration, the View Incoming Wires menu option will be available. This option provides a method by which escrow officers can notify a central wire desk of an anticipated incoming wire. Upon receipt of the wire, from the bank, the wire desk can confirm the escrow officer’s notice and the wire will be receipted into the file – and the escrow officer will receive an e-mail notification.

Selecting Wires > View Incoming Wires from the Impact desktop will open the Escrow Number Entry dialogue box. If an escrow is open on the desktop, the entry field will be pre-filled with the current escrow number. See the Escrow Number Entry section for more details on using the Search icon.

The user should click on the OK to open the View Incoming Wires screen, for the escrow number provided. In the screen shot below, there are two anticipated wires that have already been entered. The tools available to the user on this screen will be discussed in the following paragraphs.
The New Incoming Wire icon, at the top of the screen is used to initiate the entry of a new anticipated wire. That screen will be discussed below.

There are up to four icons to the right of each of the previously prepared incoming wires (if any) that are listed in the body of the screen.

The Information icon, when clicked on, will present an Incoming Wire Detail window that displays information on the previously entered anticipated wire.

The Modify icon will only be presented if the wire in is in a pending state (un-confirmed by Accounting). Clicking on the icon will bring up the Incoming Wire entry screen (discussed below) with the previously entered information available for edited. Again, once a wire is confirmed, it will not be able to be modified.

The Delete icon will only be presented if the wire in is in a pending state (un-confirmed by Accounting). Clicking on the icon will bring up a confirmation prompt, asking the user if they are sure they wish to delete the item. Again, once a wire is confirmed, it will not be able to be deleted.

The Print icon will let the user reprint the Incoming Wire Report on the anticipated wire.

**New Incoming Wire**

The Incoming Wires screen has an Entry tab (for a new wire) and a History tab. The History tab presents the same listing of previously entered wires shown on the View Incoming Wires screen but no actions can be taken on them.

The Bank field will be filled with the bank of the file, and will be locked unless there is a zero balance on the file AND there are multiple banks available to the branch of the file. If those conditions are met, the Default Bank for the branch will be pre-selected but the Bank dropdown will be available for the bank to be altered if need be.

The Amount of the wire should be entered into that field.

Additional comments can be entered into the Other Wire Reference field.
The **Sending Bank Information** area is used to enter data on where the wire is expected from. The **Bank Name, ABA and Account Number** fields require some form of data entry. If the user does not know the source bank information, periods or question marks can be entered to satisfy the data requirement. The 🕒 **NAF** can be used to fill the **Bank Name, ABA and Account Number** field, if the bank is properly loaded into the **NAF**. The **Customer Name** field is not required, but the user should know that information.

Once the wire information is as complete as the user can make it, the **OK** button should be hit to send the anticipated wire to the queue in Accounting. **NOTE:** the funds represented by the anticipated wire are **NOT** available for disbursement until the wire is confirmed as received by Accounting.

If an additional wire is to be done, the **Add Another** button can be hit, instead of the **OK** button, and the current wire will be sent to the queue and a new blank entry screen will present for the user to continue with the next wire.

The **Cancel** button can be used to cancel the routine without creating the anticipated wire.

### View Outgoing Wires

The reader is referred back to the discussion of outgoing wires, in the **Disburse > Create & Print Checks** section earlier in this manual for full detail on Outgoing Wire processing under the centralized approach.

This function is very similar in concept to the incoming wire function, discussed just above, but a primary difference is in the treatment of the funds. Whereas in managing incoming wires the funds are not available until approved by Accounting, with outgoing wires the funds are immediately removed from the file when Escrow enters the information about the wire out – before Accounting has really done the wire out and confirmed via the Wires Outgoing queue in Accounting. This ensures that the funds are not wired out a second time, and prevents a check being cut.

In the screenshot above, note the “**Initiated**” indications in the **Status** column. They indicate that the system is configured for **Dual Authorization** of outgoing wires (discussed below). Wires that have been initiated have yet to be approved by an approver, and, therefore, have not yet gone to Accounting for processing. For that reason, the can still be 🖌 **Modified** or ✗ **Deleted**, with the icons on the right.
Approval

There is a system configuration option that provides for a Dual Authorization process on outgoing wires. If enabled, an Escrow user will initiate an outgoing wire, but it will not go to the queue in Accounting for processing until approved by another escrow user, with approval authority assigned to their Impact login initials.

If the system configuration is set for Dual Authorization and the user’s password access is set as a wire out approver the Approval menu option will be presented on the Wires menu. A wire out approver must approve the wire out before the wire out will go to Accounting. A user with approval authority should click on the Approval menu option to bring up the Wire Approval screen (shown below). The screen will present all Initiated wires on files in the branch of the approver.

The Filter box, at the top of the screen, can be used to limit the records presented. It will filter, based on the entry made by the user, on the Escrow No and Customer Name fields. The Clear icon can be used to delete everything entered in the Filter box.

The Information icon, to the right of an entry, is used to pull up the “Outgoing Wire Detail – (file number)” screen, so the approver can review the wire information. No action can be taken from that screen.

The Modify icon, to the right of an entry, is used to pull up the “Wire Outs for Escrow Number #######” screen, which has an Entry and a History tab. The Entry tab will present details on the specific wire. The History tab will present all processed outgoing wires for the file.

The approver should review the wire information, and make any corrections desired, and then use the Approve or Disapprove icons, at the top of the screen to either send the wire on to Accounting for processing, or to send a Disapproved email notice back to the Escrow Officer of the file. The Disapprove action will leave the wire in an Initiated state. The Approve action will bring up the printer control dialog from which the user can print, preview or email the Outgoing Wire Request form, which will reflect the approver’s approval. Once approved, a wire will be removed from the Wire Approval screen.
The **Wire Approval** screen's detail records can be sorted in two ways.

By clicking on a column heading, once for ascending order and twice for descending order, a single column sort can be done. All column headings except for Amount and File Balance can be used to trigger a single column sort.

Using the ![Sort](image) icon, in the upper right corner of the **Wire Approval** screen, will present the **Sort Order** screen through which a more complicated sort pattern can be established. The **Column Names** can be reordered for the sort order (top to bottom) with the ![Move up](image) and ![Move Down](image) icons at the top of the screen. The ![Reset To Default](image) icon can be used to undo any user changes. The user can check the appropriate checkbox for the sorting on the particular column to be **Ascending** or **Descending** order.

---

**Wire Out Audit Report**

The **Wire Out Audit Report** option, on the Wires menu, provides the user with a report of the wires entered and actions taken with them, for the date range requested or for a particular escrow. The report shows the **Escrow Number**, **Date** the wire was entered, **Action** taken on the wire, who the action was **Done By**, the **Amount** and **Reference Number**.
Receipts Menu

The Receipts Menu, in the Escrow module, contains options relating to the receipting and transferring of funds – both for escrow trust accounts and for savings accounts (IBA’s). Depending on system configuration, the menu could have a maximum of four entries on it:

- View Receipts
- Receipt Correction
- Transfer Funds
- Transfer Savings

The View Receipts menu option will always present; the Receipt Correction and Transfer options are configuration dependent.

View Receipts

The View Receipts screen is used to enter receipts, modify unposted receipts, delete unposted receipts (if so configured) and reprint receipts. When first opened, for a file with no prior receipt activity, the screen will be largely blank, as shown below. Note: the Error Correction and NSF items will only appear for Escrow users if the system is configured to allow Escrow to use those functions. The assumption here is that they can. While the initial receipt of earnest money may be made from the Initial Questions screens, most receipts will be entered through this menu option.

![Receipts Menu](image)

The Change File icon, at the top left of the screen, is used to switch the file to be worked with.

The New Receipt icon is used to bring up the Receipts screen, for the selected file, the number of which is just below the icon.

The Date field will default to the current date and be locked.

The Type field will default to Escrow Trust and will be locked unless a savings account has been added to the file. If there is one, or more, savings account, the Type field will open up and the user can select Savings if a receipt related to a savings account is to be entered.

The Bank field will default to the bank of the file, if Escrow Trust is selected in the Type field. If the file has a zero balance, and there are multiple banks available to
the branch of the file, the user can select the bank to be used. If there is a balance on the file, the bank cannot be changed. If the **Type** field is **Savings**, the **Bank** field will present a listing of all of the available savings accounts for the file, and the user should select the correct account for the receipt being entered.

The **Payor** field can be used to enter information on the source of the funds. This field will present on the **Ledger**, so entering a good description is important.

The **Escrow Name** field will default to the last names of the first buyer and seller, separated by a slash (/). It can be edited to enter alternate information if so desired.

The **Receipt Type** field will present two different lists, depending on whether **Escrow Trust** or **Savings** is selected in the **Type** field. The user should select the appropriate **Receipt Type** from the dropdown list. While most of the receipt types are common across databases, sites can have different receipt types; there is not a static set. Users should select **WIN** if entering an Incoming Wire (if not using the Wire Processing function). Note: some receipt types are set as “depositable” and some are not. It is important that if the user has a physical item in hand, that will be taken to the bank in a deposit, that a depositable receipt type be used when entering the receipt for the item. If not, the receipt will not appear on the **Deposit Slip** screen to be able to be included in a deposit; the item will present directly in the bank reconciliation if entered with a non-depositable receipt type.

If the user has selected **Savings**, in the **Type** field, the only two receipt types that will appear are **SAV** and **INT**. These two receipt types are used to reflect savings balances being entered into or taken from a savings account – with a positive or negative amount on an **SAV** receipt – and to record interest paid on a savings account – with an **INT** receipt. These two receipt types will only enter or remove dollars from a savings ledger. An **STF** (Savings Transfer) receipt would be used on the corresponding escrow ledger receipt to reflect dollars going to or coming from a savings ledger. Normally, the **Savings Transfer** function (described later in this **Receipts** section of this manual) would be used to eliminate the need for doing two receipts (one out of escrow and one into savings, or vice versa) to track savings activity.

The **Receipt Number** field will auto-fill and is locked.

The **ABA Number** field can be used to enter routing information on the receipted item, if so desired.

The **Receipt Amount** field is used to identify the amount being receipted.

If the funds being receipted should be considered “on hold” – as they may not be good funds or for some other reason – then the **On Hold** checkbox should be checked. Only Accounting users can release a hold on a receipt.

Once completed, the user should click on the **OK** button to finalize the receipt. The user will be presented with a printer control window through which they can print, email or publish the receipt. Most sites have a multi-copy receipt report template so they can print a copy for the customer and one for their file (and maybe a copy for Accounting). The **Cancel** button can be used to exit without generating a receipt. The **Add Another** button will save the receipt and present the **Receipts** screen for entry of another receipt.

Once the receipt has been entered and printed, the **View Receipts** screen will present, showing the item(s) that have been entered on the file.
The first column, **Status**, will reflect whether the receipt has been posted or not. Once posted, a receipt cannot be modified.

The ☰ **Information** icon will bring up the **Receipt Detail** screen, on which information about the receipt is presented.

The ✒ **Modify** icon is used to bring up the receipt for editing. If the receipt is not able to be edited by the user, the ✒ **Modify** icon will not be presented.

The 🌐 **Print** icon is used to bring up the **Print** control screen, from which the user can reprint the receipt, or preview, email or publish the reprint of the receipt.

If the system configuration allows for it, the ✗ **Delete** icon will present, when applicable, allowing the user to delete the receipt. Few sites permit receipt deletion, as they want to retain all sequential receipt numbers. If the user cannot delete the receipt, but wishes for it to reflect $0.00, they can ✒ **Modify** it and change the amount to $0.00.

The 📋 **Error Correction** icon will present at the top of the screen if the system is configured to allow for its use by Escrow, and be enabled if the highlighted receipt can have a correction made for it. Clicking on the 📋 **Error Correction** icon will bring up the **Error Correction Receipt** screen on which the user can enter information in the **Payor Name**, **Escrow Name** and **ABA Number** fields, if desired, and can enter the CORRECTION amount in the **Receipt Amount** field – positive or negative. The net amount should NOT be entered, just the amount of the correction. The correction item will be given the same receipt number as the original.

The ⚓ **NSF** icon will present at the top of the screen if the system is configured to allow for its use by Escrow, and will be enabled if the highlighted receipt can have an **Non-Sufficient Funds** receipt made for it, offsetting the original – reflecting the originally deposited item was rejected by the bank. If clicked upon, the **Non-Sufficient Funds** screen will present with the information from the original receipt, with the **Payor** and **Escrow Name** fields available for editing (so the user can indicate the original was returned by the bank). Once OK’d, the detail presented will have an offsetting dollar amount from the original. While the original item remains editable, only the **Payor** and **Escrow Name** fields can now be edited – again, so the return can be detailed. The Escrow Officer on the file will receive an email about the NSF, so they can pursue good funds for the file.
Receipts – Some Common Situations

There are several common situations involving receipts. Some of these are discussed below, with the steps that should be taken to correct an error situation or to complete a receipting process.

Scenario 1: A receipt was entered into the wrong file, but has not been deposited or posted, and deleting is not available.

- **Receipts Menu**
- **View Receipts**
  - Enter the file number into which the erroneous receipt was entered
  - Highlight the receipt to be edited
  - Click on the **Modify** icon
  - Enter a zero, “0”, into the **Receipt Amount** field
  - Enter “Entered in wrong file” in the **Payor** field
  - Click on **OK** to save the change
  - Then use the **Change File** button and enter the correct file
  - Create a new receipt in the proper file

- **Or** if **Transfer Funds** feature is available, use it to move the funds from one file to the other (see **Transfer Funds** below).

**NOTE:** If the original receipt has already been included in a deposit, the deposit will need to be voided before you can edit the amount, then the deposit will need to be rebuilt, with the new receipt.

**NOTE:** If the receipt has already been posted, use two new receipts to detail the movement of funds from one file to another; use a negative amount on one, positive on the other.
Scenario 2: A receipt was entered for the wrong amount, but has not been deposited or posted.

- Receipts Menu
- View Receipts
- Enter the file number into which the erroneous receipt was entered
- Highlight the receipt to be edited
- Click on the Modify icon
- Correct the Receipt Amount of the receipt
- Click on OK to save the change
- Print the corrected receipt

**NOTE:** If the receipt has already been included in a deposit, the deposit will need to be voided before you can edit the amount, then the deposit will need to be rebuilt, with the corrected receipt.

Scenario 3: A receipt was entered for the wrong amount, and has been posted.

- Receipts Menu
- View Receipts
- Enter the file number into which the erroneous receipt was entered
- Click on the New Receipt icon
- Enter the details for an adjusting receipt (positive or negative amount as needed). Should use non-depositable receipt type (ADJ, for example), as this item will not be “going to the bank”, but needs to show up in the reconciliation on its own.
- Click on OK to save the new receipt
- Print the new receipt
**Receipt Correction**

The Receipt Correction feature is a setting only applicable to companies that fall under the jurisdiction of the California Department of Corporations (DOC) – that is “escrow only” companies, in California. The regulatory requirement is that if funds are receipted into an escrow file, and it is determined at a later date that the funds should have been entered into a different file, correcting receipts *with the same receipt number on each* are to be entered into the original file (with a negative amount) and into the correct file (with a positive amount). The option is enabled, by the System Admin, through Setup Options, in Utilities.

The **Receipt Correction** menu option, on the **Receipts** menu, automates the procedure by allowing the user to answer a few questions (original escrow number, original receipt number, and new escrow number) and then the system will automatically generate the needed transfer receipts.

The user should enter the original escrow file number in the **From Escrow Number** field and enter the original receipt number, that corresponds with the original escrow file number, in the **From Receipt Number** field. They should then enter the correct escrow file number in the **To Escrow Number** field. Click on **OK** to continue.

Impact will display a prompt asking for confirmation of the request to do the receipt correction. Confirming the request will have Impact generate two receipts, with a receipt type of **RCT**, with the original receipt number, showing funds taken out of the original file number and being credited to the new file number.

Impact will allow a receipt correction on files in different branches as long as both files are assigned to the same bank. If the **From escrow number** and the **To escrow number** are in different bank accounts, Impact will display a prompt that the files are not assigned to the same bank and will not let you do a receipt correction. The user would need to have an Accounting user do a negative receipt out of the original file and a positive receipt into the correct file. If the funds were deposited in the bank they will have to be transferred from the incorrect bank to the proper bank.

The **Receipt Correction** function will **not** allow an overdraft to be created in the originating file. Impact will display a prompt that the correcting receipt will cause an overdraft and not let the user do a receipt correction.

It is also not possible to do a receipt correction on a receipt multiple times. Impact will display a prompt saying a correction has already been entered for the requested receipt number. If the correction was done to the wrong file, Accounting will need to create two receipts, one for a negative amount out of the originating escrow and one for a positive amount into the correct escrow.
Transfer Funds

The Transfer Funds option, if available, will appear on the Receipts menu. The function makes it easier to transfer funds between escrow files that share the same bank than having to go through the routine of entering two receipts separately (one negative in one file and one positive in the other). The Transfer Funds function will create a negative receipt from the originating escrow file and a positive receipt into the new file with two separate receipt numbers assigned. Impact will allow transferring funds from a file in one branch to a file in another branch as long as both files are assigned to the same bank.

To transfer funds from one escrow to another, the user would enter the originating escrow number in the From Escrow Number field and the new file number in the To Escrow Number, enter the dollar amount of the transfer in the Transfer Amount field and enter the Reason for Transfer in that field. The Reason for Transfer will appear on the escrow ledger. The user should click on OK to proceed or click on the Cancel button to abort transfer of funds.

If the From Escrow Number and the To Escrow Number are in different bank accounts, Impact will display a prompt that the files are not assigned to the same bank and not let the user do the transfer. The user would need to have an Accounting user to do a separate negative receipt out of the original file and a positive receipt into the correct file. If the funds were deposited in the bank Accounting will have to notify the bank and transfer funds from the bank on the source file to the bank on the target file.
**Transfer Savings**  

The **Transfer Savings** option, if available, will appear on the **Receipts** menu. This function makes it easier to transfer funds between the escrow ledger and a savings ledger on a file than having to enter multiple receipts – one to take funds out of the escrow ledger and one to put funds into the savings ledger.

When invoked, the function will ask the user for the file number involved in the transfer.

A savings account must already exist on the file before the **Transfer Savings** function can be used. If the function is invoked and the file requested does not have at least one savings account tied to it, the user will receive a message stating that fact.

If there is at least one savings account on the file, the user will be presented with the screen shown here.

![Transfer Savings Screen](image)

The **Escrow Balance** is presented at the top of the screen, just below the boxed file information.

The radio buttons just below the Escrow Balance are used to identify if the transfer is sending money **To Savings** or pulling money **From Savings** – the appropriate option should be selected.

If there is more than one savings account, and the one involved in the transfer is not presented in the **Savings Account** field, the user should use the dropdown to select the appropriate savings account.

The **Savings Balance** of the savings account is presented just below the **Savings Account** field.

The user should enter the **Transfer Amount** in that field, and should provide an explanation of the transfer in the **Reason for Transfer** field.

The user should click on the **OK** button to execute the transfer or **Cancel** if it is decided not to continue.
Documents Menu

The Documents Menu contains functions for the generation of Escrow documents and the printing of Title Instructions, Prelims/Commitments, HUDs, Settlement Statements and the Legal Description. In addition, the maintenance of master documents is managed from this menu, with the appropriate permissions. The Documents Menu may contain up to eight options, depending on the user’s access level. The eight options are:

- Select & Edit Documents
- Title Instructions
- Prelim/Commitment
- HUD
- HUD-1A
- Settlement Statements
- Legal Description
- Document Maintenance

Select & Edit Documents

The Select & Edit Documents menu option is used to prepare and distribute the various escrow documents created for any file. The documents are edited within Microsoft Word, in a controlled Word window, from copies of “Master Document” templates. Users can give specific file copies of documents unique names, for versioning purposes or to distinguish unique versions of a common document, for multiple recipients, for example. Existing documents on a file can be printed without going into the document, and they can be published to a document management system (if so configured), or emailed directly from within Impact. The Escrow document masters are customized per company, and the document menu can be arranged as the business wishes.

Selecting Select & Edit Documents from the Documents menu, or clicking on the Select Edit Documents toolbar shortcut, opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter The Escrow Number field will be pre-filled with the current open escrow number. If the field is blank, or the user wants to work on documents for another file than that pre-filled, the correct file number should be entered and OK clicked to continue to the Escrow Document Menu. The Search icon is available on the off chance the file number desired is unknown. The Cancel button should be clicked if the request to edit documents was in error.
Escrow Document Menu

A sample of the Escrow Document Menu that is presented to users is shown in the screen shot below. Again, the document menu is unique to each Impact database. When initially opened, the menu is presented in “collapsed” mode, meaning only the document section headers are presented, not the full listing of documents. Clicking on the boxed plus sign, in front of a section header, will expand the document menu for that section, displaying all of the master documents available within it.

At the top of the screen are icons that the user can use to either 📝 Change File - to work on documents for a different file than the one currently selected - or to show the ☰ File Document List – which is a listing of document already worked up for the selected file (discussed more later).

In the boxed area near the top of the screen, the Escrow File #, Escrow Officer and Branch of the file are presented.

The Filter: field is used to quickly limit the listing presented to documents whose master document name contains the content entered in the Filter: field, along with the section header of the section the documents are in, or, if the entered text is in a section header, the section header and all items within the section. Some experimenting, by the user, will help familiarize them with the filtering mechanism. The ✂ Clear icon is used to quickly clear out the Filter: field of any entered content.

A bold section heading indicates that there is at least one document already prepared for the file selected, from a master in the section whose heading is bolded (as demonstrated above with the Miscellaneous Documents [1] heading). The number in brackets after the bolded section heading indicates the number of documents from that section that have been prepared for the selected file.

The ☺ icon, in the upper right corner is used to close the Escrow Document Menu.
To create a new document, the user will expand the document section the master document is in, or will use the Filter: field to expose the document masters whose names contain the filter’s content, and then the user will double-click on the document master name from the list being presented. If the listing being presented is very long, the scroll bar on the right can be used to move through it…or the Filter: field contents can be altered to narrow the presented listing.

In the example below, the Affidavits section of the menu has been expanded and the “Affidavit – Not Same Person” document master has been highlighted (with a single click on the name).

When the user double-clicks on the name, to signal that a new document, of that type, for the selected file, is to be created, the system will present the Document Title screen. The user can then either give their copy of the document, prepared just for the selected file, a new title (in the sample “- Buyer 1” was added to the title), or may simply click on OK to continue. See the Edit Documents section below for details on how to edit the document in Microsoft Word. If the wrong document was selected, clicking on Cancel will stop the document from being prepared, and return the user to the Escrow Document Menu.

The Document Title entered in the title field (above) will be displayed when the File Document List icon is clicked to open the File Document List screen, which lists all the documents created for the escrow file. This name will help you identify the unique document when editing it in the future, so you may want to edit the name presented for ease of future referencing. If there are no documents prepared for a file, the File Document List icon will not be enabled.

There are optional editable HUD and Settlement Statement Excel templates that can be installed on the Escrow Document Menu. Contact USA Digital Solutions Support for more information on these.

There is a background service that can be utilized to automatically delete escrow documents after a preset number of days after last editing, as wished by the Company.
**File Document List**

The *File Document List*, when requested, will present a screen like the one shown here, presenting all of the documents that have already been created for the selected file.

![File Document List](image)

The user can click on the column headers to sort the listing of documents by that category (either **Description**, **Date Created** or **Date Changed**) in ascending order; an additional click on the same header will flip the sort to descending order.

Across the top of the File Document List, there are four icons that may be available, depending on system configuration.

- **Print Selected**, to print the checked documents
- **Email Selected**, to email the checked documents (discussed below)
- **Delete Selected**, to delete the checked documents
- **Publish Selected**, to publish (to a document management system, if available)

To utilize these functions, the user will check the checkbox in front of the document(s) on the list that they wish to print, email, delete or publish and then click on the appropriate icon. Multiple documents can be checked.

On the right of each listed document, there are two icons:

- **Modify**, to open for editing the specific document
- **Rename**, to open the Document Title screen for the specific document

The user should click on the icon next to the document they wish to edit or rename to execute those actions.
**Email Selected**

If the user clicks on the **Email Selected** icon, after checking one or more documents on the list, the **Email Options** screen will be presented to them, as shown below. All parties to the file will be listed on the screen and the user can check which to include as addressees on the email, and whether they should be a primary addressee or a "cc" addressee. Depending on system configuration, the user may also have the choice of sending the attachment(s) in Word form or in PDF form; and, the user may be able to alter the password protection on the attachment(s), if sent in Word form.

![Email Options Screen](image)

Once the recipient(s) has been selected, and Attachment Options set (if any), the user should click on **OK** to start the email routine.

Click on **Cancel** if the emailing should not be done, to return to the **File Document List** screen.
**Publish Selected**

If the system is configured for use of a document management system like SmartVIEW, ePaperless or Impact Online the user will see the Publish Selected option. To use the function, the user would check the document(s) to be published and then click on the Publish Selected icon.

Each document management system will present different screens to the user at this point, but generically, the user would usually identify the name on the document to be published, the location it should be published to, and, possibly, the parties who have permissions to view the document in the document management system.

If multiple document management systems are available, the user will be presented with a screen asking which of the systems are to be published to; more than one can be selected at the same time.

**Creating a New Document from a Menu Item**

Once the user has located the document they wish to create on the Escrow Document Menu, they should Double-Click on the Description of the document. Impact/SQL will open the Document Title dialog box on the screen (if there is not already a document of the selected type on the file). If there is a document of the selected type on the file, a screen will present from which the user can select the existing document to edit, or can click on the New icon to create a new file of the type selected.

![Document Title Dialog Box](image)

The user should type a description for the document they are about to create in the Enter a title for this document field. They can keep the default description or type anything they wish to make it fit their purposes (up to 100 characters). They should Click OK to create the document when they are ready.

Click the Cancel button to return back to the Escrow Document Menu without creating a document.

Impact/SQL will create a copy of the document for the user to work with and then open the document in Microsoft Word. A typical document is shown below.
Impact/SQL documents are color-coded to make working within them easier. Any field that pulls information entered into the Initial Questions area in the database is colored red. If the information displayed in red is not accurate, the user should return to the Impact/SQL desktop and correct the data in the Initial Questions area. The information will be corrected when you re-open the document. This insures ALL documents that you create will have the correct information.

The Fill-Ins fields in the document are represented by blue square brackets separated with non-breaking spaces such as `[]`. (The user will not see the small o’s between the brackets unless the MS Word option to show paragraph markers is turned on.) These Fill-In fields allow the user to type information that is not stored in the database and is unique to the document. The user should press F11 or CTRL-1 or click on the Next Fill In icon, in the ribbon bar, to move from Fill-In to Fill-In until all the information has been typed. Once Impact/SQL reaches the bottom of the document, it will return the cursor to the top and start the search for a Fill-In field once more.
**SmartTags vs. DDE Fields**

As the newer versions of Impact/SQL have been released, the document masters have begun the switch to using SmartTags to pull information from the database into MS Word documents. The majority of the documents in the Escrow module are setup to pull the database information into the document by using DDE fields. As Impact/SQL document masters advance over time, users will start to see more of the documents they create open up to the Data Selector dialog box shown below.

With the use of SmartTags in the documents, a Document Administrator has a lot more flexibility when designing documents. In the case of the example shown here, one letter was created that could be used for the Buyer or for the Seller on the Escrow Order Number. There isn't a need to have two separate documents.

When the user creates a document that has SmartTags used in the master document, the Data Selector window will have a one or multiple drop-down choices. The prompt next to each choice is worded to help the user determine which party should receive the document. There may be more than one choice.

**Unused Field Options**

The Unused Field Options area of the Data Selector is used to tell Impact/SQL how to treat the SmartTags when the user is not sure which option to select from one of the drop-down fields.

The Change to fill ins radio button will remove the SmartTag field from the document and replace it with a Fill-In ("\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldots\ldot
Impact/SQL adds functionality to Microsoft Word through the Impact/SQL toolbar (ribbon) at the top of the documents. The user can click on any function they need on the toolbar using the mouse or can use the keyboard shortcut key. The table below explains each item shown on the Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool Name</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Fill in</td>
<td>Next Fill-In</td>
<td>CTRL-1 or F11</td>
</tr>
<tr>
<td>DDE</td>
<td>Insert DDE Field</td>
<td>CTRL-2</td>
</tr>
<tr>
<td>Clause browser</td>
<td>Clause Browser</td>
<td>CTRL-3</td>
</tr>
<tr>
<td>NAF Date</td>
<td>Name and Address File</td>
<td>CTRL-N</td>
</tr>
<tr>
<td>Checked box</td>
<td>Insert Checked Box</td>
<td>CTRL-5</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Insert Checkbox</td>
<td>CTRL-6</td>
</tr>
<tr>
<td>Checkmark</td>
<td>Insert Checkmark</td>
<td>CTRL-7</td>
</tr>
<tr>
<td>Degree</td>
<td>Insert Degree</td>
<td>CTRL-8</td>
</tr>
<tr>
<td>Autotext</td>
<td>Insert AutoText</td>
<td>F3</td>
</tr>
<tr>
<td>Addressee</td>
<td>Select Addressee</td>
<td>CTRL-4</td>
</tr>
<tr>
<td>Signatures</td>
<td>Insert Signatures</td>
<td>ALT-3</td>
</tr>
<tr>
<td>Exceptions</td>
<td>Insert Exceptions</td>
<td>ALT-5</td>
</tr>
<tr>
<td>Change case</td>
<td>Change Letter Case</td>
<td>SHIFT-F3</td>
</tr>
<tr>
<td>Date to text</td>
<td>Insert Date as Text</td>
<td>CTRL-0</td>
</tr>
<tr>
<td>Date spelled</td>
<td>Insert Date Spelled Out</td>
<td>CTRL-9</td>
</tr>
<tr>
<td>Button</td>
<td>Tool Name</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>$</td>
<td>Dollar Amount to Text</td>
<td>ALT-1</td>
</tr>
<tr>
<td>☑️ Format phone</td>
<td>Format Phone</td>
<td>ALT-2</td>
</tr>
<tr>
<td>📄</td>
<td>Show/Hide Headers and Footers</td>
<td></td>
</tr>
<tr>
<td>🛠️ Tools</td>
<td>Tools</td>
<td></td>
</tr>
<tr>
<td>🌐 Print</td>
<td>Print</td>
<td>CTRL-P</td>
</tr>
<tr>
<td>🍃 Email document</td>
<td>Email Document</td>
<td>CTRL-SHIFT-M</td>
</tr>
<tr>
<td>📝 Information</td>
<td>Information</td>
<td>CTRL-SHIFT-A</td>
</tr>
<tr>
<td>✅ Save Document</td>
<td>Save Document</td>
<td>CTRL-S</td>
</tr>
<tr>
<td>🔄 Save and Return to Impact/SQL</td>
<td>Save and Return to Impact/SQL</td>
<td></td>
</tr>
</tbody>
</table>
**Mandatory Fill-In Fields**

A document may have Fill-Ins that require the user to provide an answer before they can save or print the document. These are called **Mandatory Fill-Ins**. They will appear in the document as the same blue square brackets except they also include an asterisk, as in [*][*]. If the user tries to print or exit the document without providing information for this field, Impact/SQL will display the warning shown to the right.

**CLICK** the **Yes** button to continue on with the requested command (print, save, etc.).

**CLICK** the **No** button to cancel the previous request that was made. Impact/SQL will relocate the cursor to the Mandatory Fill-In where the missing information can be entered.

**Phraseboxes**

**Phraseboxes** are a special type of Fill-In field that may be used in documents. When F11 or CTRL-1 are used to move through the document and land on a *[phrasebox=*] Fill-In, a window will pop up with a list of options the user can choose from which will be inserted into the document at that location. The Document Administrator might use these to give the user a list of attachments which could be mailed out with the document, for example. It is then up to the user to **CLICK** on which item(s) they will be including with the letter. After they have made the desired selection(s), they should **CLICK** the **Insert** button. The phrasebox will be replaced with the items selected.

If the user sees square boxes, as shown in the sample phrasebox above, they can pick as many options as they would like to have appear in the document. If the user sees circles, they will only be able to choose one option.

**Insert DDE Field**

The **Insert DDE** tool opens the **Insert Field** dialog box (shown at the right). Each tab shows a list of the available database fields that the user can insert into a document at the cursor’s location.

Position the cursor at the location in the document where a DDE field’s information should be inserted.

Press CTRL-2 (or **CLICK** on the **DDE** tool) to open the dialog box.

Select the appropriate tab and highlight the field to insert into the document at the cursor’s location.

**CLICK** the **Insert** button (or **DOUBLE-CLICK** on the field name).

**CLICK** the **Cancel** button to close the **Insert Field** window.

**NOTE:** This dialog box will remain on the screen until the user closes it giving them the opportunity to insert several fields if necessary. If the user wants to leave the **Insert Field** window open to insert fields in different locations of the document, they must **CLICK** in the document to change focus from the **Insert Field** window to the document window in between inserting the separate fields.
The user can also use the Inset DDE dialog box to double-check what information Impact/SQL has in the database for a field. In the example Insert Field dialog box above, the Company Name field is currently highlighted. At the bottom of the dialog box USA Digital Solutions, Inc. is listed in red. This is the value that the user will see in the document if they were to insert this particular field. If the information is not correct, the user should return back to the Impact/SQL desktop to correct the information in the file data – to make sure the file data is current. Changing a field’s content by typing over it in a document will NOT change file data.

**Clause Browser**

Escrow clauses are frequently-used snippets of text that can be placed into any document the user creates. These are typically a paragraph in length but can range from a sentence to pages. The clauses installed on the system are available to all staff. The Clause Insertion dialog box is shown here at the right.

1. Position the cursor at the location where you want to insert an Escrow clause.
2. **CLICK** on the Clause Browser tool (or press CTRL-3).
3. Type the name of the clause in the Browser field. You can list as many clauses as you wish here by separating them with a comma.
4. **CLICK** the Insert button to place the clauses into the document.

The **Browse** button will expand the Clause Insertion dialog box to include a list of the available clauses. If the user **CLICKS** on a clause name, they can see a preview on the right side of the window.

**NOTE:** the Escrow Clauses seen on the Clause Insertion window of a particular site will be different than what is displayed here.

**DOUBLE-CLICK** on any clause name to have Impact/SQL insert the clause name in the Browser bar.

Once all the desired clauses for insertion are listed at the top of the window, **CLICK** the Insert button.

**CLICK** the Cancel button to close the Clause Insertion window without inserting any clauses.
NAF (Name and Address File)

The Name and Address File (NAF) is available to be used within Escrow documents. The user can insert the address and contact information into a document without having to make the individual a party to their Escrow File. Impact/SQL will open the Name and Address File window shown here.

1. The user should position the cursor at the location in the document where they want to insert a name and address from the NAF.
2. Press CTRL-N (or CLICK on the NAF tool).
3. Select the search criteria on the left side of the Name and Address File window.
4. Highlight the selection that is to be used in the results window. Verify on the right it is the correct individual and/or company.
5. CLICK the Use button at the top of the window (or DOUBLE-CLICK on the Company name in the results window).

Impact/SQL will close the NAF window and insert the address information at the cursor's location in the document. It will appear in similar form to the sample shown below.

First American Flood Data Group  
100 E. Washington St.  
Suite 300  
Phoenix, AZ 85001

NAF Use Special

The user also has the option to select which name and address information, from the NAF, is placed into their document. In those cases, replace Step 5 above with the Use Special button.

The NAF Use Special window is shown here on the right. CLICK on any of the radio buttons shown to include that information in the document.

Optionally, the Document Administrator may have used additional NAF fields to customize documents.
**Insert Date**

The **Insert Date** tool will insert the current date at the cursor’s current location as if the user had typed it him or herself. This is not an updatable field. The date is inserted in the format of “July 18, 2013”. Alternatively, the user can press CTRL-5 to insert the date as text.

**Insert Checked Box**

The **Checked Box** tool inserts the ☑ symbol at the cursor’s current location. There are numerous documents that include the [☑] Fill-In. This tool is very handy to indicate a chosen selection in those lists. Alternatively, the user can press CTRL-7 to insert the checked box symbol.

**Insert Checkbox**

The **Checkbox** tool inserts a blank square box at the cursor’s current location. The user can use this tool to replace a checked box that might have been inserted via the **Checked Box** tool if it was selected by mistake or if the information in the document has changed. Alternatively, the user can press CTRL-6 to insert the blank checkbox symbol.

**Insert Checkmark**

The **Checkmark** tool will insert the checkmark character, ✓, at the cursor’s current location. Alternatively, the user can press CTRL-8 to insert the checkmark symbol.

**Insert Degree**

The **Degree** tool will insert the degree symbol, °, at the cursor’s current location in the document. Impact/SQL has remapped the keyboard so pressing the ` (back apostrophe) key will also insert the degree symbol.

**Insert AutoText**

The **AutoText** tool will insert an **AutoText** entry into the document at the cursor’s current location. AutoText are snippets of text that are stored in the users UserID profile. The options that a user may have available to them may not be the same options that their co-workers have unless the organization is using the global AutoText feature of Impact/SQL. There is a more detailed discussion about using a Company-wide AutoText solution later in this chapter.

1. Place the cursor at the location in the document where an AutoText entry should be used.
2. Type the name of the AutoText entry and then press F3 if MS Word doesn’t prompt to include the phrase as shown to the right.

Impact/SQL will replace the AutoText name with the contents of the entry.
The **Addressee** tool pulls up the **Insert Addressee** dialog box. This dialog box displays all the parties to the selected escrow file that were entered in the **Initial Questions, Parties** screens. Each tab at the top of the screen represents the party types. Each will list parties of that type that can be selected for use in the document.

**IMPORTANT NOTE:** Each party that the user checks in the **Use** column will have a copy of the document produced for it. In other words, if the user creates a one page letter and checks three parties, then Impact/SQL will copy the document three times creating a letter for each party. The result is a three page document in Impact, that is really three separate letters, when all is said and done.

With the above in mind, if the document created is 15 pages long and three parties are checked, the end result will be a 45 page document—one 15 page document for each party.

**Grouping Addressees Together**

The user can group two or more parties together on the same document by assigning them the same 3-digit number from the drop-down menu in the **Group** column. The user can mix and match between individual parties and groups of parties in the same document. The user cannot, however, group parties on separate tabs. In other words, all members of a group must appear on the same tab.

If there is a need to create more than one grouping in the document, assign each group its own number from the drop-down menu. For example, if there are 4 buyers (2 husband and wife parties) and the desire is to send one letter to both couples, all 4 individuals would have a checkmark next to their individual names under the **Use** column; and, the first couple would be assigned Group 001 and the second couple would be assigned Group 002.

1. Position the cursor where the address information should be inserted.
2. **Click** the **Addressee** tool.
3. **Click** in the **Use** column next to each party to receive their own copy of the document on the screen.
4. Setup any groups of parties under the **Group** column.
5. **Click** in the **FWD** column to have the forwarding address be used for that party (only available on the **Buyers** and **Sellers** tabs).
6. **Click** the **Do Not Use Address Information** checkbox, at the bottom of the screen, to have only the names of the parties included in the document.
7. **Click** the **Insert** button to have the names and addresses placed into the document—creating one set for each individual and/or group.

**NOTE:** You can **click** the **Cancel** button to return to your document without inserting any addressing information in your document.

**NOTE:** If an individual is missing from the **Insert Addressee** window, return back to the **Parties** screen under **Initial Questions** to verify they have been entered into the database for your Escrow File #.
The **Signatures** tool helps the user design a signature table for their document that will fit exactly what they need every time. The **Signature Table** window is shown here at the right. When you **Click** the **Signatures** tool, Impact/SQL will populate the top half of the window with the number of **Buyers** and **Sellers** that are currently listed on the **Parties** screen. The 3rd and 4th options give the user the option to place the Buyers’ signatures on the right or left side of the table. Only one of the 4 configurations listed can be selected.

**Click** on the **Include an area for dates** option to have Impact/SQL create a space for the signatory to include the date they signed the document.

**Click** on the **Add BUYER: or SELLER:** to have Impact/SQL place a heading over the signature areas for the appropriate party type.

After the appropriate options are selected on the **Signature Table** window to meet the requirements for the document, **Click** the **Proceed** button to have Impact/SQL create the signature table. Using the sample **Signature Table** settings show above, Impact/SQL will create a table similar to that shown below.

![Sample Signature Table](image)

**Removing the Signature Table**

Once Impact/SQL creates the table, it represents a snapshot of the number of buyers and sellers that existed in the escrow file at the time the document was created. If any buyers or sellers are added or deleted, at a later date, the user must delete the existing signature table from the document and recreate the signature table.

The easiest way to delete the table is by moving the mouse over the top of it until the **Table Move Handle** presents (see red circle on the right, above the **BUYERS** heading). Once the **Table Move Handle** appears, **Click** on it to select the entire table. The user can then **Click** on the **Layout** ribbon bar tab at the top of the MS Word window then **Click** on the **Delete** tool, and select **Delete Table** from the submenu. Be sure to **Click** the **ImpactSQL** ribbon bar tab to return back to Impact/SQL’s toolbar.

NOTE: If the document is not complicated, it might be easier just to delete the entire document and recreate it.
**Insert Exceptions**

Normally title and escrow documents don’t “talk” to each other. The user can, however, use the Exceptions tool to have Impact/SQL place the prelim/commitment’s exceptions into the document at the cursor’s current location.

1. Position the cursor where the Exceptions are to be inserted.
2. **CLICK** on the Exceptions tool or press ALT-5.
3. Type the exceptions numbers to be inserted in the Exception Numbers field. “All” can be entered, or numbers separated by commas, or a range with a hyphen.
4. **CLICK** the Open Prelim/Commitment as XXX.doc button to open up a copy of the prelim and/or commitment on the screen to review the existing exceptions before inserting them into the document.
5. **CLICK** the Insert button to copy the designated exceptions.

**NOTE:** **CLICK** the Cancel button to close the Insert Exception(s) dialog box without inserting any exceptions into the document.

**Not yet Released**

If the user **CLICKS** the Exceptions tool and sees the dialog box shown here at the right, the Title Department has not yet released the preliminary report or commitment yet. **CLICK** the **OK** button to remove the notice from the screen. The user will need to contact the Title department to find out when the prelim/commitment may be ready.

**Change Letter Case**

The Change Letter Case tool will rotate through making selected text all lowercase letters, title case letters (first cap), or all uppercase letters.

1. Select the text to modify by blocking it.
2. **CLICK** the Change Letter Case tool (or press SHIFT-F3) to move through each option until the form desired is presented.

The Change Letter Case tool is not a substitute for text that needs to always be presented in UPPERCASE. The Change Letter Case tool applies the All Caps attribute to the selected text which is just like applying **Bold** or **Italics**. If the text is subsequently imported into another document that applies its own formatting, the text will return back to the original way it was entered from the keyboard. Use the CAPS LOCK key to make sure text that needs to be typed in UPPERCASE remains in UPPERCASE.
**Insert Date as Text**

The **Date to Text** tool converts a numeric date into a long date format. For example, 07182013 is converted to read 18th day of July, 2013. Note that the date is entered in “mmdyyyy” or “mmddyy” format, without dashes or slashes. The cursor must be located at the end of the date entry that is to be converted before CLICKING on the **Date to Text** tool (or pressing CTRL-0). The DocGroup at USA Digital Solutions, or another Doc Admin, will recommend when this type of date format should be used by creating a Fill-In field that says [Date then press CTRL-0]

**Insert Date Spelled Out**

The **Date Spelled Out** tool converts the numeric date (entered in the form “mmdyyyy” or “mmddyy”) into the standard date format. For example, 07182013 is converted to read July 18, 2013. The cursor must be located at the end of the date to be converted before CLICKING on the **Date Spelled Out** tool (or press CTRL-9).

**Dollar Amount to Text**

The **Dollar Amount to Text** tool converts the numeric dollar amount into the cardinal representation. The dollar amount should be entered without commas, but with the decimal point before the pennies figures. For example, 93379.28 is converted to read Ninety-Three Thousand Three Hundred Seventy-Nine Dollars And 28/100. The cursor must be located at the end of the dollar amount to be converted before CLICKING on the **$ Dollar amount to text** tool (or press ALT-1).

**Format Phone**

The **Format Phone** tool converts a 7-digit or 10-digit phone number into the standard telephone format. For example, 6028668199 is converted to read (602) 866-8199. The cursor must be located at the end of the phone number to be converted before CLICKING on the **Format phone** tool (or press ALT-2).

**Toggle Headers and Footers**

The **Toggle Headers and Footers** tool will open the Header & Footer toolbar and place the cursor into the first header of the document. The user can then make any changes they need to the header and footer text using Microsoft Word’s tools. They should CLICK the **Close Header and Footer** tool when are ready to return to the main document text.

**NOTE:** The user can also switch back and forth between the header and footer text and the main document by DOUBLE-CLICKING in either area.
The **Tools** tool displays a drop-down menu when the user **CLICKS** on this option. The menu is a collection of options that are useful to the user’s overall Impact/SQL document editing experience. The Tools drop-down menu is shown here on the right. Each option will be discussed below.

**User Preferences**

The **User Preferences** window gives the user the opportunity to set up options on how Impact/SQL will behave. The **User Preferences** dialog box is shown on the left.

The **View** radio buttons allow the user to select if they wish to open their documents in Microsoft Word’s **Normal** view or in Word’s **Page** view. The **Normal** view will be straight text with no margins or page breaks shown. The **Page** view shows how each page of the document will be shown on the printed page.

The **Zoom %** option allows the user to set the magnification of their document once it is opened in Microsoft Word. For most users a 120% to 144% setting will show them the entire document from the left to right margin on the screen.

The **Insert DDE Fields as Bold** and the **Insert DDE is bright red** checkboxes determine how fields inserted into the document by the user will be displayed. These two options affect only the DDE fields that the user inserts into the document using the **Insert DDE** field tool. They do not change how the Document Administrator chose to represent the fields entered in the master document.

The **Return to Impact after Printing** checkbox will automatically close every document after the user **CLICKS** the **Print** tool on Impact/SQL’s toolbar.

The **Display the Print Dialog Box when AutoPrinting from Impact** will open up Word’s print dialog box when the user **CLICKS** the **Print** tool.

When the user is finished defining how they would like to work with Impact/SQL and Word documents, they should **CLICK** the **Save & Return** button to close the dialog box and return to their current document.

**NOTE:** **CLICK** the **Cancel** button to return to the current document without making any changes to User preferences.
AutoText Load and Save

The **AutoText Load and Save** dialog box can be used to import the Company-wide AutoText entries into a user’s personal AutoText or to save a copy of what a user currently has for AutoText entries outside of Impact/SQL.

The **AutoText Load and Save** dialog box is shown to the right. The top portion deals with importing AutoText entries into a user’s AutoText. The bottom portion deals with making a backup of a user’s AutoText entries so they can retrieve them if they are lost in MS Word.

Users have two options for loading AutoText entries. The first radio button, **Load from: (personal) MyAutoText.doc**, will only be available if the user has previously used the **Store** option on the bottom of the screen. The Load option will restore the user’s AutoText entries from whatever is currently saved in their **MyAutoText.doc** file. The AutoText Load and Save dialog box will indicate the date the MyAutoText.doc was created, if one exists. Anything that was saved to the user’s AutoText after that date will be lost if there is a need to replace a user’s corrupted **Normal.dot** (which is where a user’s MS Word AutoText entries are stored).

The second radio button is the **Load from: (all users)** option and will only be available if the company has a global AutoText document set up. Impact/SQL will display the path to the location of the global AutoText document used by your company after the **(all users)** label (blanked out in the screen shot above).

The **Delete all your existing AutoText entries before loading the entries from the file** checkbox will clear out the user’s existing AutoText entries, from their Normal.dot, before reloading with the entries from the option selected.

The user should CLICK the **Load** button once they have made their choices. Impact/SQL will process either file option and display the entry count for the user. CLICK the **Yes** button to proceed with the import.

CLICK the **No** button to cancel the operation and return back to the **AutoText Load and Store** window. From there the user can CLICK the **Cancel** button to return back to the current document without making any changes to AutoText.

The **Store** button will create a Non-Impact/SQL Word document in the user’s personal Impact folder called **MyAutoText.doc**. This document contains a table with a row for each entry in the user’s AutoText. This is a great backup tool for users if they rely on AutoText. Frequently DSI receives calls from users who have lost all their AutoText entries for one reason or another. If users back up their AutoText using the **Store** feature, we can easily assist in getting it back for them by guiding them to use the **Load** feature.

It is highly recommended that all users use the **Store** feature if they use AutoText.

It is a good idea to repeat the **Store** procedure after modifying AutoText entries. DSI suggests users make storing their AutoText entries a habit that goes along with a significant day like every payday or at the first of every month.
AutoCorrect Load and Save

The AutoCorrect Load and Save dialog box is shown to the right. It behaves exactly like the AutoText Load and Save option discussed above, but works with the user’s MS Word AutoCorrect entries, if any. In this screenshot the reader can see how the dialog box appears if there isn’t a personal MyAutoCorrect.doc or a company-wide AutoCorrect option in place. The two radio buttons are grayed out, indicating there is nothing the user can load. If the user clicks on the Store button, the Load From: (Personal) MyAutoCorrect.doc option will then be available for a future re-load (if lost from the user’s Normal.dot file).

Unlink All fields

The Unlink All Fields tool will disconnect the current document on the screen from the database and change all the DDE fields to regular text. None of the information brought into the document will change from this point forward if the user chooses this option. The document will be a snapshot of your database information at the point in time the user chose this option.

2. Click on the Unlink all fields option on the pull-down menu.
3. Impact/SQL displays the dialog box shown here at the right. Click on the Yes button to unlink all fields from the database.
4. Click on the No button to return to the document without unlinking the fields.

Once the fields have been unlinked from the database, Impact/SQL will also remove all the red font color from the document since it indicates database fields and those are no longer linked.

Once the document has been saved, there is no backing out of this change. If this was done in error, the user will have to delete the document and recreate it in order to get the database fields back as DDE fields.

Remove Fill-In Fields

The Remove Fill-In Fields option will immediately remove all the square brackets in the document. Impact/SQL does not ask the user to confirm the action so the user must make sure they want to take this action before selecting the option.

This option will remove only the square brackets that create the Fill-In fields. Any non-breaking spaces or prompt text will remain in the document.

NOTE: The user can use CTRL-Z to undo this action but will have to press CTRL-Z twice—once for the left square bracket and once for the right square bracket.

Print with remaining fill-in fields

When a user chooses the Print tool from the Impact/SQL ribbon, any remaining Fill-In fields will have the square brackets hidden so they do not show up on the printed page. Selecting the Print With Remaining Fill-In Fields option from the Tools sub-menu will leave the square brackets visible on the printed page.
Print

The **Print** tool will open the typical MS Windows Print dialog box on the screen. The users should select the options they typically would do just as with any other Windows application. **Click** the **OK** button to send the document to the specified printer. The user’s designated Document printer will default as the selected printer on the Print dialog box.

Email Document

The **Email** tool on the Impact/SQL ribbon opens the **Email Options** window shown here. The top of the window displays information about the current Escrow File #.

The table portion of the window will list all the Parties listed under **Initial Questions**.

**Click** in the **To** column to have the party be listed in the main **To**: field of the Outlook email message prepared with the document as an attachment.

**Click** in the **CC** column to have the party be listed in the **CC**: field of your Outlook email message prepared with the document as an attachment.

Depending upon the company’s Impact/SQL configuration, the user may have the option to send the document as a PDF or as an MS Word document. MS Word documents also have the ability to set a password on the document so it can’t be edited unless the correct password is given. If the user does not see the **Attachment Options** area at the bottom of the **Email Options** window, their company has determined which type of attachment will be created by everyone.

**NOTE**: Do not forget the password that was used to protect the document if it is changed from the Company’s default. No one will be able to unlock the document without it.

The user should **Click** on the **OK** button once all choices have been made and they are ready to send the email, with the document as an attachment.

Outlook will open the usual email message window. The **To**: and **CC**: fields will be populated with the choices made, by the user, in Impact/SQL. The document will appear as an attachment. The user can type in the body of the email message and **Click** the **Send** button when they are ready to send the email.

Information

The **Information** tool displays the dialog box shown to the right. The user can see which version of Impact/SQL they are using if they are not certain. The other tabs contain useful information when troubleshooting any difficulties users might be having with their documents. USA DSI’s support staff may guide users to this area in order to help solve any problems.

**Click** the **Close** icon to close the Information box and return to the current document.
Save Document

This is one of the more important tools on the Impact/SQL toolbar. Click this button frequently to have Impact/SQL save your document (or press CTRL-S). You will remain in the document so you can continue working.

A good rule of thumb is to save the document as often as you want to retype. That means if you are willing to retype four hours of work, save your document every four hours. The DSI DocGroup recommends you save your document frequently and definitely before switching to another task such as answering the phone or replying to email messages. Computers are fickle and can behave badly unexpectedly.

Save and Return to Impact/SQL

Save and Return to Impact/SQL will close the document and return the user to the Escrow Document Menu. The user can then choose to create and/or edit other documents, or use the Change File icon to switch to another file to work on documents with, or to close the Escrow Document Menu and return to the Impact/SQL Desktop.

Title Instructions

Selecting the Title Instructions option, from the Documents menu, will allow the user to preview, email, publish (if so configured) or print a copy of the Title Instructions.

The Title Instructions can be customized for each Impact site. The information that presents on the Title Instructions is entered, and can be modified, on the Initial Questions screens.

Selecting Title Instructions from the Documents menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter the Escrow Number field will be pre-filled with the current open escrow number. If the field is blank, the user should type in the file number of the file for which they wish to generate the Title Instructions.

The Search option is available on that window as well.

Once a file number is entered and the OK button is clicked on, the standard Print dialog window will present and the user should select their desired action options.

Clicking on the Cancel button will return the user to the Escrow desktop.
Prelim/Commitment

Escrow has the ability to print, email or publish (if so configured) a copy of the prelim/commitment once it has been released to Escrow by the Title Department. Depending on the file type and the specifics of the transaction, there may be more than one prelim/commitment available on a file. The Commercial file type can have multiple properties, and each can have their own prelim/commitment.

Depending on the Company’s configuration, Escrow may receive an e-mail notification when the prelim is ready. Escrow may also receive an e-mail notification when an amended prelim is generated.

Selecting Prelim/Commitment from the Documents menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter the Escrow Number text field is pre-filled with the current open escrow number. If the field is blank, the user should type in the file number of the file for which they wish to print the prelim or commitment.

The Search option is available on that window as well.

Once a file number is entered and the OK button is clicked on, the Print Prelim/Commitment window will present, as shown below. This sample happens to be a Commercial file, with three properties in it, each with a prelim/commitment that has been released to Escrow.

Clicking on the Cancel button will return the user to the Escrow desktop.

The Print Prelim/Commitment window will present any prelim/commitments that have been released to Escrow. They are listed by Property Address and will reflect when they were Created, when Last Updated and when Released. The Filter box can be used to narrow down the list presented (useful for a file with a great number of properties in it).

Once at least one entry in the listing of available prelim/commitments for a file is checked, with the checkbox in front of each entry, the options to Print Selected, Email Selected and Publish Selected (if so configured) will be enabled at the top of the Print Prelim/Commitment window.

The user should check all of the prelim/commitments they wish to print, email or publish and then click on the appropriate icon at the top of the screen to trigger the action.
**HUD**

A **HUD** settlement statement can be generated, on any file of the **Residential** file type, after utilizing either the **HUD** or **Worksheet** styles of data entry, with or without GFE. A **HUD** settlement statement cannot be generated on a file of the **Commercial** file type – and the message below will be received if a user attempts to do so.

Selecting **HUD** from the **Documents** menu opens the **Escrow Number Entry** dialogue box. If the user has an escrow open on the desktop the **Enter the Escrow Number** text field is pre-filled with the current open escrow number. If the field is blank, or if the user wishes to generate a **HUD** for another file than is displayed, the user should type in the file number of the file for which they wish to print the **HUD**.

The **Search** option is available on that window as well.

Once a **Residential** file number is entered and the **OK** button is clicked on, a **Print HUD Form** or **Print HUD with GFEC** window will present. There are two possible windows, depending on whether the file is a "with GFE" file or not, as shown below.

Clicking on the **Cancel** button will return the user to the Escrow desktop.

**NON-GFE FILE**

**GFE FILE**

There are more options on "with-GFE" files to provide for the itemization of the charges entered in breakdown screens during charge data entry.
The user should select either the **Combined, Buyer Only** or **Seller Only** option they wish from the dropdown box next to the **HUD Selection** label. This will drive the data pulled into the HUD.

The **Type** dropdown is used to put a label on the HUD, such as **Estimated, Final or Amended**. The labels available can be customized by database.

On **non-GFE** files only, there is a **Paper Size** option – **Letter** or **Legal**. The letter-sized option will drop all of the unused lines, while the legal-sized option will print all of the standard lines, whether used or not and any added lines. **With-GFE** files can only print a legal-sized HUD.

On **non-GFE** files only, there is an **In Box F:** option that provides for the insertion of **Lenders #1 & #2** in box F of the HUD, or **Lender #3**. The **with-GFE** files always present all lenders entered into the file.

The **Options** section of each form let the user control some additional facets of the HUD presentation, as will be described below.

The first **Option**, on the **with-GFE** form, is used to specify whether, on a multi-lender file, there should be multiple HUDs generated, or whether a combined HUD should be generated. There will always be separate GFEC pages generated for each loan. The **Separate Lenders** checkbox is used to indicate separate HUDs should be produced.

The **Use Buyer Forwarding Address** and **Use Seller Forwarding Address** option checkboxes are used to switch from presenting the primary addresses of the Buyer &/or Seller to presenting their forwarding addresses (entered on their respective Party screens in Initial Questions) in Boxes E and D of the HUD. If either option is dimmed out, it means there are no forwarding addresses available for the specified Party type.

The **With Certification** option is used to indicate whether the Signature Page should be printed with the HUD or not. The user should check to option to include it.

The **non-GFE Print HUD Form** has a **Disclose Commission Breakdown** option, which will generate a schedule of the commission breakdown with the HUD. The same type of option is available on the with-GFE Print HUD with GFEC form, in the right-hand column of options.

Should the option to have Escrow Officer and Escrow Assistant certification stamps stored in Impact be enabled, the **Include Certification Stamp** option will be enabled (not grayed out), and when checked will include the customized stamp of the user generating the HUD on the face of page 1 of the HUD.

The right-hand side of the **Options** section of the **Print HUD with GFEC** form (with-GFE files only) presents four itemization options that will add those breakdowns, as additional schedules, after the GFEC page(s). The itemizations available are: **Seller Paid Borrower Charges, Commission Breakdown, Origination Charges** and **Title Services**. While the with-GFE HUD consolidates these charges, often breakdowns are requested and these options provide for them to be presented.

Once the user has selected their desired options, the **OK** button should be clicked on and the **Print** dialogue box will present, from which the user can **Preview**, **Email** or **Publish** (if so configured) the HUD.

If the user changes their mind and decides they do not wish to continue with generating the HUD, they should click on the **Cancel** button.

Note: There is are optional, editable, Excel and Word HUD templates that can be installed on the Escrow Document Menu. Contact USA Digital Solutions Support for more information.
**HUD-1A**

The one page **HUD-1A** is available for **non-GFE** refinance transactions (which are a rare event since the 2010 RESPA changes). This form may only be used for buyer/borrower charges. The file may not have any entries on the seller’s side within the **Initial Questions** or **HUD/Worksheet Style Entry** screens.

Selecting **HUD-1A** from the **Documents** menu opens the **Escrow Number Entry** dialogue box. If the user has an escrow open on the desktop the **Enter the Escrow Number** text field is pre-filled with the current open escrow number. If the field is blank, or if the user wishes to generate a HUD-1A for another file than is displayed, the user should type in the file number of the file for which they wish to print the HUD-1A.

The **Search** option is available on that window as well.

Once a **non-GFE Residential** file number is entered and the **OK** button is clicked on, the **Print HUD-1A Form** window will present, as shown here. If a file number of a Commercial or with-GFE file is entered the user will get a message that the HUD-1A is not supported for files of those types.

![Print HUD-1A Form](image)

See the **HUD** section above for an explanation of the options available on this form.
Settlement Statement

The Settlement Statement option, on the Documents menu, is used to generate a Settlement Statement for the file selected. Settlement Statements can be produced for any file, regardless of entry style or file type. Commercial files can only produce Settlement Statements (no HUDs). Settlement Statements can be customized by the USA Digital Solutions Support Team, with specific verbiage for different statement versions, for each database.

Note: There are optional editable Settlement Statement Excel templates that can be installed on the Escrow Document Menu. Contact USA Digital Solutions Support for more information on these.

Selecting Settlement Statement from the Documents menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter the Escrow Number text field is pre-filled with the current open escrow number. If the field is blank, or if the user wishes to generate a Settlement Statement for another file than is displayed, the user should type in the file number of the file for which they wish to print the Settlement Statement.

The Search option is available on that window as well.

Once a file number is entered and the OK button is clicked on, the Print Settlement Statement window will present, as shown here.

The Type of statement selection is variable by Impact database; typical choices are Estimated, Final, Amended and Sub Escrow. The text selected will normally print at the top of the statement. Some companies have varying verbiage on the various versions of the statements.

The Selection dropdown is used to identify whether Both (buyers and sellers), Buyers, Sellers or a Combined statement are to be produced. Selecting Both will result in the Buyer’s Settlement Statement being produced, followed by the Seller’s Settlement Statement. The Combined settlement statement shows buyer and seller debits and credits on one document.

If Certification Stamps are enabled, that option will be available for selection.

The user should check the Include Certification Page option to get a signature page printed with the statement(s).
Settlement Statements, on Commercial files, can be Fractional statements. These statements will divide up the transaction figures by the parties’ ownership interests. Fractional statements are only available if Both, Buyer or Seller are picked in the Selection area of the print dialog.

The user should check the Fractional Statements option to get split statements. Again, this is only enabled if Both, Buyer or Seller are selected in the Selection section. Below, the selection screen that pops up when the Fractional Statements Print Option is selected (in this case, Buyer was the Selection). The user should check the party or parties for whom statements should be printed. Checking the checkbox at the top left, next to the Party heading, will check, or uncheck, all parties listed.

The Exchange Statements Print Option would be used in a 1031 Exchange situation where the Accommodators are desired to be shown as the Seller or Buyer/Borrower. When selected, the user will be prompted with a screen like that shown below (if Both was the Selection made; if only Buyer or Seller were selected, only the Accommodator(s) related to that party type would present). They should check the parties to report with. The party will report with the “Accommodator” label at the top of the settlement statement.

Once the user has selected their desired options, the OK button should be clicked on and the Print dialogue box will present, from which the user can Preview, Email or Publish (if so configured) the Settlement Statement(s) requested.

If the user changes their mind and decides they do not wish to continue with generating a Settlement Statement, they should click on the Cancel button.
Legal Description

The Legal Description option, on the Document menu, is used to Print, Email or Publish (if so configured) the legal description document.

Selecting Legal Description from the Documents menu opens the Escrow Number Entry dialogue box. If the user has an escrow open on the desktop the Enter the Escrow Number text field is pre-filled with the current open escrow number. If the field is blank, or if the user wishes to generate a Legal Description for another file than is displayed, the user should type in the file number of the file for which they wish to use.

The Search option is available on that window as well.

Once a file number is entered and the OK button is clicked on, the Print Legal Description window will present, as shown here. For Residential files, there will only be one property listed; Commercial files may have more than one listed.

One or more listed entries can be checked off (checkbox in front of the address record) and, once checked, the Print Selected, Email Selected and Publish Selected (if so configured) icons will be enabled at the top of the screen. The user should select the desired action and proceed accordingly.

Document Maintenance

The menu option is only available to a user with Document Maintenance authorization. It is used to develop or modify master document templates. Please refer to the Document Maintenance manual for further information the Document Maintenance functionality. It is not detailed here.

Training on the Document Administrator role is available from USA Digital Solutions, Inc.
Projects Menu

The functionality of Projects is used for timeshare, condominium, and subdivision transactions as it provides for the grouping of several escrow files together under a single Project Name, linked to a specific master escrow file.

The establishment of Projects is keyed to the branch of the user establishing the Project…and only Projects assigned to a user’s branch will be visible to a user.

Custom reports can be generated, by Project, based on data collected from specified fields from all the escrow files assigned to the Project. This ability to do aggregate reporting can be used as a marketing tool. The custom Crystal Reports files must be created (usually by USA Digital Solutions’ Crystal Reports team) before they can be generated. They are unique to the Project.

All the receipts and disbursements from escrow files assigned to a Project are linked to one escrow trust account. Funds can be transferred from the affiliated escrow files to the master file for the Project.

Multiple escrow files in a project can be closed automatically from the Projects screen.

Clicking on the Projects menu heading, on the Escrow desktop, will pull up the Projects screen, shown below.

The Filter: field may be used to narrow down the listing of Projects presented. The user should enter part of the name in the field and the listing will exclude all Projects that do not match the selection. The Clear icon should be used to clear the Filter: field.

New Project

The creation of a new Project can be initiated either on the first screen of Initial Questions or through the Projects screen, accessed by the Projects menu entry on the Escrow Desktop.

On the first screen of Initial Questions there is a Project field where the user can tie a file to a Project. The short name of the Project should be typed into that field. If a Project does not exist under that short name, the user will be prompted as to whether they desire to establish a Project by the presentation of a screen like the one shown here. If the user completes this screen, a new Project will be created, pulling the Bank of the Project from the bank of the Master Escrow identified by the user. A recognizable Project Title should be provided by the user.

When users are opening new files, related to existing Projects, they should add the short name of the Project to the new files, on the first screen of Initial Questions.
The other method for establishing a new Project is to click on the New Project icon on the Projects screen, shown on the prior page, reached through the Project menu entry on the Escrow Desktop. This approach will let the user identify not only the information asked for on the Project Setup screen reached via Initial Questions (with a previously unidentified Project short name), but also the data fields that the user wishes to be able to have reported on the custom report to be established for the Project.

The user should enter a 6 character or less entry in the Project Name field.

A longer, more descriptive name should be entered in the Project Title field.

The Master Escrow field should be used to identify the primary file for the Project. This file will be the one where all balances on closed files (either gross proceeds or remaining funds) are consolidated, with the Transfer Funds function (discussed below).

The Bank field will self-populate from the bank on the Master Escrow, if there is one. All files in the Project must share the same bank.

The bottom of the screen is used to indicate which fields, of file data, should be available for reporting on the custom report for the Project. The user should highlight the desired field on the left side of the screen and click on Add >> to add it to the Project Data Fields list on the right of the screen. Fields can be taken off the list with the << Remove button, after selection on the right side. NOTE: selecting the fields does NOT prepare the report template. The custom report layout for each Project must be created via Crystal Reports. Normally, this is done by USA Digital Solution’s Crystal Reports team. If the format for one Project is used for others, the template from one can be copied and renamed, simplifying the effort once the first template is created.
Project Actions

The Projects screen will present all Projects, with action icons next to each, if the function is available for the particular Project.

Modify

The Modify icon is used to open the Projects screen, shown on the prior page, enabling the user to change the Project Title or Master Escrow – if improperly established. The Project Data Field listing can also be altered.

Delete

The Delete icon is used to initiate the deletion of a Project. This action should only be taken if the Project is completed and all required reporting has been done and the Master Escrow has a zero balance.

Reports

The Reports icon is used to open the Project Reports screen. From this screen, the user can either print their customized report format for the Project – showing either a listing of Files Closing On (within) a date range or a listing of Open Files for the Project. There is a checkbox that will Include Cancelled Files in either report.

There is also an option to print a Trial Balance of all files in a particular Project.
Close Project

The ☑ Close Project icon is used to set the Closed Date and Recorded Date values in Impact, for files in the Project, with Estimated Close Dates (Initial Questions) within a specified date range.

If the user wishes to flag all files with Estimated Close Dates within the range entered with the Starting Date and Ending Date fields, with a specific Closed Date and Recorded Date, then the date desired for all files should be entered in the Close Date field on the Project Close screen (shown to the right).

If the user does not enter a Close Date on the Project Close screen, but checks the Use COE Date checkbox, those files with an Estimated Close Date within the date range entered with the Starting Date and Ending Date fields will have their individual Estimated Close Dates used to file the files’ Closed Date and Recording Date fields.

In the sample to the left, a full year date range was entered (not likely) and the Use COE Date option was checked. When the user clicked on OK, the message describing what was to happen was presented, giving the user the chance to confirm the action or halt it.

In this hypothetical sample, after clicking OK, the user received the message, to the right, indicating the effect of the action.

With either approach, any existing Closed Date and Recording Date values (which may have been filled by a ":T" fee check/fee slip having been issued – unlikely, but possible) will be overwritten with the action triggered from this screen.
Transfer Funds

The **Transfer Funds** icon is used to initiate the transfer of Project file balances, for files with **Closed Dates** within a specified range, to the Master Escrow of the Project. Often, this would be done with Timeshare or Condominium projects where the deposits are logged in each file, but the disbursements are centralized, from the Master Escrow. The user should enter a range of closing dates, in the **Starting Date** and **Ending Date** fields, and then click on OK to proceed with the transfer of funds.

The system will identify if there are funds to be transferred. If not, a message to that effect will be presented.

If there are funds to be transferred, the **Print** control dialogue box will present and the user should click on **OK** to generate the **Transfer Project Receipts Journal** to their printer. The report will list the transfers out of the individual files and into the Master Escrow file.

After the report generates, a summary notice will present on the screen, asking the user to confirm the transfer should be completed, as shown here. The user should click on **Yes** to complete the transfer or **No** to cancel it. If cancelled, the system will return the user to the Project Transfer Funds screen, where they can either **Cancel** or change the date range and restart the cycle.
Reports Menu

The Reports menu, on the Escrow desktop, will present entries for generating a number of reports and for doing some other functions. The listing will vary depending on system configuration, as noted below. The full listing of possible menu entries is shown here and each will be explained in the following pages.

- Assigned Escrows
- Log Book
- Closings Report
- Income Analysis (optional)
- Deposit Slips (optional)
- View Deposit Slips (optional)
- Daily Receipts Journal
- Daily Disbursements Journal
- Trial Balance Report (optional)
- Wire Out Journal (optional)
- Custom Reports (optional)
- Custom Report Maintenance (if Custom Reports enabled)
  - Create Custom Report
  - Modify Custom Report Menu

Optional items are controlled by assorted Setup Options that the System Administrator controls. The options should be considered carefully and selected to work with established business practices. Normally, all of the options available are reviewed, and set, with the business at the time the Impact/SQL database is configured. The USA Digital Solutions Support team can provide guidance on them, as well.
**Assigned Escrows Report**

The **Assigned Escrows** option, on the **Reports** menu, provides for the on-screen or printed presentation of escrow file information for a selected escrow officer or escrow processor. The information presented on-screen, or when printed, is the Escrow #, a Project Name if assigned to an escrow, the date Opened, the date Closed, the date the title search was Ordered, and the current Status.

The user should select the **Assigned Escrows** menu option to open the **Assigned Escrows** screen. There are radio buttons to identify whether the user wishes to pull up data By Escrow Officer or By Processor. Once that selection has been made, the dropdown arrows should be used to present a listing of all Escrow Officers in the branch of the user or all Processors. The user should choose a name from the selected list. When a name is selected from the list, a listing of all of their assigned files will be presented in the body of the screen.

The **Options** box, in the upper right of the screen, lets the user limit the returned file list to **Open Files**, **Closed Files** or to not limit the list and show Both.

![Assigned Escrows Screen]

The **_print** icon, at the top left of the screen, will generate a report of the requested data. When clicked, the print dialogue box will present, and the user can select to Print (OK), **Preview** or **Email** the report. Click on **Cancel** to return to the previous screen.
Log Book

The Log Book option, on the Reports menu, is used to generate a report of files opened within a date range. The report presents information on opened escrow files per selected branch, escrow officer, or escrow processor. Depending on a user's access level, they may be able to see all activity within their branch (Escrow Manager) or just their own files (Escrow Officer). The report presents the File Number, EO #2, Opened Date, Transaction Type, Seller Name (#1), Buyer Name (#1), Marketing Rep, Property Address, City, State, Zip and County, Sales Price, Loan Amount, Sellers Broker, Buyers Broker and Source of Business.

The user should select Log Book from the Reports menu to open the Log Book dialogue box. In the Print Options area of the screen, they should click on the appropriate radio button to create a report generated By Branch, By Escrow Officer, or By Escrow Processor, then click on the appropriate drop down list arrow to choose a name from the appropriate list. Escrow Managers will have their home branch pre-selected.

The user should enter a range of file opening dates by completing the From: and To: date fields, in the Date Range section of the screen.

The OK button will open the standard Print dialogue box, from which the user can Print (OK), Preview or Email the report. Cancel, on the Log Book screen, will return the user to the Escrow desktop.

The Schedule option is also available. Report scheduling is discussed earlier in this manual. It may or may not be available, depending on site configuration.
Closings Report

The Closings Report option, on the Reports menu, is used to generate a report of files closed within a date range. The report presents information on closed escrow files per selected branch, escrow officer, or escrow processor. Cancelled files can be included in the report. In addition to running this report to identify closed files, the report is run to determine whether required 1099-S reporting has been done on the closed files. The reporting is limited to the branch of the user, if the user is assigned to a branch other than Accounting (999). The report presents the Escrow Number, Transaction Type, EO #1, EO #2, Open Date, Closed Date, Buyer Name (#1), Seller Name (#1), Market Rep, Status, TIN Applied For and IRS status.

The user should select Closings Report from the Reports menu to open the Closings Report dialogue box. In the Print Options area of the screen, they should click on the appropriate radio button to create a report generated By Branch, By Escrow Officer, or By Escrow Processor, then click on the appropriate drop down list arrow to choose a name from the appropriate list. Escrow Managers, Escrow Officers and Processors will have their home branch pre-selected.

Once the OK button is clicked on the Closings Report screen (shown to the left), after selecting the Print Options and Date Range to report on, the Print dialogue box will be presented, from which the user can identify if the report is to be Printed (OK), Previewed or Emailed. Clicking on Cancel will return the user to the Closings Report screen.

Once the user has made their selection (if not Cancel), a Missing Parameters screen will be presented (shown to the right). On this screen, the user is to identify if they wish to limit the returned file listing to those in different states of completion regarding 1099-S reporting and whether to Include Cancelled Files in the report. The IRS Status Filter options are: All Files, Not Reported, Non-Reportable and Reported. If the user is looking for a listing of all closed files, the All Files option would be selected (with the additional option of including cancelled files). If the reporting is being done as part of the 1099-S scrubbing process, the Not Reported option would likely be selected – as this would present closed files that have been flagged as requiring a 1099-S which have not had one (or more) prepared on them.

Note: there is an IRS 1099-S report in the Accounting module that can be run to show all of the 1099-S data that has been entered. It is used to scrub whether the entered data is in the appropriate format, but it is of little value if there are files left in the Not Reported state…so the Closing Report should be run to confirm there are no files with status of Not Reported before the 1099-S report is run by Accounting. It is recommended that this be done monthly, for YTD activity, to aid in keeping current with the scrubbing, so that it does not become a major project right after year end.
Income Analysis (optional)

The Income Analysis option, on the Reports menu, is available if the “Allow Escrow to View Income” Setup Option is enabled.

The Income Analysis option provides for graphic or report presentations of fees collected by fee check or fee slip (:T payee) on escrow files in the user’s branch for a date range. The reporting is very basic and is usually supplanted with Custom MIS reporting – run through the Escrow module or the MIS module – which is formatted more to an individual company’s requirements. Often sites have too many income codes for the graphic presentations to be practical.

If the user has an access level of Escrow Officer, they will be able to view income data from their files. If the user has an access level of Escrow Manager, they will be able to view income data for their entire branch or a specific Escrow Officer.

The choice of whether to report By Branch (assuming an Escrow Manager is running the reporting) or by Officer, is made in the Print Options section at the top of the Income Analysis window (shown above). The dropdowns, if available, can be used to specify the subject of the reporting.

The Date Last Posted is reflected in the middle of the Income Analysis screen because income data can only be reported on if it is posted through the daily posting routine administered by Accounting. It does no good to run the report for a date range that goes beyond the last posted date (but the system will let the user try).

The Date Range for the report is selected by entering dates in the From: and To: fields. Again, the To: date should not be greater than the Date Last Posted. The range is inclusive of the dates entered.

The Format section of the Income Analysis screen is used to identify whether Summary or Detailed data is to be presented. Only the Summary format option can use the Display option (on the right of the screen), which will present a screen of a table of data for the date range and year-to-date, and attempt bar chart and pie chart presentations. Again, with a multiplicity of income codes those graphical presentations can be hard to interpret.

The Detailed format option will only provide for the Print option, which will present a simple report that can be Printed (OK), Previewed or Emailed. The report will list income by income code by file, for the date range and party (branch or escrow officer) selected.
Deposit Slips (optional)

The Impact/SQL system can be configured to allow Escrow module users to prepare deposit slips; or, the task can be restricted to users with Accounting permissions only. If the Deposit Slips option appears on the Reports menu, in Escrow, then Escrow can prepare deposits slips. An additional control can be used to limit the depositable receipts that Escrow sees to those created in their branch (typical setting). The ability to generate deposits slips (which generally print on the check printer on the check stock, but do not have to if they are being scanned) eliminates the addition errors common on manually prepared deposit slips. Deposit slips will present in the reconciliation module as they would on the bank statement, rather than having the individual receipts present therein, making the task of reconciling much more straightforward. It is recommended that deposit slips be prepared daily. Often, it makes sense to prepare one before the cutoff for getting deposits to the bank and another of items that come in after that cutoff, to be sent to the bank the next day.

Only depositable receipts are presented for inclusion on deposit slips. Escrow personnel should be aware of which receipt types are depositable and which are not, so that when they are preparing receipts, they only use depositable receipt types for items that they are in physical possession of and which will be sent to the bank in a deposit (either physically or via scanner). Wires In and Direct Deposit items are NOT depositable and, as such, should not have depositable receipt types used for them (such as Earnest Money, which, if present, is usually a depositable receipt type, to be used for an Earnest Money check). As each site may have differing receipt types, a definitive listing cannot be provided here. Consult with the System Administrator for that listing.

The user should select Deposit Slips, from the Reports menu, if they wish to prepare one or more deposit slips. The Deposit Slips screen (like the sample below) will be presented.

At the top of the screen, there is a filter date field, called Items For:, that can be used to limit the number of receipts presented. All receipts of the date entered and earlier will present. Normally, this can be left at the current date, which defaults.

In this example, the restriction is in place to limit the receipts available for deposit to the branch of the user, so the Branch field is grayed out. If the restriction is not in place, the user must select the appropriate branch for the items in hand, or "All" if items from several branches are in hand.
The **Bank**: dropdown should be used to select the escrow trust account (Impact “Bank”) for which the deposit is being prepared. Often, a branch will only have one bank, but if there are several available, the appropriate one for the deposit being prepared should be selected.

The user can sort the listing of undeposited receipts using the **Sort** icon in the upper right corner of the screen. The default sort is branch within receipt date.

The user should then click on the checkbox in front of all receipts for which they have a corresponding physical item in hand and are to be including in the deposit being prepared. If every item on the screen is to be included in the deposit, the checkbox next to the **Receipt Date** heading can be checked. When all items that are being included in the deposit are checked (it may not be all the items on the screen), the user should then click on the **Create Deposit for Selected** icon, at the top left of the screen (which will not be enabled until at least one item is checked).

A screen like that shown here will present detailing the number of items in the deposit and the total amount of the deposit. There is a notice that, at this point, the **Ticket Number** (deposit slip number) has not been assigned; it will be assigned if the user clicks on the **OK** button. The **Date of Deposit** field will typically be the current date, and disabled, but if the database is configured to allow back-dating of deposits it will be open for editing (not recommended).

The user should click on **OK** to continue with the deposit slip preparation, or **Cancel** to stop the process. If **OK** is clicked, the routine Print dialogue box will present, from which the user can **Print** (**OK**), **Preview** or **Email** the deposit slip. For sites that take their deposits to the bank, the deposit slip should be printed to the check printer (which should default). For sites that scan deposits, the deposit slip can be printed to the document printer, or the print function can be **Canceled**, if a deposit slip is not needed. The deposit will still have been created, and the items included on it will have been removed from the **Deposit Slips** screen.

**Manual Deposit (optional)**

There is a system setup option that provides for the entry of manual deposits. This option has extremely limited utility and is therefore almost never turned on. If it is turned on, there is an additional icon at the top of the Deposit Slips screen, **New Manual Deposit**, which can be used to create a deposit that is at the bank but not supported by receipts in Impact. Practically, only an account opening deposit would satisfy such a situation, and that can be supported by a reconciliation adjustment entry – eliminating the need for a manual deposit – which is why the option is seldom enabled.
View Deposit Slips & Voiding of Deposit Slips (optional)

If Escrow is configured to work with Deposit Slips, the View Deposit Slips option will appear on the Reports menu. The View Deposit Slip screen, which presents when the user selects the option, has several purposes: to display the general information about a deposit, to show the contents of a deposit, to check on the cleared or void status of a deposit, to reprint a deposit’s contents or to void a deposit (if so configured). In addition, a new deposit can be created from this screen.

When first opened a screen like that above is presented to the user.

The default entry in the Items For: field is the date 30 days back from the current date. The purpose of that field is to limit the data on the screen, and so by starting with a date 30 days in the past, the last 30 days of deposits is presented, for the selected Branch and Bank.

The user may be able to alter the Branch selection, depending on access level and branch assignment, but typically not as an Escrow User.

The Bank selection will be available for editing if more than one bank account is assigned to the selected Branch.

If changes are made to the Items For, Branch &/or Bank selections, the user should click on the Search button to re-do the search, based on the new criteria.

On the main screen, the information on the deposit, since the Items For date, for the selected Branch and Bank, includes: the Bank, the Branch, the Ticket # (DS #), the Deposit Date, the Amount of the deposit, how many Items were in the deposit, whether the deposit has Cleared the bank (daily account reconciling is critical for this to be truly effective) and whether the deposit was Voided.

To the right of each entry are up to three icons.

The Info icon will bring up a listing of the items within the specific deposit, as shown to the right.

The Print icon will reprint the deposit slip selected.

The Void icon, available if a deposit has not already been voided or cleared, will void the deposit and put the items in it back on the Deposit Slips screen.

The New Deposit icon, at the top of the View Deposit Slips screen, will bring up the Deposit Slips screen discussed earlier.

The Search by Deposit icon will bring up a screen into which the user would enter a specific deposit slip number, then click on OK, and the system will present all deposit slips, for any bank, that have that deposit slip number assigned, on the View Deposit Slips screen.
Daily Receipts Journal

The Daily Receipts Journal option, on the Reports menu, is used to view and/or print the detailed listing of unposted receipts (wires in and other receipts) for a specific Branch, for a specific File Date. The Print Options include By Branch and Bank (useful if multiple banks are available to the branch and entries for multiple banks are selected for printing) or By Bank. The Branch selection is controlled by the user's branch assignment, so normally will only reflect one available branch. The File Date is normally the current date, as previous days' work is generally posted by Accounting early in the following morning, so there would be nothing to see for prior days.

This report is available to satisfy the requirement of some businesses to print a listing of all receipts done at a branch in each day, at the end of the day. The same data is printed by Accounting in the Daily Posting routine, so generally this report need not be prepared and sent to Accounting.

The report is also useful to quickly review the receipts entered for the day, to ensure all items in hand have been receipted, for example.

Daily Disbursements Journal

The Daily Disbursements Journal option, on the Reports menu, is used to view and/or print the detailed listing of unposted disbursements (wires out and checks) for a specific Branch, for a specific File Date.

The look and behavior of the Print Daily Disbursements Journal screen is exactly the same as the Print Daily Receipts Journal screen discussed above on this page, so that description will not be repeated here.
**Trial Balance Report (optional)**

The **Trial Balance** report presents the net ledger balance and aggregate saving balance for all files with a balance (positive or negative), in either category, for a selected point-in-time date. The default report presents the **Escrow Number**, **Bank**, **EO Initials**, **Ledger Balance**, **Savings Balance**, **Last Transaction Date** (accounting activity), **Open Date**, **Close Date**, **Recording Date**, **Policy Date** and **Status** (whether cancelled or not).

There is a configuration option in Impact/SQL that will permit the viewing of the **Trial Balance** report by some Escrow access levels. If enabled, users with **Escrow Officer** access level will be able to run the Trial Balance report for files assigned to themselves, and users with **Escrow Manager** access level will be able to run the Trial Balance report for all files assigned to their branch.

Selecting the **Trial Balance** option, from the **Reports** menu, for a user with **Escrow Manager** access level, will present the following **Escrow Standard Trial Balance** screen.

At the top of the screen, the **Date Last Posted** is presented. Below that is a date field that the user can use to indicate the date through which they wish to run the Trial Balance report (**Trial Balance as of**). It is a point-in-time report. It cannot be run for a date later than the **Date Last Posted**, as it only reports posted data.

The available **Print Selection** options, for an **Escrow Manager** are to run the **Trial By Specific Officer** or **By Specific Branch**. If the radio button is selected on the **By Specific Officer** label, then the user should select the Escrow Officer from the dropdown list available. Only officers in the user’s branch will be presented in the listing. If the radio button is selected on the **By Specific Branch** label, the user’s branch will be reported on. No other branches will appear in the dropdown for selection.

If the user has the access level **Escrow Officer**, they will not see the **By Specific Branch Print Selection** option, just **By Specific Officer**, and they will be the only officer in the dropdown listing.

Neither the **Escrow Manager** nor **Escrow Officer** access levels will permit the Trial to be run **By Bank** – that is an Accounting-only option.

The **Print Options** section of the **Escrow Standard Trial Balance** screen is typically not utilized, but can be to modify the reporting somewhat.

- The **Include Zero Balances** option will include files that have had accounting activity, but which are at a zero balance on the “as of” date of the report.
- The **Show only files open for X months or longer** option is used to limit the report to aged files. The user should specify a number of months in the field provided.
- The **Include Buyer/Seller Names** option will do that and remove all of the dates other than the Close Date.
- The **Include Held Funds Description** option will do that and also automatically includes the Buyer and Seller names.
- The **Print Ledgers** option will generate the Trial and a separate ledger for each file on the Trial.
Wire Out Journal (optional)

The **Wire Out Journal** option, on the **Reports** menu, is available only if the system is configured for **Outgoing Wire Processing** and the option **Enable Dual Authorization by Escrow** is selected. The report is used to identify wires that have been **Initiated** but which are not yet approved under the dual authorization routine.

If so configured, users with access levels of Escrow Officer, Escrow Manager, Floater (w/ or w/o check write), Accounting, Accounting Manager or System Administrator will be able to use the option.

The option presents information on **Initiated** but not yet approved outgoing wires. Once a wire out is approved, by a wire out approver under the dual authorization routine, it will not appear on the report.

Depending on access level, the user’s selection options, on the Wire Out Journal screen (shown here), will vary. An Escrow Manager will be able to run the report for their own branch and for escrow officers within their branch. Accounting access level users will see all Print Selection options available to them.

A sample of the layout of the report is shown below.
Custom Reports (optional)

The presence of the Custom Reports option, on the Reports menu, is driven by a setup option. If a business wishes to make some custom MIS reporting available to be run from the Escrow module, this option will be enabled and reports will be developed and placed on the Custom Reports menu in Escrow. There are reporting tools that can be incorporated into the reports put on the Escrow Custom Report menu that can limit what files a particular user can see data on, depending on Access Level. The use of those tools will be discussed with the business if they request the preparation of any Escrow custom MIS reports.

When selected, the Custom Reports option will present a screen like that shown here (by default the “tree view” is collapsed, showing just report category headers; this sample is expanded to show contents of the single folder in place for this sample system).

The user can click on the “+” sign in front of a folder to expand it, to display its contents, or inversely, if expanded, the “-” sign in front of the folder description will collapse the folder. Double-clicking on the category heading will have the same effect.

To run a report, the user should double-click on the report name. Most reports will need a date range, at a minimum, to be supplied by the user. Some will have other Parameters that the user should respond to, making the desired selection(s) and then click on OK to generate the report, or Cancel to exit without generating a report. If so configured, the Schedule function is also presented (discussed earlier).

Custom Reports Maintenance (if Custom Reports avail)

The Custom Reports Maintenance option, on the Reports menu, is only presented to select access levels and is used to reach the functions Create Custom Report and Modify Custom Report Menu.

Generally, custom reports are prepared by USA Digital Solutions, Inc.'s Crystal Reports team, in consultation with the business. Further guidance on these functions can be provided by that team. They will not be described further in this manual.
Misc. Menu

The Miscellaneous (Misc.) menu, on the Escrow desktop, contains a collection of functions that are not related to the other functional groupings. The items presented on the Misc. menu will vary depending on system configuration and user access level. The full listing is presented below and will be discussed in the following pages.

- Amortization
- Rate Calculator
- Search
- View Ledger
- Savings Accounts (optional)
  - Add / Modify
  - Print
- View Check Status
- Void Check (optional)
- Void Wire Out (optional)
- Printer Setup
- Change Password (conditional)
- Manual Check Entry (optional)
- Accounting Lock/Unlock File (optional)

Amortization

The Amortization option, on the Misc. menu, is used to generate an amortization schedule. The amortization schedule generated includes the Payment Number, monthly Due Date, Payment Amount, Interest Paid, Principal Paid, Principal Balance, Unpaid Interest, Balance Due, and if applicable, a comment about any Modification to the loan. Also, the amortization schedule generated includes subtotals for yearly payments, principal paid and interest paid, and the total amounts of payments, principal paid and interest paid for the loan.

The user is presented with the Amortization screen (shown to the right) when the option is selected. To generate a basic schedule, the user should enter information into the fields at the top of the screen – Principal, Interest Rate, Loan Start Date, Payments/Year, payment Start Date and EITHER the Installment Amount or the Term (in Months). One of those two fields must be left blank. A Start Date must be entered, and it must be after the Loan Start Date. A Stop Date need not be entered unless an Installment Amount is and a Term is not – then a Stop Date is required. A Title can be added to the schedule so that the resulting printout can have an informative heading – such as the customer’s name.
The bottom of the screen, in the Odd Transactions section, is used to detail atypical events that will occur during the amortization period. The event type is selected from the Type of Transaction dropdown listing, and the options are: Principal Reduction, Balloon Payment, Change Installment Amount or Change Interest Rate.

The user, if they need to introduce one or more Odd Transactions (up to 7), should select the Type of Transaction, enter a Date of the event and enter either an Amount or Percent, as applicable for the event. There is a notation at the bottom of the screen reminding the user that, "If an Odd Transaction date does not fall on a transaction date then the date will be adjusted to the transaction date immediately following the date entered".

Clicking on the Calculate button will create the amortization schedule. The user will be first presented with the Print control dialogue, from which they can Print (OK), Preview or Email the schedule. Clicking Cancel will return the user to the Amortization screen.

Should the data that was entered result in a situation where the interest accrued each period will match or exceed the installment amount (a negative amortization situation) a message to that effect will be presented (shown below), and the user will be asked to confirm they wish to generate a schedule reflecting the addition of the unpaid interest to the principal balance. If the user replies by clicking on Yes, the system will proceed; if No, then it will stop.

If the interest accrual is only less than the payment amount for some number of periods less than the total number of periods, the balance due will grow until it begins to be reduced by the late application of interest, and when the original principal balance is reached by the balance due, principal will be applied thereafter. In either situation the last payment due will be marked up to reflect payment of the full balance due.

A sample of a basic 30 year amortization of $500,000, at 3.5% interest, with a loan start date of 10/01/2013 and a first payment date of 11/15/2013 reflects a payment amount of $2,245.22. The beginning of the amortization schedule produced is shown below.
Rate Calculator

Please note that the Rate Calculator in Impact/SQL does not currently handle some common pricing practices and is under review for revision (as of September 2013). Therefore, a full description of the Rate Calculator will not be included in this section of the Escrow manual.

Search

The File Search function, reached with the Search option, on the Misc. menu, is described at the beginning of this manual in the General Information and Helpful Hints section; and, it is also discussed just below, in the View Ledger section; it will not be re-described here.

View Ledger

The Ledger is where all of the accounting transactions on an Escrow file (receipts and disbursements) are presented (whether posted or in process). When the request is made to display a ledger, with the View Ledger option, on the Misc. menu, the user will be prompted for the Escrow Number.

Generally, the user will have the Escrow Number and will simply enter it and click on the OK button. However, if they do not have the number, but have a name (for example there is a funding check in hand, without an escrow number on it, but with a borrower’s name), the user can use the Search icon to initiate a full system search of Impact.

The File Search screen gives the user the ability to search the database broadly or in a more targeted manner. By entering the beginning of a last name in the Search For: field, for example, and then clicking on the Search button without changing the search: default of All but file numbers, the user will get a listing returned of all files that have names of either the Borrower or the Seller which begin as requested. The more sure the user is of the item being requested, they should enter a more complete description. However, if at first the user does not find what they believe they should have, limit the information entered in the Search For: field. The user may also use the percent sign (%) as a wildcard in searches. It can be placed at the beginning, middle or end of the entry to tell the system to find anything that ends with what was entered, contains anything between the entry items, or begins with what was entered, respectively.
The more targeted search options are listed below and can be selected from the Filter: dropdown. The default is **All but file numbers**.

- Sellers and Buyers
- Buyers
- Sellers
- Property Address
- Tax Parcel Number
- Subdivision (Name)
- Reference Number
- Base File Number
- Loan Number (Lender’s)
- File Number
- Title File Number

Once the user clicks on the **Search** button, a listing of candidate items will present. The records will indicate which search criteria they matched up on. Up to the first 1,000 records that meet the criteria will be presented – the user will be prompted to narrow the search if over 1,000 hits are made. There is a View File Status icon next to each record returned; click on the icon to get more information on the file that the record relates to. Double-click on a record to use the file number on the **Escrow Number Entry** request screen.

Once an escrow number is entered on the **Escrow Number Entry** screen presented above, or if a file is selected from the search results screen (with a double-click), the **Ledger** will be presented, as shown below. The **Ledger**, in version 8.0, has been redesigned from those earlier versions of Impact/SQL used, and both **Escrow** and **Savings** account information is available through the same screen. The **Ledger** is described in detail in the following paragraphs.

At the very top of the screen are three icons: 📐 **Change File** and 📜 **Print** (on the left) and 🔖 **Collapse Summary** (on the right). The **Change File** icon will let the user select a different file. The **Print** icon will help the user print the ledger. The **Collapse Summary** icon will hide the file and balance information, at the top of the screen, giving the user more room to view ledger records. It will revert to an 🔖 **Expand Summary** icon, which is used to re-present the file and balance information.

At the initial opening of a ledger, general information about the file (**Escrow Number**, **Escrow Officer**, **Branch**, **Bank** currently assigned, and **Buyer** and **Seller** names) is presented on the top left of the screen, and summary accounting figures, relating to escrow trust balances, are presented on the top right. The (Posted) **Balance** is modified with the work in process and on hold to result in the **Available Balance** – which is what is left in the file to be disbursed.
Note that there are three tabs on this screen: Posted Items, Receipts in Process and Disbursements in Process. Click on the tab heading to move from one to the other.

The ledger presents, for each transaction, from left to right:

- The **Date** of the transaction; they are presented in date order

- The **Src** column presents the type (R=receipt, T=transfer, W=wire and D=disbursement) and source (Bank Number); if the file has switched banks, you will see different source numbers on some of the items, and you will see multiple banks listed in the account tree on the left

- Who entered the item (user’s initials), in the **By** column

- The **Payor** of a receipt or the **Payee** on a disbursement

- The receipt type (only on receipts), in the **Type** column

- The reference number of the item (receipt number or check number), in the **Number** column; an “M” beside the check number denotes it was a manually prepared check; a “C” beside a check number indicates the check has been cleared, through a reconciliation; an “H” will appear on a receipt that is on hold (remember: only Accounting can release non-current-date holds), and a “V” will reflect a Void.

- The amount of the item (either in the **Receipts** column or in the **Disbursements** column, as appropriate

- The running **Balance** through each transaction

- The 🔄 **Info** icon next to some records can be used to present additional detail on the particular item.
Savings Ledger – from View Ledger

The newly formatted Ledger, in version 8.0, will also give the user access to the Savings account information, if any, associated with a particular file. On the left side of the screen, under the file information, a “tree” of account numbers is presented. If there are one or more Savings accounts, they will be listed under the Savings heading. Note: if there is escrow trust account activity for more than one escrow trust account, those will be listed above the Savings heading, under the Escrow Trust heading.

Click on a specific Savings account number listing and two things will happen. In the file summary section above the ledger detail, on the left side, the Bank field will be filled with the savings account’s information, and the Balance information, on the right side will reflect summary information about that particular savings account. The ledger detail that is presented will be that for the selected savings account.

![Ledger screenshot]

The tabs available for ledger detail records are Posted Items, Receipts in Process and Adjustments in Process (no Disbursements), as all savings activity is done via receipts.

Close the Ledger with the Close icon in the upper right hand corner.
Savings Accounts (optional)

The ability for Escrow users to create and work with Savings Accounts (interest bearing accounts) is controlled by a system setup option.

Add/Modify

The Add/Modify menu choice, under the Savings Accounts option, on the Misc. menu, is used to add a savings account (interest bearing account) to an escrow or to modify information about an existing savings account. The user can have an unlimited number of savings accounts assigned to an escrow, and a separate ledger is maintained per savings account.

When selected, the Add/Modify function will display the same escrow file selection screen the user sees when they ask for a ledger, with the same search functionality available. Hopefully, if the user is adding a savings account, they know which escrow they are adding it to. Upon selection of the escrow, the user will be presented with this screen:

To add a savings account to the selected escrow, click on the New Account icon, at the top of the screen. To edit an existing account’s information click on the Modify icon to the right of the specific account to be modified. The user will be presented with a similar screen, with either choice. A sample is shown below. The screen will be blank if entering a new account, or the fields will be populated if modifying the information on an account. The Delete icon, on the account listing screen, is used to delete an account entered in error, or which was not used. Once an account has activity, it cannot be deleted.

The information entered or maintained here is:

- Account Number
- Bank Name
- Date Opened
- Date Closed
- Social Security Number (Account Holder’s)
- Name of the Account Holder
- Address of the Account Holder
- City, State and ZIP of the Account Holder

Use the Cancel button to exit without saving your entries or changes or click on OK to save and exit.
The Print icon, at the top of the Savings Accounts screen, will open a screen of options like the one shown here, which is used to provide a report of all of the savings accounts assigned to the selected escrow. This report is similar to that generated under the Print menu item, but that report can include information on more than one escrow (the options for all savings accounts By Branch or all savings By Bank Name are grayed out here, as they are not applicable).

**Print**

Information about savings accounts for a particular escrow, accounts at any one or all branches or about all accounts by bank (savings bank names) is generated with this function. The user has the option to include zero balance accounts, as well as whether to include just open accounts, just closed or both. The Print Savings Account screen is shown above.

This is a sample layout of the Savings Account Listing, by specific Branch Number. The report presents, from left to right: the Escrow Number, the savings Account Number, the Bank Name, the Open Date of the account, the Close Date, the Last Transaction Date, the Account Balance and the information about the owner of the account (Name and Address). The report always presents the current, posted account balances.
View Check Status

The View Check Status option, on the Misc. menu, can be used to quickly see if a check has been reconciled as having cleared the bank or if it has been voided. Depending on the user’s access level and branch assignment, they may be restricted to only seeing information on checks in their branch.

The option will present the View Check Status screen when selected (shown below after a Find has been executed). The user should enter the check number they are seeking information about, then click on the Find button. The system will search for all checks of the number entered, across all banks and branches, and will present information on each found (again, depending on access level and branch, a user may only see items from their branch). This screen indicates if the item(s) shown are cleared or voided, and when, in the Status column.

There are two icons, to the right of each item listed, that can be used to get more information related to them. The Info icon will bring up a screen with more information on the specific check (like that shown to the right).

The View Ledger Information icon will bring up the Ledger for the file of the check.
**Void Check (optional)**

The ability to void checks, by Escrow users, is controlled by system configuration options. They may not have the ability at all, or may be restricted to voiding “same day only” items (checks issued that day). It may be that only the Escrow Manager access level users can void checks. If the option appears on the Misc menu, some permission exists for the user.

Typical business practice is to permit Escrow to void items on the date of issue, and only for items they have in their possession. A check that is not in the business’ possession is usually only voided in Impact AFTER a stop has been placed at the bank and has been verified (generally the day after placement).

Selecting the **Void Check** option, from the Misc. menu, will bring up the **Void Check** screen, into which the user should enter the number of the check they wish to void, and then click on the **Find** button.

![Void Check Screen](image)

The Info icon will bring up a screen with more information on the specific check, as shown on the previous page.

The View Ledger Information icon will bring up the Ledger for the file of the check.

If the item can be voided by the user, the Void icon will be presented at the far right of the check information line. An item that has been flagged as cleared, by the reconciliation process, will not be able to be voided and the Cleared Date will appear in the Status field. When the Void icon is clicked on, the user will be presented with a screen like that shown to the right.

The screen details the check information and pre-fills the Memo: field with VOID VOID VOID. The user can edit that text if they wish. Clicking on the OK button will complete the voiding of the check, and a message that the void has been completed will be presented.

The user will be returned to the **Void Check** screen, where the voided item will now reflect that information in the Status field. The icon, if presented, now stands for Reverse Void. If the user is able to reverse voids, they will see the icon. Clicking on the icon will initiate the routine to eliminate the void – the reverse of the voiding routine.
Void Wire Out (optional)

The ability to void an outgoing wire, by Escrow users, is controlled by a system configuration option.

Selecting the Void Wire Out option, from the Misc. menu, will bring up the Void Wire Out screen, into which the user should enter the number of the number of the wire out they wish to void, and then click on the Find button.

![Void Wire Out Screen](image)

The Info icon will bring up a screen with more information on the specific wire out.

The View Ledger Information icon will bring up the Ledger for the file of the wire out.

If the wire out can be voided by the user, the Void icon will be presented at the far right of the wire information line. An item that has been flagged as cleared, by the reconciliation process, will not be able to be voided and the Cleared Date will appear in the Status field. When the Void icon is clicked on, the user will be presented with a screen like that shown above in the Void Check discussion.

The screen details the wire out information and pre-fills the Memo: field with VOID VOID VOID. The user can edit that text if they wish. Clicking on the OK button will complete the voiding of the wire out, and a message that the void has been completed will be presented.

The user will be returned to the Void Wire Out screen, where the voided item will now reflect that information in the Status field. The icon, if presented, now stands for Reverse Void. Clicking on the icon will initiate the routine to eliminate the void – the reverse of the voiding routine.
Printer Setup

Each user’s session is unique in the printers it has at its disposal and how they are configured. Once printers are established within the computer environment (either in Citrix sessions, or in a terminal server environment, or locally), Impact must be told which printers to use for each user. They must be defined in the user’s environment before they can be selected in Impact. The first time a user goes into Impact, if their printers have not been defined through this function, they will be prompted about the matter and will be asked if they wish to define their printers. Once defined, they will no longer get the warning prompt. Should they need to change their defined printers, they would use this function, from the Misc menu.

Depending on the user, Impact will need a document printer defined (at a minimum) and, possibly, a check printer will need to be defined. Note that the check printer is distinguished by the fact that it uses MICR toner, so banks’ proof machines can recognize the encoded information on checks and deposit slips.

This function is available in the Impact Escrow, Title, and Utilities module, as well as in Accounting. The configuration only needs to be done once for each user.

Two tabs are presented, one for the Document/Report Printer and the other for the Check Printer. Simply select the printer to assign to each task, by highlighting the desired printer from the list presented, on each tab.

When print jobs are queued up, Impact will know whether it needs to send each to the check printer or the document printer, and will send the jobs to the correct printers.

Change Password (conditional)

If NT Authentication is not being used (not recommended), and the Impact system asks the user for their Impact initials and a password when they access an Impact module, the users will be able to change their own password with the Change Password function. Historically (pre Impact/SQL version 8), a System Administrator had to change a user’s password for them. Selecting the Change Password option, on the Misc. menu, will present a screen on which the user will enter their old password and their new password. The new password will have to be entered twice, to verify it was entered consistently.

The entries will be displayed as asterisks (**), so no one looking over the user’s shoulder can read their password off the screen.

The system will NOT check to see that the password truly was changed – the same password can be entered as the Old Password and in the New and Verify Password fields.

User passwords in Impact/SQL are restricted to six (6) characters or less.
Manual Check Entry (optional)

The availability of the Manual Check Entry option, on the Misc. menu, is a system configuration option for Escrow, and is rarely implemented.

Use of the Manual Check Entry screen will allow the user to create a check entry for an escrow file where the physical check was manually typed – not created within Impact/SQL. This is done to log a check that was manually prepared - during a power failure, for example. This is a very rare situation.

NOTE: A stock of preprinted, pre-numbered checks should be available for this eventuality.

Select Manual Check Entry, from the Misc. menu, to begin the manual check entry process. The user will be prompted for a file number. Once that is entered, and they click OK to precede, the Manual Check Entry screen will be presented, as shown below. The available balance of the file will be presented at the top of the screen.

The Change File icon, at the top of the screen, is used to select a different file for manual check entry, if the wrong file happened to be selected.

Enter the manual Check Number in the field of that name.

The date fields (Check Date and Post Date) will be pre-filled, and if they are correct, TAB through them. If they need to be changed, either enter dates or use the calendar tool to select the proper dates.

Press TAB or place the cursor in the Payee Name field to fill out the name and address information manually, or place the mouse in the Payee Name field, then click on the Naf button, in the upper right corner of the screen, to auto-fill this information with data from the Name and Address File (Naf).

Click on the New Item button, below the address information on the Manual Check Entry screen, to add an unlimited number of stub detail lines. The bottom half of the screen will present a detail line grid, as shown above. Each stub line description can be up to fifty characters. Press TAB to move the cursor to the Amount field, and then enter an amount.

If entering a manual fee check, :T entered in the Payee Name field will activate a Code column, next to the Amount column, for income code entry.

If a detail line is entered in error, click on the Delete button at the right of the specific line to remove the stub line. Click on the Yes button on the pop up confirmation dialogue box to confirm the deletion of the stub item.

The Add Another button, at the bottom of the screen, can be used to add an additional manual check for the same file.

Click on the OK button to save changes and return to the Impact desktop.

Click on the Close button, in the upper right hand corner of the window, or click on the Cancel button to abort any entries, and return to the Impact desktop.
Accounting Lock/Unlock File

The Accounting Lock/Unlock File menu entry will appear on the Misc menu if the user has the Password option selected to permit them to use this function. Locking a file will prevent any Accounting activity from being conducted in the file. Locks may be automatically placed on aged files by an Impact Windows Service option.

When selected, the following screen is presented, from which the user can Print a report of the file’s locking history, review the File Status and Lock (or Unlock) the file. The Change File icon is used to move to another file.

When the Lock File icon is clicked, at the top left of the screen, a window will pop up that asks for the reason the file is being locked. Enter the reason and click OK to save, or click on Cancel to cancel the locking effort.

Once locked, the reason entered will be listed on the bottom half of the screen shown above, and the Unlock File icon will present at the top of the screen. Clicking on it will cause a similar window to present, asking for the reason the file is being unlocked. The history of the locking/unlocking that has been done can be printed with the Print icon.

The File Status icon, when clicked, will present a window with a detailed set of screens (Info, Tracking, Policies and External Systems) that will give the Escrow user quite a bit of information about the subject file. This screen has been described earlier in this manual; that discussion will not be repeated here. Click on the Close button, in the upper right corner of the File Status screen, to return to the Lock/Unlock File screen.

Click on the Close button, in the upper right corner of the Lock/Unlock File screen, to return to the Escrow desktop.
Naf Menu

The Name and Address File (Naf) or customer list is a very important tool in Impact. It is used to aid in consistently filling name and address information into the appropriate fields in Impact. Consistency in data entry helps ensure that documents properly present information. Management reporting is also aided by consistent data entry. The Name and Address File (Naf) is displayed in a tiered manner: Company – Branch – Individual (Top – Middle – Bottom). This provides a good way to show the relationship between an individual and where he/she works, within the larger organization. The Naf can be centralized or branch-specific, depending on system configuration. If the user is doing maintenance in a branch-specific environment they must be aware of the branch their Impact login initials are assigned to.

Add and Modify

Maintenance of the Naf is done through this menu entry, if the user has authorization to change the Naf. When first accessed, the screen is blank, with the Search Option radio button All enabled, and the cursor is in the Search By Name field, in anticipation of the user entering the beginning of a name to be searched for. There are two icons at the top of the screen, New and Print, which will be discussed below.

Near the top, on the left of the screen, is a box of Search Options. The nine options presented are the eight categories which can be used to categorize entries by type of firm, as they are entered/edited, and the All option is used to assist in searching the entire database, regardless of categorization of the entries.

Below the Search Options box is a box containing four fields that are used to direct the system to Search By either Name, County, ID or State. When more than one character is entered into any of these fields, the system automatically begins searching, after a brief delay to see if more characters are being entered, for records that match the criteria entered. The user may use the percent sign (%) as a wildcard character. Those records that have a specific match, and their related records, are displayed in the tree on the lower left of the screen. In the search results display, the company entries are bolded, branch entries are not bolded and individuals’ entries are italicized for enhanced readability.

Double-click on an entry to Modify it (or Use it, if in a field where a Naf entry could be used, when the Naf was invoked).
A user with maintenance authority can add a new Naf entry by clicking on the New icon, at the top of the screen, or by right-clicking, while a specific entry is highlighted, or when the screen is blank. Depending on whether there is a highlighted entry or not, and at what level the highlighted entry is (Company (top), Branch (middle), Individual (bottom)), Impact will display a prompt asking what the user would like to do, presenting currently available options, which could include: Add a New Company, Add a Branch Under the Company, Add an Individual under the Branch or Add an Individual Under the Company.

The sample shown to the right was generated while a company level record was highlighted, and the New icon was clicked. Had the user right-clicked with the mouse, with the same record highlighted, the options would have been presented in a slightly different format (menu listing) with less information provided as guidance.

Based on the user’s selection, they will be presented with an empty form into which they will enter data on the new entry. Depending on what level of entry was requested, some fields may already be completed and will not be able to be edited. Complete the form with as much information as is available. The form shown to the left was presented when a New Company entry was requested.

The Entity Type is used to categorize the company to help in searches.

Depending on system configuration, an automatic Id # can be assigned to each customer. The automatic ID #'s are useful to coordinate customer numbering with an outside accounting or CRM system. The Comments area of the screen can be used for information not provided for in the fields presented.

At the bottom of the screen the Naf has fields available for a Bank Name, Account Number and Routing Number. This is useful information to have filled out before wiring money to the entity. The bank Routing Number must be a valid receiving bank ABA number or Impact will not accept the routing number. While bank routing numbers are downloaded from the Federal Reserve website and updated by the system administrator periodically, in order to validate ABA #'s on wire entries, the entries in the Naf are NOT updated by the ABA downloads.

Click on OK to accept the entry, or on Cancel to quit without saving.
**Modify**

To make changes to a Naf item, the user should double-click on the record they wish to change, or right-click on the record and select **Edit** from the options presented. If the user has rights to edit the Naf, the entry will be presented for editing.

The Naf allows the Naf Administrator to flag a Naf record as **Inactive**. Setting a Company level record as Inactive sets all related parties as Inactive. Setting a single related party as Inactive will dim the specific entry and still allow the user to use the Company level record and any other records not set as Inactive.

Click on **Cancel** to abort any changes and return to the NAF Entity screen, or **OK** to save any changes or new entries to the screen.

**Delete**

To delete a Naf entry, right-click on it and select **Delete** from the options presented. If there are related entries below the one selected for deletion, the user will be prompted to delete them before attempting to delete the current record. The function will delete the entire Naf entry (a dialogue box will ask for confirmation).

**Print**

A name and address listing can be generated for any or all of the Naf categories. This can be done either from the main Naf screen, using the **Print** icon, at the top of the screen, or by using the **Print** menu option, from the main Naf menu. By default, in the **Print Options** area of the screen that is then presented, all the fields are checked, meaning they are selected. Click on a check box to uncheck any categories that should not be printed.

Click on **OK** to print the report, or **Cancel** to abort and return to the Impact desktop.

Optionally, click on **OK**, then on **Preview**. From this preview screen, the print results can be exported to a file (click on the **Export** icon on the top left corner of the screen, for example to an XLS or DOC file) and used in other systems, for seasonal greeting cards, mass mailing, etc.
Options Menu

The Options menu, on the Escrow desktop, has two settings on it that the user can select to provide helpful tools to their Escrow desktop: Show Toolbar and Show Recent File List. There is information on both of these tools at the beginning of this manual, so only a brief comment on each will be made below.

Show Toolbar

Selecting the Show Toolbar option, on the Options menu, displays a row of icons under the menu at the top of the Escrow desktop. The icons can be used to initiate actions without using the menus. Holding the cursor over the icons will present tooltips identifying each icon’s purpose. The purpose of each icon is described at the beginning of this manual.

Show Recent File List

Selecting the Show Recent File List option, on the Options menu, will provide a listing of the last ten (10) files accessed, at the bottom of the File menu. This is the Recent File List. The user can simply click on a file number, on the list, to open it up. To access the list the user can use ALT+F to display the File menu.

Tools Menu

There is one option on the Tools menu, currently: Event Log.

Event Log

The Event Log, in Impact/SQL, keeps a record of most unexpected errors that a user might experience in Impact/SQL. It gives the USA Digital Solutions Support Team a good place to review the history of error events when an issue is being researched. Details captured on the errors can be emailed to Support@Digisolaz.com, after clicking on the Info icon next to a particular error entry, and then clicking on the Email button at the bottom of the Event Details screen.
About Menu

The About menu, on the Escrow desktop, will bring up a screen of the current Impact/SQL installation, including the version and build numbers. This information is often helpful for the USA Digital Solutions Support Team when researching an issue. There is no functionality on this screen, other than a link to the USA Digital Solutions, Inc. web site.
Appendix A - Washington State – Taxes

The Impact/SQL system can be configured to add the sales tax and excise tax calculations, for Washington State, to the applicable HUD screens (1100 – Title Charges & 1200 – Government Recording and Transfer Charges). This setting should only be applied to databases in the state of Washington. The discussion below will detail the system alterations for “with GFE” Residential files. The non-GFE Residential and Commercial data entry are also altered to accommodate sales taxes, but the concepts are similar so only the with GFE Residential will be detailed below. The businesses are responsible for maintaining the sales tax tables (via the Utilities module) as rates change – not USA Digital Solutions, Inc.

Sales Taxes on Escrow and Title Charges

The “with GFE” Residential file 1100 Title Charges screen, on a site configured for Washington sales tax calculations, looks the same as on other sites, until the user enters the GFE charge breakdown screens for the 1102, 1103 & 1104 figures (shown below). Note the Sales Tax additions to the screens.

The Override Sales Tax checkbox, at the top left of each screen, will open up the sales tax fields for manual entry. If not checked, the system will calculate the sales tax on each line.

The calculations are based on the Estimated Close of Escrow Date.

Taxes on Escrow Charges are based on the file’s closing center (Escrow Branch) Municipality Type, City, County and State.

Taxes on Title Charges are based on the file’s title service center (Title Branch) Municipality Type, City, County and State. So, if a file’s title branch is in another location from the escrow branch, the rates may be different for the two types of charges.
**Excise Taxes**

The Washington sales and excise tax option replaces the blank 1206 & 1207 lines with a 1206 line set of fields dedicated to Excise Tax.

The Calculator icon, to the right of the fields, is used to open the Excise Tax screen – shown to the right.

The State and Local Excise Tax Rates will present at the top of the screen (not shown in this sample).

The Gross Selling Price and Personal Property data, if entered, is shown.

The taxes will be calculated and presented.

The user should enter figures in the Delinquent Interest State, Delinquent Interest Local and Delinquent Penalty, as needed.

The Amount to Charge Buyer and Amount to Charge Seller fields should be used to split the Total Due, as applicable.

Click on OK to save and return to the 1200 screen. The excise tax data from the calculator will be presented and locked.

Once data is entered on the calculator screen, re-entering that screen and clicking on Remove will clear the data on the screen and when OK is then hit, the user is returned to the 1200 screen with the previously computed data still there, but editable (unlocked). The data can either be manually removed or adjusted as desired.

Click on Cancel to not save any changes and return to the 1200 screen.
Appendix B – Sub Escrow Functionality

There is sub-escrow functionality available in Impact. It is largely utilized by the Southern California marketplace. The reader is referred to separate documentation on the matter, titled “Enhanced Sub Escrow Functionality in Impact/SQL ver 7.7”, available from USA Digital Solutions, Inc., and on the USADSI website.

Appendix C - Troubleshooting

USA Digital Solutions, Inc. (DSI) Support personnel may ask that you make a screen shot so that you can e-mail Support a “picture” of the screen as it appears when the error occurs.

To create this screen shot, save it and send it to the Support personnel, do the following:

Press the PRINT SCREEN key on the keyboard, which is usually located on the top row of the keyboard, and is usually the third key from the right.

Open your e-mail client, start a new e-mail, to Support@Digisolaz.com, and Paste the screen shot into the body of the e-mail. This will work if the e-mail format is HTML. If the screen shot does NOT paste properly, open a Word document and paste the screen shot into it; save the Word doc; and, attach it to an email addressed to Support@Digisolaz.com.

DSI Support personnel can be reached at (602) 866-8199 extension 2.